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Deltek CRM and Proposals to Deltek V
I n t r o d u c t i o n

In this chapter
� About This Guide
� Deltek Client Services
� Getting Additional Help

Welcome to Deltek Vision, the Web-based software 
solution for professional services organizations. Vision 
combines your front-office and back-office data into one 
integrated system and enables all the members of your 
firm to use and share the same information — thereby 
helping increase the efficiency and productivity of your 
business.
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Introduction
About This Guide

The Deltek CRM and Proposals to Deltek Vision Migration Guide contains helpful 
information for firms migrating data from the latest version of Deltek CRM and 
Proposals 3.x to Deltek Vision. In this guide you will find steps to perform before, 
during, and after migration to ensure success as well as general information to help 
you familiarize yourself with navigation, usability, and feature changes in Deltek 
Vision.

The contents of this guide include:

This guide can be used as a reference tool by the persons in your firm who are 
responsible for performing the actual migration of data from Deltek CRM and 
Proposals to Deltek Vision. Those performing the migration will find detailed migration 
instructions in Chapter 2. Those performing the migration should also refer to Chapter 
1 for an overview of Vision, including the technical architecture, and Appendix A for an 
overview of database changes.

In addition, all end users, such as principals, marketing professionals, and project 
managers, may want to read Chapter 1 and Chapters 3-10 to learn about features 
new in the Deltek Vision CRM and Proposals applications that did not exist in CRM 
and Proposals 3.x and to learn how to use Vision to perform functions that did exist in 
CRM and Proposals 3.x. 

Migration Approaches

You can approach your migration in one of two ways:

• Some firms rely on substantial on-site consulting assistance by experienced 
Deltek staff members. This approach is the most comprehensive and provides 
services that are tailored to your firm’s specific needs. 

• Another option is to take advantage of regularly scheduled classroom and Web-
hosted training programs to supplement a smaller amount of on-site consulting 
service. This approach is more cost effective and allows staff in different locations 
to train at the same time.

Deltek offers a variety of services to help ensure a successful migration tailored to 
your firm’s needs. For a complete list of services, see the Deltek Client Services 
section beginning on page xii of this chapter. 

Chapter 1 Overview and Introduction to Vision
Chapter 2 Migrating to Deltek Vision
Chapters 3-10 Review of Deltek Vision Features
Appendix A Comparison of CRM and Proposals 3.x and Vision 

Database Tables
-x



About This Guide
Multicompany and Multicurrency

Deltek Vision offers a Multicompany feature and a Multicurrency application. 

If your firm will enable the Multicompany feature or if you have purchased and plan to 
enable the Multicurrency application, you may have some additional considerations as 
you migrate from CRM and Proposals 3.x to Vision. Throughout this guide, you will 
find fields, options, and issues specific to Multicompany or Multicurrency called out 
using one of two graphics. 

Because using either Multicompany, Multicurrency, or both presents unique issues 
that cannot be covered in depth in this guide, if you plan on using one or both of these 
features/applications, please contact your Deltek representative.

Multicompany

Using a single, enterprise-wide database, Deltek Vision’s Multicompany feature 
provides a comprehensive view of the transactions, interactions, and activities of all 
your business entities. Designed to manage the special CRM, project planning, 
resource management, project control, and accounting needs of multicompany 
enterprises, Deltek Vision offers each business entity the flexibility and independence 
it needs while encouraging the enterprise-wide sharing of knowledge and resources.

When you see the icon shown to the left elsewhere in this guide or in the Vision Online 
Help, this represents an issue relevant to the Multicompany feature.

Multicurrency 

The Multicurrency application allows a firm to transact business in any number of 
global currencies while maintaining core financial records in a single, “functional 
currency.” This application is designed for any enterprise that uses multiple 
currencies, from a complex global enterprise that transacts business daily in 
numerous currencies to a single company that occasionally does business in foreign 
currencies.

When you see the icon shown to the left elsewhere in this guide or in the Vision Online 
Help, this indicates an issue relevant to Multicurrency.

• For firms also converting data from Advantage, FMS, and/or Sema4, 
there are additional issues not addressed in this guide. Please 
contact your Deltek Vision representative before continuing.

• You must be running the latest Deltek CRM and Proposals 3.x 
Version on a Microsoft® SQL Server 2000 or MSDE database prior to 
migrating data to Deltek Vision. If you are using an earlier Deltek 
CRM and Proposals version, please first upgrade to CRM and 
Proposals 3.x. If you have questions about upgrading or if you are 
using RFP for Windows or RFP Gentrack, please contact Deltek 
Technical Services at 800.836.1600.
Deltek CRM and Proposals to Deltek Vision Migration Guide -xi



Introduction
Deltek Client Services

For over 20 years, Deltek has maintained close relationships with client firms, helping 
with their problems, listening to their needs, and getting to know their individual 
business environments. A full range of client services has grown out of this close 
contact. A summary of these services follows. 

Ongoing Support Plan

As a user of Deltek software, you rely on our solutions and support every day to 
perform the most important functions in your firm, such as project accounting, financial 
reporting, billing, labor and payroll, client relationship management, and resource 
planning. Deltek is committed to providing the timely support that our clients have 
come to expect.

Ongoing 
Support Plan = 
OSP

Recognizing that your Deltek software is critical to the success of your business, we 
have developed the Ongoing Support Plan (OSP) to help you maximize the benefits of 
your software investment.

Deltek users have a wide range of phone and Web-based support options included as 
part of the Ongoing Support Plan. Our experienced, well-trained support analysts are 
available via the Web, telephone, and e-mail to answer your questions relating to the 
application and technical operation of your Deltek software.

Your firm’s OSP also entitles you to receive valuable information and materials, 
including software updates, payroll tax updates, priority service, unlimited access to 
our e-Support site, and discounts on other Deltek products and services.
-xii



Deltek Client Services
e-Support Site

If you forget 
your password 
or user ID, go to 
https://support. 
deltek.com, 
enter your user 
ID in the If you 
have forgotten 
your password 
section, and 
click Email Me 
My Password. If 
you do not have 
an account on 
the e-Support 
site, the Deltek 
support contact 
manager at your 
company can 
log on to the e-
Support site and 
add users.

To access the e-Support site: 

1. Go to https://support.deltek.com to log on to your company's portal. 

2. Enter your Username and ID.

3. Click Login.

An OSP entitles you to access Deltek’s support Web site (e-Support). With an 
assigned username and password, you can access the following Deltek e-Support 
options:

• Support Home — View alerts from here. You can also select the Knowledge 
Center, Ask Support, Live Support Chat, or My Stuff links to open other e-Support 
pages, or instead, click the corresponding tab.

• Knowledge Center — From the Knowledge Center tab you can:

• Search the Support Knowledge Base for solutions to issues and questions. 
New solutions are added each day. The Knowledge Base is available 24 
hours a day.

• View or save Deltek product information, such as release notes, user guides, 
technical information, or white papers (in PDF format). You can also print and 
e-mail Knowledge Base articles.

• Read information and follow links to third-party software downloads, Deltek 
forms, and third-party vendor forms.

On the Knowledge Center tab, select a product in the Search by Product field, 
and then select an option from the Search by Category field to select a specific 
area to search — such as the Knowledge Base, release notes, technical 
information, or reference materials. You can refine your search further using the 
Search by Keyword and Search By fields. For any item you retrieve on the 
Knowledge Center tab, you can opt to be notified by e-mail if the item is updated 
in the future. 

• Ask Support — Submit a question directly to the Support queue for a reply from 
our Support staff. As you type your question, the Knowledge Base provides 
possible related answers for your review before you submit your question. You 
can also attach pertinent documentation to your question.

• Live Help — Chat with a support technician online.

• My Stuff — The My Stuff tab offers the following options:

• Case History — Check the status of your questions in the Support queue or 
provide additional information for your questions in the queue.

• Knowledge Base Items — If you subscribed to be notified of future changes 
to an item from the Knowledge Center tab, check for any updates to those 
items here. You will also be notified by e-mail of any changes. 

• Account Profile — View or update your e-Support user and company 
information, such as your contact information and login password.
Deltek CRM and Proposals to Deltek Vision Migration Guide -xiii



Introduction
• Contact Management — Add new contacts from your firm so they can 
access the Deltek e-Support site. This link appears only if you are a Deltek 
support contact manager at your company.

• Change Password — Change your e-Support login password. 

• Events — View Deltek news and events.

• Usergroups — View usergroup information.

• Training — Obtain training information.

• My Files — Upload your files to Deltek.

• My Subscriptions — Manage your Deltek e-mail subscriptions.

• Provide Feedback — Use this option from the Support Home page to submit 
comments, suggestions, or opinions on this site to Deltek. 

E-mail and Telephone Support
When Web-based support isn’t enough, turn to our e-mail and telephone support
services. Use the following e-mail addresses and phone numbers:

Priority Service

When you call the telephone support line, you normally speak with the Support staff 
directly. If we are experiencing exceptionally high call volume, you speak with a 
technical receptionist, who asks you for a detailed description of your issue, and logs it 
in our call tracking database. 

Deltek answers over 90% of telephone calls directly, and strives to return all 
messages within one hour.

Deltek Product Telephone E-mail Address

Deltek Advantage

North America:         
1 877 HLP PROJ    
(1 877 457 7765)

Europe: 
+0800.077.8960

Australia:              
+61 (8) 8150.550

advantagesupport@deltek.com

Deltek CRM & Proposals crmsupport@deltek.com

Deltek GovWin™ govwinsupport@deltek.com

Deltek Sema4™ sema4support@deltek.com

Deltek Vision® visionsupport@deltek.com

Deltek Vision® 
(International)

visionsupport@deltek.com

Deltek Vision Small 
Business

visionsbsupport@deltek.com

Additionally, refer to the following for information regarding other Deltek support 
areas:

Deltek Client Care 800/836-1600 clientcare@deltek.com

Deltek Technical Services 800/836-1600 techservices@deltek.com

 
 
.
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Deltek Client Services
When Using Telephone Support...

When you call the phone support line, please have the following information ready:

• Deltek client account number (five-digit)
• Telephone number
• E-mail address
• Type of call — application or technical
• A brief description of the problem

Weekly Telephone Support Schedule

As soon as you are up and running on Vision, your staff can call one of our Vision 
support analysts at any time with questions and to get assistance with application 
problems. You'll find our staff well prepared to handle the everyday operating issues of 
Vision users.

Current telephone support hours are (Eastern Time):

You can leave a message on our voice mail system 24 hours a day.

To log on to the 
e-Support site 
from within 
Vision, click the 
global Help icon, 
and then click e-
Support from 
the drop-down 
list.

After you have set up a username and password, you can log on to the Deltek e-
Support site at: 

https://support.deltek.com 

Call Escalation Procedures

Despite our best efforts to ensure that all client concerns are treated efficiently, you 
may sometimes feel that an issue is not being handled to your satisfaction. If so, 
please contact your account manager. You may also contact our Client Care Group, 
whose helpful staff can address virtually any request, including finding the appropriate 
staff member or manager to address your issue.

Deltek Product Monday - Friday Saturday

Deltek Advantage 8:00 AM - 8:00 PM 10:00 AM - 4:00 PM 

Deltek CRM & Proposals 8:00 AM - 6:00 PM N/A

Deltek GovWin 7:00 AM - 10:00 PM 9:00 AM - 5:00 PM

Deltek Sema4 9:00 AM - 8:00 PM N/A

Deltek Vision 7:00 AM - 10:00 PM 9:00 AM - 5:00 PM 

Additionally...

Deltek Client Care 8:00 AM - 6:00 PM N/A

Deltek Technical Services 7:00 AM - 10:00 PM 9:00 AM - 5:00 PM
Deltek CRM and Proposals to Deltek Vision Migration Guide -xv



Introduction
Deltek Ongoing Communication

  Important! E-mail is Deltek’s primary means of communication with our clients. Therefore, it is 
important that we keep your e-mail address on file. 

You must also subscribe to receive important support bulletins.To do so, log on to the 
support site and you can manage your subscriptions online. 

Your Firm’s Contact Information

To provide you with timely support, it is important for us to have current information, 
especially e-mail addresses, for all Deltek contacts at your firm.

You can view and update this information online. Please be sure to keep it current.

Software Updates

Your Ongoing Support Plan (OSP) entitles you to online software updates for your 
current Deltek software. These important, periodic updates include new features and 
enhancements requested by clients and by Deltek Support staff, along with software 
fixes and corrections. Online software updates also include payroll tax tables, as 
applicable.

Deltek’s online software updates incorporate technology upgrades to ensure that your 
system stays current and operational. These upgrades are not available to firms 
without an OSP. Once Deltek ships a software update, we only support the two most 
recently released versions of the software.

Technical Services

techservices@ 
deltek.com   or 
800/836-1600

In addition to our application experts, we have technical specialists trained and 
certified in the latest Microsoft technologies. Our Technical Services Group can 
provide you with current information on hardware, software, and licensing 
requirements. If you are new to Deltek software, we offer technical implementation 
and deployment consulting — we help you make the right decisions now, to avoid 
needless time and expense later.

As is the case with all software, some areas are not covered by 
the Ongoing Support Plan. Work in these areas is normally billed 
on a time and materials basis.
-xvi



Deltek Client Services
Technical Support

Deltek’s Technical Services Group can assist your firm on matters such as:

• Network connection issues.

• General technical support relating to third-party products used by Deltek software, 
including Microsoft Office Access, Microsoft SQL Server, Microsoft Database 
Engine (MSDE), Microsoft SQL Server Reporting Services, and Nokia Intellisync.

• Deltek software installation and deployment.

• Hardware and software requirements for systems running Deltek software.

• Deltek product system messages.

• Database and software installation issues.

• Deltek product upgrade issues.

Consulting Services

To contact 
Deltek’s 
Consulting 
Group, please e-
mail consulting 
services@deltek
.com or call 800/
836-1600.

Deltek is not only a software vendor, but also an experienced team of professionals, 
dedicated to the specific needs of professional services firms. Our consulting team — 
which includes members with 25 years or more of industry experience — is available 
to support you every step of the way as you install Deltek products and use them day-
to-day. From implementation planning, to operational support, to custom 
programming, our Consulting Group is ready to help you maximize your investment in 
Deltek products.

Custom Programming, Reports, and Invoices

To contact the 
Custom 
Programming 
Group, call 800/
836-1600 and 
ask for the 
Custom 
Programming 
Group.

At Deltek, we pride ourselves on the array of reports, templates, and style sheets 
included as standard features in our software applications. But what if your firm has 
unique reporting, billing, or processing needs not addressed by standard Deltek 
applications? First, ask our Support staff whether the enhancement you need is on our 
development list. We may even have a scheduled date for its release.

If the enhancement is not on our development list, please contact our Custom 
Programming Group. This experienced group of reporting specialists can create 
reports to your specifications, or help you develop custom reports on your own.

Implementation Planning

We strongly recommend investing in Deltek consulting when you implement Deltek 
software. Our consultants work side-by-side with your senior management and key 
staff members to establish an implementation schedule and ensure that your firm’s 

As with all software, some areas are not covered by the OSP or 
the Premium Technical Services Plan (for example, 
implementation and work breakdown structure design). Deltek 
normally bills for these services on a time and materials basis.
Deltek CRM and Proposals to Deltek Vision Migration Guide -xvii



Introduction
important implementation decisions are informed and timely. Deltek’s senior 
consultants can also help you look critically at your current business practices and 
financial management strategies -- with the goal of improving them as part of the 
software implementation process.

Business Process Consulting

Firms periodically examine their procedures to identify ways of improving them. 
During a Business Process Consultation, Deltek consultants work with your marketing 
staff, contract managers, and senior management to optimize your firm’s use of its 
Deltek software.

On-site Application Consulting

After implementation, Deltek consultants can provide consulting tailored to your firm’s 
individual needs. Consider calling Deltek Consulting Services when your firm installs 
additional software features or adds key staff members.

Management Seminars

Management seminars provide focused training for principals, contract managers, and 
marketing staff. These seminars are designed to increase both management 
effectiveness and proficiency in using the application. Our own most senior 
consultants, who are experts in the critical management needs of professional 
services firms, conduct these seminars.

Online Web Consulting

As an economical alternative to on-site consulting, consider online communication. By 
receiving live interactive consulting over the Web, our consultants see your worksta-
tion as you use it, and make changes to your setup interactively. Many of our clients 
use online Web consulting to address specific issues without incurring airfare and 
hotel expenses.

Conversion Assistance

What if you want to import data from other sources, or merge multiple Deltek 
databases? Many firms convert their existing computer systems without assistance. 
Others receive support from Deltek’s Data Consulting Group, who review existing data 
and help prepare it for use in the new software. 

A firm’s approach to conversion depends on its size and in-house resources. If you 
think your firm might benefit from conversion assistance, contact the Data Consulting 
Group.
-xviii



Deltek Client Services
Deltek University

One of the most important indicators of the success of a software implementation is 
the ability of employees to readily adapt to new products and processes.

Education is the foundation for building the necessary knowledge and skills to achieve 
this goal. Deltek University provides education to maximize your Deltek investment 
and minimize project risk.

We have over 20 years experience of providing consistent, high quality education, 
with a commitment to make you successful. 

• Implement solutions faster at reduced cost 

• Mitigate project and business risks 

• Decrease support costs with faster acceptance among users 

• Achieve operational excellence and growth 

Implementation and Application Education

Deltek University offers courses covering:

• System configuration

• Business process overviews

• Transaction processing

• Reporting

Delivery Options:

Classroom 

Courses are delivered at Deltek University facilities across North America, the United 
Kingdom, and Australia.

On-site

Our courses can also be delivered at your site. These courses can be customized to 
meet your specific needs.

Web-Based Training

Receive live instruction at your home or office and save time and travel expenses. 
Expert Deltek instructors deliver the same quality of training as in our classroom via 
live sessions over the Web.

e-Learning 

Self-paced e-Learning provides interactive, voice guided, software simulation learning 
tutorials available over the Web.
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Vision End-User Training Kit

Transform your key staff into instructors with tools and technology to deliver 
standardized education to your users aligned to your business processes. The Vision 
End-User Training Kit features templates, lesson plans, quick reference guides, and 
e-Learning lessons. The tools allow you to provide new and ongoing training to 
maximize your team's effectiveness.

Contact Deltek University

Tel: 1.800.456.2009 x3

Email: deltekuniversity@deltek.com

Web: www.deltekuniversity.com

Additional Client Services

Annual User Conference

Visit our Web 
site at 
www.deltek. 
com to find out 
more about our 
conference and 
other Deltek 
events.

Each year Deltek hosts a user conference in a major city or resort. The conference 
provides an excellent opportunity to meet our staff and other Deltek users from around 
the world, attend application seminars, and see demonstrations of new features. The 
conference also provides our staff with the chance to speak with you about changes 
you would like to see in the future, and to determine how we can serve you better.

User Groups

See our e-
Support site for 
more 
information 
about a user 
group near you.

Deltek clients have established user groups throughout the United States and 
Canada. These client-run groups are ideal for meeting and sharing ideas with other 
Deltek users.

Client Care and Account Management

Deltek’s Client Care Department ensures that we consistently provide responsive, 
individualized attention to our clients. We understand that our long-term success 
depends not only on satisfying our clients, but also on delighting them with exceptional 
customer service. We are dedicated to making sure you are totally satisfied with 
Deltek services and products.

The only way we can determine whether good customer value is being created and 
delivered is to listen to you — our client. By responding to your ideas and 
recommendations for process, product, and service innovation, we can provide 
greater value both now and in the future.
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Deltek Client Services
We encourage you to provide us with any and all of your comments, so we can learn 
what we’re doing right and what is important to you. You can do this in a number of 
ways, including completing one of our periodic client satisfaction surveys, or by 
sending an e-mail to clientcare@deltek.com.

Account Management

We assign an account manager to each Deltek client. Your account manager’s job is 
to ensure that you’re totally satisfied with Deltek’s products and services. He or she 
guides you in using Deltek resources to ensure that your projects, and consequently 
your business, are more successful.

Within 30 days after you become a Deltek client, your account manager will contact 
you to introduce himself/herself. Also, when you log on to Deltek’s e-Support site, your 
account manager is identified.

clientcare@ 
deltek.com

If you have questions about the Account Management program, please feel free to 
contact your account manager or the Client Care group.

Your account manager also helps by:

• Serving as your organization’s primary Deltek contact. 
• Proactively building a relationship with you and your organization.
• Escalating any outstanding issues as needed, and allocating Deltek resources 

based on your requirements.
• Assisting you with all invoice and OSP inquiries.
• Processing sales of add-on modules and software upgrades for your organization.
Deltek CRM and Proposals to Deltek Vision Migration Guide -xxi



Introduction
Getting Additional Help

Deltek Vision Help System

The Vision Help System is a comprehensive tool that provides you with both 
conceptual and procedural information for all areas of the Vision application.

Accessing the Vision Help System

You can access the Vision Help System in one of three ways:

• Click the global Help icon to open the Vision Help System from any Vision 
application. The global Help icon is located on the Vision toolbar at the top of your 
screen.

• Click the Help icon on the toolbar in any Vision application to view help for that 
application. Toolbars are located at the top of each form in Vision.

• Click the Help button on a dialog box to view help for that dialog box. Help buttons 
are located at the lower right corner of each dialog box in Vision.

Vision Help Drop-down List 

When you click the global Help icon in Vision, a drop-down list displays.

The Vision Help drop-down list offers the following:

• Contents — Click this option to open the Vision Help System.

• Help Desk — Click this option to open the Send Email dialog. Use this dialog to 
compose and send a message to a designated Help Desk mailbox. You can send 
e-mails directly to Deltek Vision Support, or you can set up an internal Help Desk 
mailbox to respond to questions from your staff.

Click one of the options on the Help drop-down menu 
to open the Vision Help System, send an e-mail to the 
Vision Help Desk, visit the Deltek online e-Support 
site, visit the Knowledge Base, contact a support 
group, or view information about the Vision database 
and application version that you are currently using.
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• E-Support — Click this option to open the Deltek e-Support site. This site is 
available as part of the Deltek Vision Ongoing Support Plan (OSP). You must 
have a username and password to access this site.

• Knowledge Base — Click this option to open the Deltek e-Support site. From 
there, you can select the Knowledge Base option. It provides thousands of 
solutions to prior issues and questions. 

• Contact Us — Click this option to open the Deltek e-Support site. From there, you 
can select the Contact Us option to view support phone numbers, e-mail 
addresses, and hours of operation. Also, chat with support personnel live! 

• About — Click this option to view application, database, and server information 
for Vision.

Vision Help System Table of Contents

The Vision Help System is organized into self-contained books, which you can open 
from the Table of Contents. Each book contains all the help topics related to a specific 
part of the Vision application. 

The Table of Contents consists of the following main books:

• Welcome to the Deltek Vision Help System
• Vision Concepts
• Getting Started
• Dashboard
• User Options
• Text Editor
• Info Center
• Calendar and Activities
• Proposals
• Planning
• Billing
• Transaction Center
• Accounting
• Project Control
• Human Resources
• Time and Expense
• Purchasing and Inventory
• Reporting
• Utilities
• Data Synchronization and Microsoft Integration
• Mobile Applications Suite
• Configuration
• Data Dictionary
• Deltek Client Services
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Within each main book, you will find additional books and help topics. To open a book 
and view its contents, click the book. To see a particular help topic, click the topic title 
in the Table of Contents. 

Vision Help System Navigation

After you open the Vision Help System, use the following icons to view the help 
system contents, index, and glossary; print help topics; return to previously opened 
topics; and display drop-down text in selected help topics. These icons are located on 
the toolbar at the top of the help system window.

• Click the Contents icon to display the Table of Contents for the entire help 
system.

• Click the Index/Search icon to display the index for the entire help system. You 
can search for index entries using keywords.

• Click the Glossary icon to obtain definitions of terms used in Vision.

• Click the Print icon to print the current help topic.

• Click the Back icon to jump back to the previous help topic you viewed.

The left pane of the help system displays the help system Table of Contents, Index, or 
Glossary; the right pane displays the contents of the currently selected help topic. 

The left pane includes icons that you can use to scroll through the Table of Contents 
and to hide the left pane, allowing you to view more of the content in the right pane.

• Click the Back and Forward arrows to scroll through the help topics in the current 
book.

• Click the Close button to hide the Table of Contents. 

To close the help system, close your browser window or tab.
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Related Documentation

In addition to the Vision Help system and this guide, Deltek provides additional 
documentation (in PDF format) to help you install and use the Vision application. The 
documentation available for this release of Deltek Vision is listed below. Each of the 
guides and quick reference cards in this list is available for download from the Deltek 
e-Support site (except where noted).

https://support.deltek.com

• Deltek Vision Getting Started Guide — This guide contains an introduction to 
the Vision Web interface and all the Vision applications, with tips for navigating 
through the system, using the dashboard, and finding and opening records.

• Deltek Vision Concepts Guide — This guide describes the concepts underlying 
the basic accounting, project control, and customer relationship management 
(CRM) functions of the Vision application.

• Deltek Vision Technical Installation Guide — This guide contains detailed 
instructions for installing all the technical components of Vision, including the 
servers, the database, and the application itself.

• Deltek Vision Implementation Guide — This guide contains information about 
configuring and setting up the various Vision applications and features.

• Deltek Advantage to Deltek Vision Migration Guide — This guide contains 
information about migrating from Advantage to Vision, including the steps in the 
migration process and an overview of Vision features. 

• Deltek Award to Deltek Vision Migration Guide — This guide contains 
information about migrating from Award to Vision, including the steps in the 
migration process and an overview of Vision features. 

• Deltek FMS to Deltek Vision Migration Guide — This guide contains 
information about migrating from FMS to Vision, including the steps in the 
migration process, detailed discussions of the key migration decisions, and 
procedures for verifying the converted data. (This guide is provided by 
Implementation Services prior to the migration.)

• Deltek Sema4 to Deltek Vision Migration Guide — This guide contains 
information about migrating from Sema4 to Vision, including the steps in the 
migration process and an overview of Vision features. (This guide is provided by 
Implementation Services prior to the migration.)

• Deltek Vision Configure Vision Analysis Cubes — This guide details the 
prerequisites and steps required to configure your database server when using 
Vision Analysis Cubes.

• Deltek Vision Configure Vision Analysis Cubes for Internet — If you want 
users to access Vision Analysis Cubes and Microsoft® Excel® via the Internet 
(from outside the corporate firewall), you must follow the configuration steps in 
this guide after you complete the configuration steps in the Configure Vision 
Analysis Cubes guide. This guide describes the two methods for exposing data for 
Internet users.

• Deltek Vision Custom Reports and Microsoft® SQL Server Reporting 
Services — This guide provides instructions for creating, delivering, and 
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generating Vision custom reports with Microsoft® SQL Server® Reporting 
Services and its report writing tools.

• Deltek Vision Performance Canvases Technical Installation Guide — 
Performance Canvases allow you to use Vision Project Cubes and General 
Ledger Cubes data sets and analysis services to create role-base graphical 
canvases. These canvases offer a customized graphical component for the Vision 
Dashboard. This guide describes the installation steps that are required to use 
Performance Management Canvases with Vision.

• Deltek Vision Document Management Technical Installation Guide — This 
guide contains detailed information on the necessary prerequisites, general 
configuration, and installation procedures required to use the Vision Document 
Management application.

• Deltek Vision Mobile Application Suite (MAS) Installation Guide — This guide 
provides instructions for enabling MAS on your Vision server, installing 
prerequisite software components, and installing and configuring the MAS 
software. This guide also provides a list of all the mobile devices that can be used 
with the Deltek Vision Mobile Application Suite.

• Deltek Vision Synchronization Server Installation and Maintenance for 
Nokia Intellisync — This guide contains an overview of the Vision 
Synchronization Server feature, as well as technical installation, setup, and 
maintenance information.

• Deltek Vision Server Synchronization Implementation Guide — This guide 
provides planning and best practices information for clients who are implementing 
the Deltek Vision Server Synchronization application.

• Deltek Vision Specification and Business Rules for Synchronization Guide 
— This document lists the fields mapped in each of the three areas of Vision 
(contacts, appointments and tasks/to-dos) for which you can use server 
synchronization to bi-directionally synchronize between Vision and your third-
party groupware. This guide covers business rules and requirements, describes 
limitations, and discusses scenarios to watch for when mapping data.

• Deltek VisionXtend Guides — These guides explain how to use the Deltek 
VisionXtend platform to integrate Vision with other applications, access web 
services, implement data validation routines, and establish workflow procedures 
using the Microsoft .NET Framework. The following VisionXtend guides are 
available:

• Deltek VisionXtend Extending Data Validation Business Logic for Expense 
Reports

• Deltek VisionXtend Extending Data Validation Business Logic for Timesheets

• Deltek VisionXtend Invoking a Custom Method to Process Workflow Actions

• Deltek VisionXtend Invoking a Web Service to Process Workflow Actions

• Deltek VisionXtend Test Client Application for Vision Web APIs/Web Services

• Deltek VisionXtend Web Services and API for Deltek Vision 

• Deltek Vision Quick Reference Cards — The Vision quick reference cards 
provide snapshots of specific business processes or Vision forms with tips for 
entering data and using application toolbars. The following quick reference cards 
are available:
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• Accounts Payable (Create a Voucher from a Purchase Order)

• Create Client from Vendor Utility

• Dashboard

• Desktop and Microsoft Office Integration

• Expense Report

• Mobile Timesheet and Expense Report for Hand Held Devices

• Navigation Tree Designer

• Project Planning

• Purchasing (Create a Standard Purchase Order)

• Resource Management (Generic Resource Assignments and Resource 
Utilization)

• SF330 Proposals

• Template Based E-mails

• Timesheet

• User Options

• Visualizations
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Overview and Introduction to Vision
Overview of the Migration Process

Migrating from CRM and Proposals 3.x to Vision means moving relevant data in your 
current CRM and Proposals database to a new Vision database, and then using 
Vision to manage that data. 

Migrating to Vision involves several manageable steps that should be completed in 
the proper order for a successful migration. The following list indicates the order of 
major steps and lists sub-steps for each major step. Deltek is available to guide you 
through each step in this process.

1. Prepare to Install Vision

• Plan for the migration.

• Select hardware and software.

• Create a backup of your CRM and Proposals database.

• Prepare your data for migration.

• Run CRM and Proposal reports (if you plan to use these to verify data after 
conversion).

2. Install Vision

• Install Vision.

• Convert your CRM and Proposals database to a test database.

3. Test Vision

• Connect to the Vision test database.

• Configure Vision.

• Spot check records in Vision against CRM and Proposals. 

• Back up your Vision test database.

• Train team to use Vision.

• Update design, documentation, and reports, as necessary.

• Perform segment testing.

4. Go Live on Vision

• Prepare for live conversion.

• Convert your CRM and Proposals 3.x database to a live Vision database.

• Reconfigure your live database with the system settings you had configured 
on your test database. 
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• Connect to the Vision live database.

• Begin using Vision.

• Follow-up with additional Deltek consulting or training, as needed.

This list of steps is a general guide to which you can refer as you proceed through the 
migration process. In practice, some steps may overlap or may include additional 
procedures not mentioned here. Each of these steps is discussed in greater detail in 
Chapter 3 of this guide.

For example you will need to reconfigure security settings, Info Center 
designer settings, and report settings. If you decide not to do this 
yourself, you can have the Data Migration Group do this as a part of the 
final conversion.
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Deltek Vision Technical Overview

The following overview contains brief descriptions of various technical concepts and 
models that you should review before you migrate to Vision. This information is 
intended for non-technical audiences who may benefit from a basic understanding of 
the technical architecture and operations of the Vision application. 

In this chapter, you learn about:

• Vision and the Microsoft® .NET architecture

• Vision logical tiers

• Vision deployment models

• Factors you should consider as you evaluate what hardware and/or software 
you need to install and run Vision

Gaining a general understanding of the technical concepts presented in this chapter 
can help you assess your firm’s technical needs prior to migrating from CRM and 
Proposals to Vision.

It is important to install all the hardware and software you need before you migrate to 
Vision. Without the proper hardware and software in place, you will not achieve 
optimal application performance.

Vision and the Microsoft .NET Architecture

Vision’s entire server-side architecture uses Microsoft’s .NET framework. .NET is a 
the name of a set of software technologies developed by Microsoft to connect 
information, people, systems, and devices.

.NET-based applications are easier to build, deploy, and integrate with outside 
systems than those built using earlier technologies. It allows Deltek developers and 
your in-house IT staff can extend Vision’s workflow capabilities by calling outside Web 
services from within Vision. For example, you might send real-time, updated project 
information from Vision to an external collaboration Web site so that your clients can 
view current project information. Or you might automatically update your employee 
self-service system when employee information is changed in Vision.

For a detailed discussion of specific hardware requirements and 
technical specifications for installing and running Vision, see the Deltek 
Vision Technical Installation Guide, available from the Answers tab of the 
Deltek e-support site (https://support.deltek.com). This guide is also 
accessible by hyperlink from the Deltek Vision Release Notes for the 
latest Deltek Vision release.
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Deltek Vision Logical Tiers

Vision is a multi-tier application, which means that the application components are 
distributed over several tiers to enhance performance, scalability, and security. Each 
Vision tier represents a different layer within the application, extending from the Vision 
database up to the individual client workstation. Each tier is responsible for a specific 
set of application functions.

The Vision tiers do not necessarily correspond to a physical location on your hard 
drive or local network, but are instead logical tiers that can be collapsed or divided into 
as many physical tiers as needed for your firm. You can deploy all the tiers on one 
server or install each tier on a separate server. However, all the tiers (except the client 
tier) must be at the same location.

The Vision logical tiers are:

• Client Tier — This tier is the individual workstation on which the user 
accesses the Vision application.

• Process Server Tier — This tier consists of services that can be run on the 
individual process servers. 

• Web/Application Tier — This tier is your gateway to all the Vision 
applications. This tier houses all the components and the business logic that 
drives the Vision application.

• Reporting Tier — This tier is the clearinghouse for all your invoice and report 
generation requests.

• Database Tier — This tier is where your Vision database resides.

You must carefully consider the technical requirements for each logical tier as you 
begin thinking about the Vision deployment model you want to use at your firm. 
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Deltek Vision Deployment Models

To ensure the best fit with your firm's environment, Deltek has developed several 
deployment models for Vision. There are three general models you can use to deploy 
Vision as well as a custom deployment option. The model you choose for deployment 
depends — in part — on your firm's size and concurrent usage requirements.

Before you decide on a deployment model for your firm, consider the following 
questions:

• How many users at your firm will be running Vision at any given time?

• Do your client workstations meet the minimum or recommended hardware 
and software requirements for running Vision?

• Will you deploy Vision for use over an intranet or for use over the Internet?

• Will you access Vision from a single location or from multiple locations?

• Will your staff need additional training on Microsoft® Internet Explorer, 
Microsoft Windows, Microsoft Internet Information Server, or Microsoft SQL 
Server?

Each of the Vision deployment models is summarized in the following table.

Deployment 
Model Description

One Server Using the One Server model to deploy Vision, you install all 
tiers on a single server. 

Firms typically choose this model if all users are at a single 
location and will only be accessing Vision in the office or over a 
Virtual Private Network (VPN) connection into the corporate 
network.

Infrastructure security is not necessarily a concern with this 
model because all application usage is internal to the 
organization. This model is designed for small firms (less than 
20 employees) without technical staff and who are not 
planning to utilize Vision Server-to-Server Synchronization. 
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Two Server Using the Two Server model to deploy Vision, you install onto 
at least two physical tiers. 

Typically, one server is a dedicated database server and the 
other server acts as the report, application, and Web servers. 
Some firms may also have the Report Server and Database 
Server reside on the same server and the web, application, 
and process server on another machine. This model suits firms 
where all users are at a single location and will only be 
accessing Vision in the office or over a VPN connection into 
the corporate network.

Infrastructure security is not necessarily a concern in this 
model because all application usage is internal to the 
organization. This model is designed for small to medium-
sized firms (20 – 150 employees) that may or may not have in-
house IT staff and who do not plan to use Vision Server-to-
Server Synchronization.

Three or More 
Servers 

Using the Three or More Servers model to deploy Vision, you 
install onto three or more physical tiers. 

In this scenario, there are one database server, one or more 
report servers, one or more Web/application servers, and 
possibly one or more Process servers. This model is designed 
for large firms (150 or more employees) with multiple locations 
that will be using Vision on an internal Wide Area Network 
(WAN). There might be additional report, Web/application, or 
Process servers required for load balancing, performance, 
security, or fault tolerance. 

This model is designed for firms having complex deployment 
requirements. Firms deploying this model should have in-
house technical staff who are also proficient in firewall 
management. 

Deployment 
Model Description
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Deltek Vision Hardware and Software 
Requirements

Before you install Vision at your firm, you must first determine if you have the 
appropriate hardware and software to run the application. The hardware and software 
you need depends on your concurrent usage requirements, the size of your database, 
and a number of other variables.

Some of the things you should consider as you think about your hardware and 
software needs:

• Workstation Requirements — How many users will need access to Vision, 
and what types of processing will they be performing?

• Database Requirements — Microsoft SQL Server 2005 SP2 or Microsoft 
SQL Server 2008 CU1. The database you choose depends in large part on 
the size of your firm and the number of concurrent users you expect to run 
Vision. 

• Server Requirements — The deployment method you choose for Vision will 
determine how many servers you need. The requirements for each type of 
server — Database, Web, Application, and Report — may vary depending on 
the size of your firm. 

Deltek strongly recommends having a dedicated Web server for Vision. 
Because the Web server is the entry point for all Vision applications, it is 
important that this server have a very high level of availability.

• Platform Requirements — You can only run Vision using Internet Explorer 
6.0 or later on a Windows platform. 

• Bandwidth Requirements — Our goal is to ensure that Vision is responsive 
on a typical network connection. Dial-up connections are suitable for simple 
tasks, but are not recommended for your primary connection to Vision.

• Licensing Requirements — You may need to purchase additional licenses 
to run Vision. For example, if you purchased SQL in a per seat capacity you 
may need to purchase SQL Server licenses equal to the total number of 
concurrent Vision users you expect to have at your firm. Typically, this number 
is about 10% of your total user base.

For more information about hardware and software 
requirements, see the Vision Product Support Compatibility 
Matrix document for your deployment (one server, two servers, 
or three or more servers). These documents are available from 
the Answers tab of the Deltek e-support site (https://
support.deltek.com), and are also accessible by hyperlink from 
the Deltek Vision Release Notes for the latest Deltek Vision 
release.
1-8

https://support.deltek.com
https://support.deltek.com


Deltek Vision Technical Overview
Before you purchase or install any additional hardware, we recommend that you 
speak with one of our Technical Consultants to determine your firm's actual hardware 
and software needs. 
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Overview of What’s New in Deltek Vision CRM and 
Proposals

Before you install Vision at your firm and begin using the software, you will want to 
acquaint yourself with the new look and feel of the application as well as with the 
various new features available to you.

• Chapter 3 of this guide provides you with an overview of the entire application and 
helps you learn how to use the Vision browser interface.

• Chapters 4 through 10 of this guide provide information about all of the new 
features in Vision. In each chapter, you’ll learn about the ways Vision differs from 
CRM and Proposals, including:
• New features
• New terminology

• Appendix A provides information about the database changes included in Deltek 
Vision. Use the following table to determine where to find the information you 
need.

Deltek CRM and Proposals Features Not in 
Deltek Vision 

The ability to create master proposal documents in Microsoft® Word from Deltek 
Vision, which is available in Deltek CRM & Proposals 3.x, is not part of Deltek Vision 
Version 6.0.

Please contact your Deltek representative if you have any questions.

Vision Area Page Reference

General Navigation and Usability 
Features 

3-53

Configuration 4-97

Info Center (data sources) 5-147

Calendar/Activities 6-219

Proposals 7-235

Reporting 8-263

Utilities 9-277

Desktop Integration 10-303

Data Dictionary Appendix A 
1-10



Deltek CRM and Proposals to Deltek V
M i g r a t i n g  t o  
D e l t e k  V i s i o n

In this chapter
� Migration Checklist
� Preparing to Install Deltek Vision
� Converting Your CRM and Proposals Database
� Installing Deltek Vision
� Testing Deltek Vision
� Going Live on Deltek Vision
ision Migration Guide 2-11



Migrating to Deltek Vision
Migration Checklist

The following checklist outlines the steps of a successful Vision install and migration. 
Where appropriate, the checklist contains references to pages within this guide or 
other Deltek documentation to help you perform each step.

The steps in this guide are intended as guidelines to use in conjunction 
with other Deltek services. For a complete list of services, see the Deltek 
Client Services section in the Introduction to this guide, beginning on 
page xii.

Step

 

1. Schedule Hardware/Software Consultation

Schedule a teleconference with your Deltek Technical 
Services consultant regarding hardware and software 
requirements.

2. Planning (onsite or teleconference)

• Plan expectations of Vision.

• Review current processes.

• Review reporting requirements and need for custom 
formats.

• Review current workflow to determine any necessary 
changes to end-to-end process.

3. Review System Differences

Review the differences between Vision and existing software 
(CRM and Proposals, RFP Gentrak, RFP for Windows), and 
assess how differences affect your organization.

4. Review new Vision features

Determine how you are going to use new Vision features. 
Refer to Chapters 3–9.

5. Review Custom Reports

• Review CRM and Proposals custom reports.

• Determine which, if any, are no longer required.

• Determine priority for each report.
6. Develop Detailed Schedule

Develop a detailed migration schedule. Make sure that team 
members understand their responsibilities and have the 
resources they need.
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7. Review Interfaces with Outside Applications

Catalogue any interfaces to outside applications that need to 
be maintained. Since Vision’s data structure is different from 
that of CRM and Proposals, interfaces need to be reviewed 
and changed accordingly.

8. Plan Data Mapping

Determine how you will collect Info Center information (project 
data, employee data, and so on).

9. Create a Backup 

Create a backup of your CRM and Proposals database. Refer 
to “Create a Backup of Your CRM and Proposals 3.x 
Database” on page 21.

10. Clean up Data

Clean up CRM and Proposals data, reviewing for duplicate 
records or records that should be marked inactive or deleted.

Refer to “Prepare Data for Migration” on page 22.
11. Install Hardware

Install required hardware and ensure that hardware (server, 
workstations, printers, and so on.) is functioning properly. 
Consult with your Deltek Technical Services representative 
and refer to the Deltek Vision Technical Installation Guide for 
assistance.

12. Install Conversion Software (if performing the conversion 
yourself), other Vision Software, and all Required 
Software

• Install the conversion software. For information on 
installing the conversion utility, refer to “Install the 
Conversion from CRM and Proposals Utility” on page 24.

• Install required Vision software and any other required 
software (Microsoft SQL Server and so on), and ensure it 
is functioning properly. Consult with your Deltek Technical 
Services representative and refer to the Deltek Vision 
Technical Installation Guide for assistance installing 
Vision software and all other pre-requisite software.

13. Perform Test Conversion

Run a test conversion. Refer to “Converting Your CRM and 
Proposals Database” on page 24.

Step
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14. Configure the Test Database

Configure the test Deltek Vision database with settings such 
as user defined fields, workflows, reports and queries. You 
should configure Deltek Vision to meet your goals and 
requirements so that your tests are run in the same 
environment that you will eventually use when you go live on 
Deltek Vision.

Refer to the Deltek Vision Implementation Guide for 
assistance.

15. Review Results

Review the results of the conversion. Refer to “Verify Records 
in Vision” on page 44.

16. Back up Test Database

Back up your test database to have a clean point to return to if 
problems arise during testing. Refer to “Back up Your Vision 
Test Database” on page 47.

17. Create Custom Report Plan

Determine how to replace custom reports that cannot be 
replaced by standard functionality:

• Which are mission critical?

• Can they be developed in-house?

• What tools will you use?

• Do you need consulting assistance?
18. Develop Import/Export Plan

Modify existing integration tools for Vision. Vision includes an 
import tool to assist with initial and ongoing data imports.

Refer to the Deltek Vision Implementation Guide for 
assistance.

19. Plan for Post-Conversion Support

Set up provisions for a post-conversion support help desk or 
other service to field questions or issues that may arise after 
conversion. Consult with Deltek to tailor a service plan to 
meet your firm’s needs.

20. Provide Operational Training

Provide operations training to the migration team members 
who will operate Vision, enter data, query data, and produce 
reports. 

Step
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21. Configure Security

Configure Vision Roles to test that the Vision security 
configuration meets your firm’s requirements.

22. Plan and Perform Segment Testing

Most firms want to simulate running the software prior to 
going live. A segment test is not a full parallel run but allows 
time to test Vision and familiarize appropriate people, such as 
the marketing and project management teams, with Vision’s 
operation.

23. Update your Firm’s Documentation

If your firm maintains user manuals to help ensure data 
consistency, you must update this documentation to reflect 
field changes or new Vision processes.You may also elect to 
enter some of this information in the field-level tool tips or 
user-definable screen help. Please see the Info Center 
Designer Help book, available from the Vision User Interface, 
for more information.

24. Provide Application Training 

Provide application training to the marketing team, project 
managers, senior managers, and other staff who will use 
Vision. 

25. Perform Final Data Conversion

Perform the final data conversion. Refer to “Converting Your 
CRM and Proposals Database” on page 24.

26. Configure the Live Database

Reconfigure your live database with the system settings you 
had configured on your test database in step 14. For example 
you will need to reconfigure security settings, Info Center 
designer settings, and report settings. If you decide not to do 
this yourself, you can have the Data Migration Group do this 
as a part of the final conversion. 

Refer to the Deltek Vision Implementation Guide for 
assistance.

27. Go Live

Begin using Vision as your management information system. 
Refer to “Going Live on Deltek Vision” on page 51.

Step
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Preparing to Install Deltek Vision

Before you install Deltek Vision at your firm, you should perform the steps listed below 
to ensure the successful migration of data from your existing CRM and Proposals 
database.

Steps to perform before installing Vision include:

• Understand Vision: Technology, User interface, Database changes, Application 
changes, Reporting tool changes

• Select Hardware and Software

• Create a Migration Plan

• Create a CRM and Proposals 3.x Data Backup

• Prepare Data for Migration

• Run Summary and List Reports (to compare with the same reports in Vision after 
conversion)

The following sections of this chapter discuss each of these steps in greater detail.

Understand Vision

Before you begin to plan your migration strategy, it is helpful to understand the new 
Vision technology and interface. The following sections provide brief explanations of 
each technology and include references to more detailed information, where 
applicable.

Technology Overview 

Refer to “Deltek Vision Technical Overview” on page 4 for an overview of the 
technology used by Vision.

User Interface

In addition to Vision’s easy-to-use browser-based interface, Vision enhances usability 
with features such as a Dashboard and saved searches. The user-configurable 
Dashboard acts as the one-stop entry point to each user’s commonly used records, 
applications and reports. Saved searches allow users to create and organize 
searches based on specific criteria. Searches can be saved personally or shared 
globally with other users.

For more information and tips about using the Vision user interface, see “Review of 
Deltek Vision Features” on page 53. 
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Database Changes

To accommodate new, integrated functionality, the Vision database is significantly 
different from the CRM and Proposals 3.x SQL Server database. Refer to “Database 
Changes from CRM and Proposals 3.x” on page 1.

You should understand the following about database conversion:

• Before you begin to migrate your Deltek CRM and Proposals data, you need to be 
running the latest version of Deltek CRM and Proposals 3.x on a Microsoft SQL 
Server 2000 platform. Deltek can assist you with conversions to the proper 
release and platform.

• You cannot convert directly from the Sybase platform to Vision. For information 
about converting from Sybase to Vision, please contact the Manager of Data 
Conversion, John Eckroth, at jeckroth@deltek.com.

• If you are running CRM and Proposals 3.x on a Microsoft SQL Server database, 
the Vision conversion utility converts all data from your existing database to the 
new database including:

• Customization and related data

• File links

• User accounts

• Most Company Data Source information (converted to Organization 
Configuration, primarily Firm Setup–Proposals)

The CRM to Vision conversion utility will not bring over:

• Security rights and groups

• Saved queries

• Proposals

• Custom fields from the Company Data Source. 

Application Changes 

Vision’s integrated design and Web interface mean that in addition to new features 
that did not exist in Deltek CRM and Proposals 3.x, some familiar functions will be 
performed in different ways. 

Chapters 3–10 provide tips for navigating in the new user interface, explain Vision 
features new to CRM and Proposals 3.x users, and show you where to perform 
functions in Vision.

If your firm created custom fields tabs in the Company Data Source, this 
content is not converted to Vision. Custom fields in other Data Sources 
are converted to the corresponding Vision Info Center (either to a tab 
called Miscellaneous, if the tab was called Custom Fields in CRM, or to a 
tab with the same name used in CRM).
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Reporting Tool Changes 

Deltek Vision Reporting offers you a wide range of reports that present information 
about all aspects of your projects, opportunities, clients, and employees.

From Vision Reporting you can:

• Generate reports for previewing onscreen or for printing. You can print the report 
right away or schedule it to run at a later time. 

• Create and save report “options” for a List Report, specifying the Info Center, data 
columns, sorting and grouping criteria, and formatting for each report option. 
Similarly, you are able to save sets of selection criteria. Both types of named, 
saved sets are available in any future reporting session, making the reporting 
process easier and quicker. 

• Select data with which to populate reports.

• Create and save “favorite” report formats. Once you have created a favorite, it 
takes just one click to generate a favorite report with current data—Vision 
automatically applies all options settings, including formatting options, and 
retrieves the appropriate records. You can even access any of your favorites from 
your Dashboard.

• Download Vision data to an Adobe PDF, Microsoft Word, RTF, Excel, TIFF, or 
CSV file, or an XML or HTML document. 

• Print or export data to Excel directly from an Vision grid. 

• Email reports from the report browser window.

• Drill down for detail on certain types of data.

• Use SQL Reporting Services to define your own reports or modify existing Vision 
reports that integrate with Vision.  

As with CRM and Proposals 3.x, Vision Reporting uses a third-party reporting tool. 
While CRM and Proposals uses Crystal Reports, Vision Reporting uses SQL 
Reporting Services. Because of this difference in third-party tools, there are several 
reporting issues to consider when migrating:

• You should review all Vision reporting functionality to determine if standard 
functionality can replace custom reports. Refer to the Reporting portion of the 
Vision Help for information about Vision reporting features. Vision Help is 
available from within the Vision application only.

You can purchase and install a separate application called, Visualizations 
to generate Visualization reports. These reports are graphical 
representations of the current health of your opportunities and projects. 
You can generate visualization reports using the standard Vision 
interface or run a Smart Client version of visualization reports, which 
generates reports more quickly. The Smart Client version includes all of 
the functionality of the standard interface as well as additional options for 
metric selection and coloring. 
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• If you decide to create custom reports, Deltek recommends that your firm rewrite 
existing Custom Crystal Reports using the SQL Reporting Services application. 
For information about using SQL Reporting Services to create custom reports, 
contact your Deltek Vision representative. 

• If your firm wishes to continue using Crystal Reports, you need to fully understand 
the differences between the Vision database structure and the Deltek CRM and 
Proposals database structure. Your firm must thoroughly test, and potentially 
rewrite, existing custom reports to work with new tables and column names. 

• If you decide to write or re-write custom reports in Crystal Reports for use with 
Deltek Vision, you will have to deploy your Crystal reports outside of the Vision 
application. 

Select Hardware and Software

As part of the planning process, Deltek Technical Services helps you choose and 
configure any new hardware or related software that you need to run Vision.

Deltek evaluates your current equipment and determines your needs in the following 
areas:

• Workstation requirements

• Microsoft SQL Server database requirements

• Server requirements

• Bandwidth requirements

• Licensing requirements

Refer to the Deltek Vision Technical Installation Guide for steps to install Vision-
related software. See “Installing Deltek Vision” on page 31 for information about the 
software you must install.

Create a Migration Plan

Proper planning is requried for the migration process. To ensure that your migration 
runs as smoothly as possible, one of Deltek’s experienced consultants will meet with 
you to help you develop a migration plan. 

As you meet with Deltek to develop your plan, there are several key issues to 
consider. Some of these considerations include:

You should have all necessary hardware and software installed prior to 
your test conversion date, so that you can begin segment testing 
immediately after conversion.
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• Will you implement other Vision applications in addition to CRM and Proposals? If 
so, you need to address departmental integration.

• Will you deploy Vision CRM and Proposals to more people within the organization 
than those who currently use the application? If so, you need to consider the 
training implications as well as the implications to your current resources. For 
example, you may need to implement additional processes to support the needs 
of the additional users.

• Will you use the Microsoft® Outlook® or Lotus® synchronization? If so, you need 
to consider the processes and guidelines for all those involved in the 
synchronization process. 

Your Deltek consultant works with your firm to develop a successful migration plan 
based on the answers to these and other questions specific to your firm.

The Planning Process

Putting together a migration plan with Deltek usually takes one or two days. During the 
planning session, Deltek:

• Helps you gather information from your senior managers, marketing 
personnel, and project managers to assess each group’s Vision requirements 
or firm-specific requirements.

• Reviews your current work breakdown structure (WBS) to determine if 
incorporating Vision’s three-level WBS would be beneficial. Be aware that 
although Vision allows up to a three-level WBS, only the first level is used for 
proposals.

• Reviews the Vision release schedule.

• Demonstrates the Vision user interface.

• Demonstrates new features and new reporting capabilities available in Vision.

• Discusses how internal procedures might be improved to make the most of 
the features in Vision.

• Analyzes the differences between CRM and Proposals 3.x and Vision to see 
how they will affect your firm.

• Discusses the special responsibilities or roles that your staff must fulfill during 
the migration process.

• Discusses the most efficient way to convert your CRM and Proposals 3.x 
database.

• Schedules the major phases in the migration process, including data 
preparation, conversion, and segment testing.

• Discusses the date you want to begin processing "live" on Vision.

• Determines whether your firm needs any custom reports or processes to 
supplement the standard options available in Vision.

• Determines a schedule for updating your internal documentation to reflect 
Vision fields, screens, and any new business rules.
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• Plans a training program for your employees.

To complete your migration plan, you need to set target dates for the following:

• Initial test conversion

• Internal documentation completion

• Segment testing period

• Pilot program (optional)

• Final conversion when you begin processing “live” in Vision (cut-over date)

Create a Backup of Your CRM and Proposals 
3.x Database

Prior to converting to the Vision database, you should make a backup of your CRM 
and Proposals 3.x SQL Server database. 

Conversion of your CRM and Proposals database permanently changes the format 
and table organization of the data, which means that you cannot convert proposals 
from CRM and Proposals for use in Vision. For example:

• The CRM and Proposals database stores text data (merged proposal documents, 
style sheets, resume text, project descriptions) in .rtf format. The Vision database 
stores text data in .html format.

• Consultant vendors are converted into vendor records and stored in Vision’s 
Vendor Info Center.

• CRM and Proposals Company Data Source information is converted to Vision 
Organization Configuration, primarily Firm Setup - Proposals. Refer to 
“Organization” on page 140 for more information about Vision Organization 
configuration.

• The conversion process does not convert custom reports, custom profile codes, 
custom fields tabs from the Company Data Source, and some other types of data. 

To back up your CRM and Proposals SQL Server database:

1. From the Start menu, select Programs » Microsoft SQL Server » Enterprise 
Manager. The system opens SQL Server's Enterprise Manager.

2. Click the plus sign (+) in front of the SQL Server Group menu choice in the left 
pane of the SQL Server Enterprise Manager window.

3. Click the plus sign (+) in front of the server you created.

4. Click the plus sign (+) in front of the Databases folder. The system displays a 
group of databases in the right pane of the Enterprise Manager window.

5. Highlight and right-click the Databases folder. 

6. Select All Tasks, Backup Database from the pop-up menu. The system displays 
the SQL Server Backup form. 
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7. Be sure the backup device is listed in the Backup to list. If no device is listed, 
click Add to select a device using the Select Backup Destination form.

8. Click OK on the Select Backup Destination form to accept the backup device.

9. Click OK on the SQL Server Backup form to backup your CRM and Proposals 
SQL Server database.

Prepare Data for Migration

For the most part, you do not need to alter your current CRM and Proposals data prior 
to converting your data. However, this may be an optimal time to perform data clean-
up, such as:

• Review custom fields — Delete fields that are redundant in Vision, or modify 
fields as needed. If you want to move data that was in user-defined fields in CRM 
and Proposals to standard fields in Vision, please contact your Deltek consultant 
for assistance.

• Delete duplicate records (particularly client/contacts) — Be careful when 
deleting fields prior to conversion. If you delete records, the data in all the fields 
related to those records will also be deleted and therefore not transferred to 
Vision. If you are unsure, Vision’s Key Conversion Utility gives you the ability to 
combine duplicate records after conversion. See “INPUT Web Service” on 
page 287 for more information.

• Delete outdated or unused records — Delete records no longer in use.

If you are also an Advantage, FMS, or Sema4 user, and you plan to 
migrate data from those systems to Vision as well as your CRM and 
Proposals data, there are more complex data issues to consider. Please 
consult with your Deltek Vision representative before continuing.
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Run CRM and Proposal Reports

Before converting to Deltek Vision, it may be helpful to run summary and list reports 
from the CRM and Proposals Data Sources. After you migrate your data to Vision, you 
can then run the comparable reports from Vision and quickly compare the data to 
verify a successful conversion.

Print several of the following Data Source reports prior to conversion:

• Clients

• Contacts

• Opportunities

• Employees

• Projects

In addition to using the above-listed reports to compare with reports you 
run in Vision after you convert your database, Deltek recommends that 
you also spot check data in individual Vision fields, on screen. You may 
also want your System Administrator to run reports directly from the 
Deltek Vision Microsoft SQL Server database to verify data was 
successfully converted.

For more information about verifying data see “Verify Records in Vision” 
on page 44.
Deltek CRM and Proposals to Deltek Vision Migration Guide 2-23



Migrating to Deltek Vision
Converting Your CRM and Proposals Database

During the time you have been using CRM and Proposals, you have likely 
accumulated a huge store of information about your firm's projects, clients, and 
employees. No doubt you will want to transfer this data from CRM and Proposals into 
Vision as quickly and efficiently as possible so that you can start using Vision. 
Therefore, as soon as you have completed all the recommended pre-conversion 
processes, and after you have installed Vision, you can proceed to the actual 
conversion of your CRM and Proposals 3.x database.

To ensure the best conversion results, we recommend performing two conversions:

• Test conversion

• Final conversion

The test conversion usually takes place a few months before the final conversion. It 
has two purposes:

• To check that our conversion program works correctly with your data and that you 
are happy with the resulting database.

• To provide you with an experimental database to use for testing and employee 
training.

The final conversion takes place at the time you begin processing “live” on Vision. 
Picking the best date to go live takes careful planning. 

After you are ready, you have two options for data conversion:

• You can send a backup of your CRM and Proposals database to one of our Data 
Conversion specialists, who will convert your data and return your data.

• You can install and run an automated conversion utility yourself, and you can 
convert your CRM and Proposals 3.x database at your convenience.

The option you choose will most likely depend on the size of your firm, the complexity 
of your database, and the resources you have available.

Install the Conversion from CRM and Proposals 
Utility

To make the conversion process as easy on you as possible, Deltek has created an 
automated conversion utility that you can use to convert your data from your existing 
CRM and Proposals 3.x database to your new Vision database. 

Conversion turnaround time is 3-5 days. Please plan accordingly.
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The following instructions tell you how to install the conversion utility. After you have 
installed the utility, you can convert your database at any time you choose.

To install the Conversion from CRM and Proposals utility:

1. From the Vision Installation CD, start the DeltekVisionUtilities.exe program. The 
Remove Installation Files dialog displays.

2. Select one of the Unpack options and click Next. The Extracting Files dialog dis-
plays.

Do not install CRM and Proposals or the conversion utility on your Vision 
servers.
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3. After the files have been extracted, click Next. The following message displays.

4. Click Yes to continue. The Deltek Vision Utilities Installation Wizard opens.

5. Click Next to display the Deltek Vision License Agreement.

6. Select the I accept the terms of the license agreement option and click Next. 
The Select Features dialog displays.
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7. Select the Deltek CRM 3.x to Deltek Vision Conversion Utility option. By 
default, the utility is installed to C:\Program Files\Deltek\Vision\6.0. Click Browse 
and select a different folder, if necessary. Click Next to proceed. The Ready to 
Install the Program dialog displays.

8. Click Install to begin installing the utility. The Setup Status dialog displays.

9. The Installation Wizard notifies you when the setup is complete. 
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10. Click Finish to exit the Installation Wizard.
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Run the Conversion from Deltek CRM and 
Proposals Utility

After you have installed the Conversion from Deltek CRM and Proposals 3.x utility, 
you are ready to convert your database.

Before you begin:

• If you have not already done so, back up your CRM and Proposals 3.x database.

• Be sure all users are logged out of CRM and Proposals 3.x.

• Your CRM and Proposals 3.x database must be named DeltekCRM before 
converting. If the CRM and Proposals 3.x database that you plan to convert is not 
called DeltekCRM, you need to back up your database and restore it as a new 
database named DeltekCRM before you run the conversion utility.

The following instructions tell you how to run the conversion utility. You can run the 
conversion utility at any time you choose. If errors occur during installation, you are 
prompted with an error message, as displayed on page 30.

To run the Conversion from Deltek CRM and Proposals utility:

1. Select Programs » Deltek Vision » Conversion from Deltek CRM 3.x, from the 
Windows Start menu. 

Vision opens the Conversion from Deltek CRM and Proposals utility.

2. Enter information in the following fields:

• Server Name — Select the Microsoft SQL Server from the drop-down list or 
type the name of the server in the field. This is the server where the existing 
CRM and Proposals 3.0 database is located and where the new blank Vision 
database will be created. The CRM and Proposals database server must be 
the same as the blank Vision database server. You can move it later to a 
different database server, if necessary.

• Database Name — Type the name of the Vision database that will receive the 
converted CRM and Proposals 3.0 data.

• SQL Login — Type a Microsoft SQL Server login ID that has System 
Administrator access on the server selected in the Server Name field.
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• SQL Password — Type the password for the SQL login ID entered in the 
SQL Login field.

• Time Zone — Select your time zone.

3. When you have verified that all the information on the form is accurate, click OK.

4. When prompted with the message, “The conversion has completed successfully,” 
click OK. You have successfully converted your database and are ready to install 
Vision.

If errors occur during the installation, the following message displays.

“There were errors in your conversion. Please email the “CRMToVision60.log” file 
found in your “C:\Program Files\Deltek\Vision\Conversions\CRM” directory to 
VisionSupport@deltek.com for further assistance.”

Locate the log file referenced in the error message and email it to Deltek Vision 
Support at VisionSupport@deltek.com.
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Installing Deltek Vision 

After you have completed the recommended pre-conversion steps and converted your 
data, you are ready to install Deltek Vision. 

The installation process includes these basic steps:

• Install Microsoft SQL Server or Microsoft SQL Server 2005 Express Edition. 

• Install Deltek Vision. (During installation, the SQL Reporting Services software 
required to run Vision reports is installed on your report server.)

• Perform Advanced Installation Steps (Registry Settings).

For detailed instructions on how to install the above applications, 
see the Deltek Vision Technical Installation Guide sent with your 
Vision software. The most up-to-date copy is also available from 
the search-based Answers tab on the Deltek e-Support site.
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Testing Deltek Vision

After you convert your database and install Vision, you are ready to begin testing the 
Vision application. The testing process is designed to ensure that your data converts 
properly and to allow you time to become familiar with Vision.

You should prepare a detailed testing plan prior to converting your database. Your 
testing plan should include employee assignments for testing, instructions for 
reporting errors, bugs, or data inconsistencies, and a time frame for completing all 
testing.

To complete testing, you need to:

• Log on to Vision.

• Configure Vision for use.

• Verify records in Vision against CRM data.

• Back up your Vision test database.

• Train your employees on Vision.

• Perform segment testing.
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Log on to Vision

Vision Splash Screen

To log on to Vision:

1. Open Internet Explorer and type in the URL to the Deltek Vision application. Con-
tact your System Administrator for the URL.

2. Click Deltek Vision, or wait while the application loads. Vision displays the Deltek 
Vision logon form.

3. In the User ID field, enter your user ID. 

4. In the Password field, enter your password.

5. From the Database drop-down list, select the database to which you want to log 
on.

6. Click Login. The Vision application opens, displaying the Welcome page.

Configure Vision for Use

When you convert data from CRM and Proposals to Vision, certain system-wide 
information is not converted, such as user security settings. In addition, there are 
some key configuration steps you must take before using Vision, such as module 
activation, server-side email setup, and process server setup. 

In addition to these configuration steps, you should configure first the test Deltek 
Vision database and then the final database with settings such as user defined fields, 
workflows, reports and queries. You should configure the test Deltek Vision database 
to meet your goals and requirements so that your tests are run in the same 
environment that you will eventually use when you go live on Deltek Vision. 
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This section includes general information about and brief instructions for the following 
processes that you must configure before you begin testing and using Vision:

• Module activation

• Security configuration

• Access to custom proposal merge templates

• Organization configuration

• Proposal Firm setup

• Server-side email configuration 

• Process server configuration

See “Configuration” on page 97 of this guide to learn more about the options available 
to you to configure additional Vision features. Also refer to the Deltek Vision 
Implementation Guide, available on your Vision installation CD, for specific 
configuration information and instructions. 

Module Activation

When you log onto Vision for the first time, you must activate the modules you want to 
use. The modules you activate depend on the applications you have purchased. CRM 
and Proposals modules may include:

• CRM

• Custom Proposals

• SF254/SF255/SF330 Proposals 

• Synchronization Server

• Document Management

• Visualization

To activate modules:

1. From the Vision main menu, click Configuration » Module Activation.The Mod-
ule Activation dialog displays.

2. In the Password field(s) that correspond with the application(s) you want to acti-
vate, enter the appropriate password(s). For example, in the Custom Proposals 
Password field, enter the Deltek assigned password for this application. 

3. Click OK.

4. Click the Logoff global icon in the upper-right corner of the window to log out of 
Vision.

5. Log back on to Vision. See instructions in the previous section, “Log on to Vision.” 
Vision opens with the appropriate module(s) activated.
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Security Configuration

When you convert your CRM and Proposals database, the conversion brings over the 
following security information:

• All user accounts in your CRM and Proposals database — The conversion 
brings over usernames only, no passwords or roles are converted.

• One ADMIN username.

• One Default role.

Before you begin using Vision, you must set up roles for all users (or groups of users) 
in your firm. You can then use these roles to define each user’s security access to all 
the Vision applications and forms as well as the lookup and reporting options that 
each user can access. You can also set up user passwords, if desired.

For detailed information on setting up security for the Vision application, see the 
Security Setup Help book (Configuration, Security Setup) in the Vision Help, available 
from the Vision application.

Access to Custom Proposals Merge Templates 

All Proposals users have full access to SF254/SF255/SF330 Proposals merge 
templates, regardless of Role settings. However, to use the Info Center merge 
functionality or Custom Proposals, users must belong to a role that has access to the 
particular custom merge template.

To define a role’s access to custom merge templates (for those using Vision 
Proposals):

1. Click Configuration » Security » Roles from the Vision main menu. 
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2. Define a Role for Proposals and/or Info Center Merge users (or open a previously 
defined role). See the Security chapter of the Deltek Vision Implementation Guide, 
for details.

3. Click the Access Rights tab and select Merge Templates from the Functional 
Area field:

4. Grant the role access to custom merge templates, in one of the following ways:

To grant full access for this role to 
all custom merge templates 
associated with all Info Centers

To grant access to only particular 
custom merge templates

A Click Full access to all merge 
templates.

A Ensure that Full access to all 
merge templates is not selected.

B From the Info Center field, select 
the appropriate Info Center.

C From the Available Templates 
column, select the template(s) you 
want to make available. To select 
multiple, consecutive templates, 
click the first template, hold down 
the Shift key, and select the last 
template. To select multiple, non-
consecutive templates, click the first 
template, hold down the Ctrl key, 
and select all other templates. 

D Click Add.

E Repeat steps A-D for all Info 
Centers.

To remove selected templates, select 
the template from the Templates for 
this Role column, and click Remove.
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5. For each employee who will merge Info Center data or use Custom Proposals, set 
up his or her user account (from Configuration » Security » Users and Pass-
words) with the Role defined previously: 

Organization Setup

In place of CRM’s Company concept, Vision uses an Organization concept based on 
a “business unit” model. You set up an Organization for each of your company’s 
business units, which may be profit centers, office locations, or other organizing 
principle.

Company data source information is encompassed in Vision Organization 
configuration, but Vision’s Organization model includes additional features, such as 
the ability to have a multi-leveled organization structure. 

Much of the company information from CRM and Proposals is converted into Vision as 
proposal firms (Firm Setup - Proposals). A two-level organization structure is also 
created and individual offices correspond to the 2nd level of the organization. After 
organizations are created, they are also associated properly with respective proposal 
firms. Without this association, Info Centers, such as projects and employees (which 
are the main entities handled in government proposals at the firm/company level), 
cannot be effectively linked to government proposals.
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For general information about Organization Configuration, see “Organization” on 
page 140. For specific information and steps to configure Organizations for use in 
Vision, see the Deltek Vision Implementation Guide.

Proposals Firm Setup

For use with the Proposals applications, Vision uses a “Proposal Firm” concept based 
on an “office location” model of your firm. You set up a Proposal Firm for each of your 
firm’s office locations whose personnel and project-related data you plan to use in 
proposals. Most of your CRM and Proposals Company Data Source data is converted 
to the Vision Proposal Firms application.

You should understand the following about Proposals configuration:

• You do not have to activate the SF254/SF255/SF330 Proposals module to set 
up your firm’s Proposal Firms. However, you must set up Proposal Firms and 
enter the appropriate data, to use the SF254/SF255/SF330 Proposals. These 
modules will not work properly without Proposal Firm data. During the 
conversion process, Company Data Source information is converted to Firm 
Setup - Proposals.

• If you will be creating SF330 Proposals, then during Proposal Firm setup, you 
must select profile and discipline codes to auto-populate in Part II Block 9 and 
Block 10 of the SF330 form from the comprehensive lists of codes stored in 
the Project Codes and Employee Skill/Discipline code tables. You do this by 
inserting the default codes you want to use in the grids on the SF330 tab of 
Firm Setup - Proposals. These are just default lists that Vision uses to 
populate the SF330 form based on the firm selected on the form. You can add 
or delete codes from the SF330 form (up to a maximum of 20 disciplines and 
22 project codes). For more information about the SF330 tab, see step 5 in 
the To Setup a Proposal Firm procedure below. For more information about 
the SF330 form, see “SF330 Proposals” on page 250.

• In Custom Proposals, if your proposal uses any merge codes that retrieve 
firm-wide data, you must set up a Proposal Firm and enter that data. For 
example, your firm's name and address do not exist in any of your 
Organization records. To make your firm’s name and address retrievable by 
Custom Proposals, create a Proposal Firm record and enter them there. 

• The CRM and Proposals label your firm uses for Company overrides 
the default Vision label of Organization when you convert from CRM 
and Proposals. (For example, Configuration, Company from the 
Vision main menu). You can continue to use this label, but keep in 
mind that the Vision Help System and all other Vision documentation 
refers to Companies as Organizations.

• If your firm created CRM Company Data Source custom fields tabs, 
these tabs are not converted to Deltek Vision.

• If your firm plans to use the Deltek Vision Multicompany feature, this 
may affect how you convert CRM company data. Please discuss this 
with your Deltek Vision representative.
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• Create a Proposal Firm for each office location, then add its related 
organization(s) on the Associated Organizations tab of the Firm Setup - 
Proposals form. An Organization can be listed for only one Proposal Firm, but 
each Proposal firm can list multiple Organizations.

• To maintain each organization's data for use according to the "office location" 
module, enter the appropriate office location data on all tabs in Firm Setup - 
Proposals. The SF 330 tab is used for SF330 proposal creation only. SF254/
SF255 users do not need to enter information on this tab.

• If the SF254/SF255/SF330 Proposals module is not installed, the Additional 
Info tab omits the Service Fees grid and the SF330 tab.

To set up a Proposal Firm:

1. From the Vision main menu, click Configuration » Organization » Firm Setup-
Proposals.

2. Create a Proposal Firm for each office location that will be used in Proposals. For 
help filling out the Firms form, click the Help button on the toolbar from within the 
Vision interface.

3. On the Associated Organizations tab, click Insert, and add the Organizations 
for that Proposal Firm, if desired. Each proposal firm can be linked to multiple 
organizations. However, two proposal firms cannot share the same organization. 
For example, if you add Organization BT: 0AD to Proposal Firm Boston, you can-
not add the same Organization to Proposal Firm - Atlanta.

If your firm plans to use the Deltek Vision Multicompany feature, this may 
affect how you use Proposal Firms. Please discuss this with your Deltek 
Vision representative.
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4. On the Additional Info tab, enter the Proposal Firm’s data to be used in propos-
als.

If the SF254/SF255/SF330 Proposals module is not installed, neither the Service 
Fees grid nor the SF330 tab appears. 
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5. On the SF330 tab, enter information specific to using the SF330 Proposal form, 
such as annual average revenue information, discipline or skill codes, or project 
codes. The Discipline codes and Project Codes (profile codes) available for inser-
tion are stored in the Employee Skill/Discipline Code table and Project Codes 
table, respectively. The codes you insert on the SF330 form will autopopulate in 
Part II Block 9 and Block 10 based on the firm you select to associate with the pro-
posal. If your firm does not plan to use the SF330 proposals form, you do not need 
to enter information on this tab. If the SF254/SF255/SF330 application is not 
installed, you will not see the SF330 

tab .

6. Click Save when finished.

Server Side Email Setup

You can use Vision’s email functionality to email reports to principals, project 
managers, and other interested personnel at your firm. You can also use this 
functionality to allow user’s to send emails to a default Help Desk for assistance.

Before you can use Vision’s internal email features, you must configure server-side 
email information. 

Vision supports 
only out-going 
SMTP email.

To set up server side email:

1. From the Vision main menu, click Configuration » General » System Settings » 
Email tab.

• See “Project Codes” on page 243 and “Employee Skill/Discipline 
Codes” on page 245 for more information about these code tables.

• For more information about the SF330 Proposal form, please see 
“SF330 Proposals” on page 250 and the Vision Help SF330 
Proposals book, available from within Vision. 
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2. Enter information in the following fields:

3. Click Save.

Process Server Setup

The Vision Process Server allows users to submit jobs, such as groups of reports, to a 
process queue and schedule them for processing. Users can submit reports to a 
process queue to keep their workstation free for other processes.

Field Description

Email Server Enter the name of the email server.

Port Enter the server port number to use for emails. The 
default SMTP port is 25.

Default Sender Enter the email address for the default sender of 
system-wide emails.

Use Default Sender for 
Default Reply To

Select this option if you want the Reply email address 
(the address that appears when you click Reply) to 
be the same as the email address you entered in the 
Default Sender field.

If you want to use a different reply address, do not 
select this option. Enter the address that you want to 
use in the Default Reply To field.

Default Reply To Enter a default Reply email address that will 
automatically appear when you click Reply. 

Default Help Desk Enter the address for sending emails to a centralized 
Help Desk mailbox. You can choose to send emails 
directly to Deltek, or you can set up an internal 
mailbox to receive and respond to questions from 
your staff.

When users click the global Help icon in Vision and 
then select Help Desk from the drop-down menu, 
Vision displays a Send Email form for users to enter 
and submit their Vision questions. The email address 
you enter in this field is automatically entered in the 
To field on the Send Email form.

Username (optional) Enter a username, if applicable.

Password (optional) Enter a password, if applicable.

Vision URL Enter your company's entire URL. For example http://
vision.deltek.com. This field is required if you want 
alert emails to work within Vision.

Send Test Email to 
Default Help Desk

Click this button to test the ability to send emails to 
the email address entered in the Default Help Desk 
field.
2-42



Testing Deltek Vision
Before you can begin using process queues in Vision, you must set up process server 
options. Once you have set up your process server options, you can use the Process 
Server utility to manage your process servers and process queues. See “Process 
Server” on page 292 of this guide for additional information on the Process Server 
utility.

To set up process server options:

1. From the Vision main menu, click Configuration » General » System Settings » 
Servers tab.

2. Complete the fields on this tab, as described in the following table:

• To add a blank row to a grid, click the Insert grid option.

• To delete a row from a grid, select the row and click the Delete grid option.

Field Description

Retain job history for x 
days

Select this option if you want Vision to save history for 
completed processes in the queue. 

If you are not retaining process history, Vision deletes 
process entries from the queue after they have run, 
failed, or been cancelled. If the process entry has an 
alert pending, Vision deletes the entry after the 
submitter has been notified.

If you are retaining process history, Vision deletes 
process entries from the queue after the specified 
number days. If the job has an alert pending, Vision 
deletes the process only after the submitter has been 
notified.

Retain Errors for x days This option allows you to set a limit on the number of 
days that the server retains error reports for 
successful runs.

If you enter an error retention period of 0 days, Vision 
saves all error reports indefinitely.

Process Queues

Name Enter a name by which to identify this process queue, 
using up to 40 characters of free text.

Dedicated Server If you want to dedicate a queue to a specific server, 
select the server from the drop-down list. Only that 
process server will run jobs on that queue.

This is useful if you want a particular machine to run 
jobs of a particular type. For example, you may want 
all large jobs to run on the most powerful machine.
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3. Click Save to save your entries.

Verify Records in Vision

Before you move on to test your conversion, you may want to spot-check data to 
review the results of conversion. 

Deltek recommends verifying data in several records in each Vision Info Center to 
ensure that the data converted properly. You should check data directly on screen in 
Vision. In addition, you can also run the same summary and list reports you ran in 
CRM and Proposals 3.x prior to conversion and compare the two sets of reports.

In the following sections are instructions to verify data in a Project Info Center record. 
The general steps to verify data, listed below, are the same regardless of the Info 
Center:

• On each tab, verify that all fields appear.

• In each field, verify that the data is accurate.

Max Enter the maximum number of jobs that will run 
concurrently in this queue, regardless of how many 
jobs are actually in the queue. Enter zero for no limit. 
The value entered here is limited by the Max 
Concurrent Jobs setting set in the WebLink utility.

Priority Enter the priority for the process queue, with zero (0) 
being the highest priority.

The priority level you enter is used to determine user 
access (by role) to the process queue.

Status This field displays the status of the queue: Running or 
Stopped.

Application Servers

Server Name Enter an application server name. These servers are 
used to run application processes, such as 
transaction posting, and also to act as your process 
servers. To manage each process server via the 
Process Server Management utility (Utilities » 
Process Server » Server Management), all process 
servers need to be established here as Application 
Servers.

Field Description
2-44



Testing Deltek Vision
• For all fields that contain drop-down lists, be sure all options appear from the list.

• Verify that all user-named tabs (if any) and all fields on these tabs converted 
properly.

• Verify that all fields on the Custom Fields tab were properly converted to the 
Vision Miscellaneous tab, if applicable.

Custom fields are converted in two ways from CRM and Proposals 3.x to Vision, 
depending on how they appeared in CRM and Proposals. 

• If you had custom fields on the Custom Fields tab in CRM and Proposals, the 
Custom Fields tab is called the Miscellaneous tab, after migrating data to Vision. 
All custom fields that appeared on the Custom Fields tab are converted to the 
Miscellaneous tab. If your firm did not use the Custom Fields tab, the 
Miscellaneous tab is not created in Vision.

• If you had custom fields on custom tabs, named by your firm, these tabs are 
converted “as is” to Vision. For example, if you created a tab called Comments in 
CRM and Proposals, a tab called Comments should appear in Vision, as should 
all the fields that appeared on this tab in CRM and Proposals 3.x.

For additional information about the Vision Info Centers, see “Info Center Records 
(Data Sources)” on page 147.

Open a Project Info Center Record to Verify Data

To verify that your CRM and Proposals Data Source records were successfully 
converted to Vision, you should open a number of records and verify the data in each 
field is accurate.

To verify Project Info Center data for one project record:

1. Log on to Deltek Vision. For instructions see page 2-33. 

2. Click Info Center » Projects from the Vision main menu.

3. Open a project whose data you are familiar with. This may be one of the projects 
for which you ran a report in CRM and Proposals prior to conversion. To open a 
project, do one of the following:

• Type the full name or project number in the Find field and click Enter.

In some cases, Vision drop-down lists derive their values from Code 
Tables, which are accessible from Vision Configuration. If some drop-
down list values do not appear, there may have been an issue converting 
the values to the appropriate code table. 

Please note that if you had a custom fields tabs in your Company Data 
Source this information is not converted because Company Data Source 
information is converted to Organization Configuration, and the custom 
fields cannot be converted.
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• Perform a Quick Find by typing any part of the project name or project number 
in the Find field and pressing Enter to display a list of possible project 
matches. Select the project from the list.

• Click the Find field to open the Project Lookup. Perform a search from the 
lookup to find the project. For information about performing searches from a 
Lookup, refer to the Vision Help by clicking the Help global icon from the 
Vision user interface.

4. Click each of the following tabs and verify that all the correct fields appear on each 
tab. Also verify that the data in each field is correct. For information about the 
fields on each tab, refer to the Vision Help.

• General

• Team

• Clients/Contacts

• Activities

• Background

• Dates & Costs

• Location

• Marketing Campaigns

• Files

5. If your firm had custom fields on the Custom Fields tab in CRM and Proposals, 
click the Miscellaneous tab and verify that all the correct fields appear on the tab 
and that the data in each field is correct. 

6. If your firm had custom fields on custom tabs in CRM and Proposals, click each 
custom tab, and verify that all the correct fields appear on the tabs and that the 
data in each field is correct.

7. When you are satisfied that all data has been converted correctly, your testing of 
this record is complete. Repeat steps 3–6 for any additional projects you want to 
verify.

If your firm has also purchased, installed, and activated other modules, 
such as the Deltek Vision Accounting or Time & Expense applications, 
additional tabs appear in the Project Info Center, but CRM and Proposals 
does not convert data to these tabs.

• When you converted to Vision, the Custom Fields tab should be 
converted and renamed Miscellaneous. If no data existed on the 
Custom Fields tab in CRM and Proposals, Vision does not create this 
tab. 

• Please note that if you had a custom fields tabs in your Company 
Data Source this information is not converted because Company 
Data Source information is converted to Organization Configuration 
and the custom fields cannot be converted.
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Run a Project List to Verify Data 

If you ran List and/or Summary reports in CRM and Proposals before converting, you 
will want to print the same reports in Vision for verification purposes. You can run Info 
Center record reports (such as a Project List) from the Print option on the particular 
Info Center’s toolbar, or you can access reports from the Reporting option on the 
Vision main menu. 

The following steps explain how to run a project list from within the Vision Project Info 
Center. For more information about running reports, refer to the Reporting or Project 
Info Center Vision Help. 

To run a project list:

1. Log on to Deltek Vision. For instructions see page 2-33. 

2. Click Info Center » Projects from the Vision main menu.

3. Open a project whose data you are familiar with. This may be one of the projects 
for which you ran a report in CRM and Proposals prior to conversion. To open a 
project, do one of the following:

• Type the full name or project number in the Find field and click Enter.

• Perform a Quick Find by typing any part of the project name or project number 
in the Find field and pressing Enter to display a list of possible project 
matches. Select the project from the list.

• Click the Find field to open the Project Lookup. Perform a search from the 
lookup to find the project. For information about performing searches from a 
Lookup, refer to the Vision Online Help.

4. From the Project Info Center toolbar, click Print » Print Current Project . The 
Reporting dialog displays.

5. Click the record-selector box to the left of the Project List to select this report.

6. Click Print.

Back up Your Vision Test Database

Before you begin aggressively testing Vision, create a backup of your test database. 
This gives you the flexibility to restore your data at any time during the testing process, 
if necessary.

To back up your Vision test database:

1 Log on to Vision. See page 2-33 for instructions.

2 From the Vision Main Menu, select Utilities » Backup Database. Vision displays 
the Backup Database dialog.

3 From the Backup Device field, select the desired backup device.

4 Click the Initialize backup device option to initialize the device before the backup 
is made. Vision will empty the backup device, and the only backup that will be in 
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that device will be the one you are doing at this time. You can have more than one 
backup devices on the database server.

5 Click Backup.

Train Employees on Vision

A crucial part of the migration process is training your employees to set up, test, and 
begin using Vision. The training process for Vision should be relatively simple 
because your employees are already familiar with the principles behind CRM and 
Proposals, which are similar to those behind the CRM and Proposals component of 
Vision.

However, your employees need to learn how to use Vision’s new browser-based 
interface, set configuration options, and run reports.

While much of Deltek’s training is formal and follows a particular agenda with 
particular goals in mind, some of the training is informal and occurs naturally as Deltek 
works with your employees.

At the outset, training concentrates on:

• Orienting employees to the Vision environment

• Preparing employees to make system setup changes necessary to perform the 
final conversion of your data to Vision

• Preparing employees to test Vision with your converted database

This initial training allows your employees to begin testing Vision as you prepare to go 
live.

While your firm continues testing Vision, Deltek provides more in-depth training on 
specific Vision applications, as well as on specific CRM concepts. After you begin live 
processing in Vision, you may want to start sending employees to some regularly 
scheduled Deltek Vision training classes.

Perform Segment Tests

After you install Vision, convert your test database, and train your firm’s employees, 
you are ready to begin segment testing.

Segment testing involves testing each area of Vision using a subset of your firm’s own 
data from your test database. Ideally, you test using data that you match to similar 
processes and reports from CRM and Proposals 3.x. Typically, the segment test 
period lasts for a period of weeks, but at some large firms it can span several months. 

The purpose of segment testing is to:
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• Providing a defined method to review the converted data

• Familiarizing your core conversion group with how Vision works

• Assisting in the identification of internal processes that need to be revised based 
on your new software application

• Identifying any conversion issues that need to be resolved before the final 
conversion

• Identifying who is going to be responsible for each component of the plan and set 
target completion dates

In preparation for segment testing, Deltek helps you create a test plan and works with 
your firm as you begin to use Vision. In addition to ensuring that Vision does what it is 
intended to do, the test period gives your firm an opportunity to become comfortable 
with Vision and to make decisions about how your data will be converted when you 
complete your final conversion.

Deltek helps you design a test plan that covers every important area of Vision. At the 
minimum, you should test the following functionality:

• In each Info Center:

• Perform several standard lookups using varying search criteria. 

• Perform several advanced lookups.

• Add records.

• Delete records.

• Modify records.

• Merge records in Microsoft Word.

• Verify summary and list report results.

• In the Activity Manager:

• View activities.

• Modify activities.

• Add activities.

• In the Calendar:

• View information on each tab.

• Modify activities through the calendar.

• Add activities through the calendar.

• In Proposals:

• Add a custom proposal.

Lookup is the Vision term for searching for and retrieving records from 
the Vision database.
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• Merge a custom proposals with a template.

• Merge a government proposal with a Form SF255 template.

• Merge a government proposal with a Form SF254 template.

• Merge a government proposal with a Form SF330 template.

Using Vision should generally yield the same results as using CRM and Proposals. 
You should investigate and resolve any significant discrepancies before your firm 
begins processing live in Vision.

After you have performed segment tests and are satisfied with the results, you can 
perform a final conversion of your data. See “Converting Your CRM and Proposals 
Database” on page 24.
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Going Live on Deltek Vision

As part of planning your migration to Vision, you must choose a “go live” date. This is 
the date on which you plan to stop processing through CRM and Proposals 3.x and 
begin processing solely through Vision. The date you choose depends on several 
factors, including:

• Employee availability (for example, holidays, other critical assignments)

• Availability of data needed for cut-over

When you reach your go live date, you must convert your database, install Vision, and 
configure your application and security settings just as you did when you created your 
test database. 

Because the go live date marks the beginning of “live” processing through Vision, if 
you perform any processing in CRM and Proposals 3.x beyond the go live date, you 
must perform the same processing again in Vision.

You may be able to import some configuration and other settings from 
your test database into your live database.

Contact a Deltek Support Representative for assistance if you plan to 
import any settings from your test database.
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Overview of Deltek Vision’s Features

This chapter teaches you how to navigate through the Vision application and 
introduces you to Deltek Vision’s system-wide features.

This chapter provides you with a point of reference as you review the remaining 
chapters of this guide, which describe the features in each of the Vision applications.

In this chapter you learn how to:

• Log on to Vision.

• Select a menu choice.

• Navigate through the application using the Vision main menu and global icons.

• Set user options.

• Access, configure, and manage your Vision Dashboard.

• Perform an Info Center Search.

In this chapter, you also learn about:

• Vision applications

• Vision system-wide features, such as alerts, utilities, and the text editor

• Internet Explorer

• Vision lookups

• Vision report printing guidelines

• The contents of this guide refer to default tabs and fields. Some of 
the tabs and fields in your application may have been changed or 
added to meet your firm’s business requirements.

If you are using Vision applications other then CRM and Proposals 
(such as Accounting and/or Planning), additional menu items, tabs, 
and fields are also available. 

Contact your System Administrator for more information about the 
Vision applications used at your firm.

• For additional information about Deltek Vision features and 
capabilities, please refer to the Deltek Vision Getting Started Guide, 
accessible from your Deltek Vision CD or the Deltek support site 
(https://support.deltek.com - Answers tab). 
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Accessing Deltek Vision

To begin working in Vision, you must do the following:

• Log on.
• Select a menu choice.

Log On

To log on to Vision:

1. Open Internet Explorer and type in the URL to the Deltek Vision application. Con-
tact your System Administrator for the URL.

2. Complete the fields on the splash screen. See the following table for details:

3. Click Login. Vision opens.

Select a Menu Choice

The default application opens when you log on. You set the default application you 
want to open each time you log on using the User Options dialog. In addition, when 
you open Vision, the Vision main menu displays on the left side of the screen.

Splash Screen field Description

User ID Unique identification for each user. Contact your Vision 
Administrator for a User ID, if necessary.

Password Individual password for each user. Contact your Vision 
Administrator for a password.

Database Use the drop-down arrow to select the desired database.

Do not load Startup 
Application

If you have selected an application to launch upon login, 
selecting this option bypasses that application and opens 
the Welcome page instead. See page 3-76 for 
information about selecting a startup application.

Windows 
authentication

Vision uses Windows security information to verify your 
log on.

See “User Options” on page 76, to learn how to set the default 
application. 
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Vision Screen and Main Menu
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Right-click an application under any Vision menu on the Vision menu tree 
and select the Open in new Window option to open the application in a 
new browser window. This allows you to have multiple applications or 
forms open at the same time. Any record that displays as a hyperlink in a 
field or grid can also be opened this way.

Alternatively, you can access any Vision application using a URL, rather 
than selecting a menu choice. You can also open any Vision record, or 
browse directly to a Vision Saved Search using a URL.

To open a Vision application using a URL, you open a browser window. 
Type the path to Vision on your server. Then append the string 
launchapp.aspx?initialpage=<appname>. For example, to open the 
Leads Info Center, you would type this URL:

<Path to Vision>/launchapp.aspx?initialpage=Leads

Where <Path to Vision> is the path to your installation of Vision (for 
example, Localhost/Vision60)

If you set up Windows Authentication for login, then the Leads Info 
Center would open directly when accessed via this URL. If you are not 
using Windows Authentication, the login page appears first. After the user 
logs in, Vision displays the Leads Info Center.

To open a Saved Search, you would type the same inital URL, and 
append information about the path to the Search. For information about 
Saved Searches and opening Saved Searches using a URL, please see 
“Record Grouping/Saved Searches” on page 92.
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Deltek Vision Applications

You access Vision applications through the Vision main menu. Each application has 
its own Vision Help section that explains, in detail, how each application functions.

Application Description

Dashboard The dashboard is your opening screen and “portal” 
into Deltek Vision, allowing you to create a 
personalized view of your business world. 

Information Center The Vision Info Center is a collection of data files that 
you use to manage all of your business-related data. 
The Info Center contains all of your projects, clients, 
contacts, opportunities, marketing campaigns, leads, 
employees, and vendors.

Client Relationship 
Management (CRM)

Vision provides you with a variety of options for 
scheduling and managing your daily activities, as well 
as maintaining information about your clients and 
contacts.

Calendar/Activities The Calendar/Activities application provides you with 
a variety of options for scheduling and managing your 
daily activities, including phone calls, meetings, tasks, 
and other important business functions. 

You manage activities using one of the following 
applications:

• Activity Calendar 

• Activity Manager 

• Info Center 

• Dashboard 

For more information, see Chapter 6, “Activity and 
Calendar” on page 219.

Proposals Vision Proposals streamlines production of SF254, 
SF255, SF330 and Custom proposals, minimizing 
preparation time and improving communication 
among the proposal team.

For more information, see Chapter 7, “Proposals” on 
page 235.
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Billing/Billing Rate 
Tables/Labor Categories

When you purchase the Deltek Vision CRM module, 
you receive the Service Estimating Tool (Service 
Estimate Tab of the Opportunity Info Center. See 
page 5-199 for more details). This tool requires 
access to the Billing Labor Categories tables. If you 
have purchased the CRM module, but not purchased 
the Vision Accounting module, this option is the only 
one enabled under the Billing menu.

Reporting Vision Reporting offers you a wide range of reports 
that present information about all aspects of your 
projects, clients, contacts, opportunities, employees, 
and vendors.

For more information see Chapter 8, “Reporting” on 
page 263.

Visualizations Visualization Reporting offers graphical 
representations of the current health of your 
opportunities and projects. You can generate 
visualization reports using the standard Vision 
interface or run a Smart Client version of visualization 
reports, which generates reports more quickly. The 
Smart Client version includes all of the functionality of 
the standard interface as well as additional options for 
metric selection and coloring. 

Utilities Vision Utilities allow you to manage your record 
formats, process server options, data import, and 
database backup functions.

For more information see Chapter 9, “Utilities” on 
page 277.

Configuration Vision Configuration contains all the tools you need to 
set up and configure the Vision application.

For more information see Chapter 4, “Configuration” 
on page 97.

Document Management Use this application to store, share and collaborate on 
a set of documents for every project, employee, 
client, contact, opportunity or other key Vision record. 
When you purchase and enable Document 
Management, a Documents tab is accessible from 
certain Info Centers. From this Documents tab, you 
can upload, link, check in or out, disassociate, and 
delete documents. 

For more information see “Document Management” 
on page 126.

Application Description
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In addition to the applications described above (which correspond to the applications 
available in CRM and Proposals), Deltek offers the following Vision applications.

Application Description

Planning The Vision Planning application is designed to guide 
project managers and proposal writers in using Vision 
to construct plans for opportunities and projects.

Billing The Vision Billing application lets you: bill labor, 
expenses, fees, and units in all industry-standard 
formats; process, modify, accept, and print invoices; 
and generate billing-related reports.

Accounting The Vision Accounting application allows you to 
maintain a list of vendors, enter and post accounts 
payable vouchers, process payments, produce 
accounts payable checks (automatically or manually), 
review accounts payable vendor and voucher data, 
reconcile bank statements, maintain a consultants 
ledger, run overhead allocation and revenue 
generation, and manage budgets.

Transaction Center — When you purchase Vision 
Accounting, the Transaction Center is available from 
the Vision main menu. The Vision Transaction Center 
is the data processing center for most of your 
business processes. Use the Transaction Center to 
enter and post A/P vouchers and disbursements, 
cash receipts and disbursements, employee 
expenses and repayments, invoices, journal entries, 
miscellaneous expenses, prints and reproductions, 
timesheets, and units.

Human Resources The Vision Human Resources application includes an 
ABRA interface, a Benefit Hours component, and a 
Payroll processing component. The ABRA interface 
automates the process of linking to Foxpro software, 
collecting and updating your employee data in an 
ABRA mapping table, then importing the data into 
Deltek Vision or exporting from Vision to Foxpro for 
processing. 

You can also purchase an ADP or Paychex Payroll 
interface, which allows you to export Vision payroll 
data to one of these third party software packages. 

Time & Expense The Vision Time and Expense application consists of 
two separate applications—Timesheet and Expense 
Report—that allow you to record your own time and 
expense charges and then submit them for 
processing.
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Purchasing The Vision Purchasing application allows your firm to 
automate its record keeping of both internal and 
project-related procurement and receiving of 
services, materials, supplies, and capital items. The 
application is designed for use in any firm, whether its 
purchasing function is centralized or decentralized.

Multicurrency The Vision Multicurrency application allows a firm to 
transact business in any number of global currencies, 
while maintaining core financial records in a single, 
“functional currency.” This application is designed for 
any enterprise that uses multiple currencies, from a 
complex global enterprise that transacts business 
daily in numerous currencies, to a single company 
that occasionally does business in foreign currencies. 

Mobile Application Suite The Vision Mobile Application Suite gives you the 
ability to enter the timesheet and expense report data 
on mobile devices, such as PDAs or laptops, when 
you are disconnected from the Vision database. 

Application Description
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Deltek Vision System-wide Features

Vision’s system-wide features include various data and word processing functions 
designed to simplify your daily tasks. They are easily accessible while working in any 
of the Vision applications. 

The system-wide features are:

• Data Access Methods
• Multi-Level Organization Structure
• Recall of Last Opened Record
• Workflow and Alerts
• Utilities
• Deltek Vision Text Editor
• Info Center/Tab Designer
• Integration with Microsoft Outlook, Microsoft Word, and the Windows Task Bar

Data Access Methods

Vision is designed to allow easy data access when working in an application, thereby 
simplifying the process of updating or searching for information. The following table 
outlines the ways in which you may select or enter data in Vision. For more 
information and examples of the following data access methods, see “Using the Info 
Center” on page 151.

Access Method Description

Drop-down Lists Drop-down lists are available in fields that contain 
a Drop-down Arrow, either at the left or right side 
of the field. 

Drop-down lists are available in most Vision 
applications. Drop-down lists display valid choices 
for completing a data entry field. Click once on the 
drop-down arrow, then click on your choice from 
the drop-down list to select the item and enter it in 
the field.

Find Icon The Find icon is found in all Find fields and in 
some data entry fields. This icon indicates that you 
have access to a corresponding lookup list for the 
field. Click once on the icon to access the lookup 
list.
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Calendar Icon The Calendar icon is found in fields that require 
you to enter a date. Click on this icon to display a 
drop-down calendar that you can use to select the 
date you want to enter in the date field.

Notes Icon The Notes icon is found in text fields that are 
linked to the Vision Text Editor. Click this icon to 
open the Vision Text Editor and enter or edit text. 
When you close the Text Editor, your text displays 
in the text field.

If you enter or modify text directly in a text field, 
you must press Shift+Enter to start a new line or 
Enter to start a new paragraph. 

Add-on-the-Fly Icon The Add-on the-Fly icon is found in certain data 
entry fields in the Info Center. Clicking this icon 
allows you to open a blank Info Center record and 
create a new record (while keeping the original 
record open). The new record is then added to 
your database and linked to the original record.

Ellipsis Icon The Ellipsis icon indicates that additional data is 
available for a data entry field. Clicking this icon 
allows you to view or enter additional data in the 
selected field.

Navigation Arrows If you have more than one record open in the 
same browser window, Vision displays a set of 
navigation arrows and fields. Use the arrows to 
scroll through the records, or jump to the first or 
last open record. Use the fields to access a 
specific record in the open list.

Slide Bars Slide bars let you maneuver among the fields 
within table grids when there are too many fields to 
display on the screen at once. The slide bars allow 
you to view data that may not be displayed when 
you initially access the grid. 

Access Method Description
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Forms and Tabs Forms and tabs contain groupings of data for a 
specific record type or process. For example, the 
Client Info Center includes General, Contacts, and 
Associations tabs. Click a form or tab name to 
access it.

Table Grids Table grids are the tables found on certain tabs, 
forms, and dialogs (such as on the Experience tab 
of Employee records). They are used to add 
record associations, link files to records, and enter 
transaction and configuration data.

You can sort data in most table grids using any 
one of the available grid column headings. Click 
on a grid column heading to establish a sort order 
(ascending or descending). Click on the column 
heading again to revers the sort order.

Columns within the grids can be reduced, 
enlarged, or moved. To change the size of a 
column, place your cursor on the vertical line at 
the end of the column name and slide it to the left 
or to the right. To move a column, click and drag 
the column name to the desired location in the 
grid. 

Grid Options The grid options available on each grid vary from 
application to application. Use the available 
options to insert, edit, copy, and delete items in the 
grid as well as to perform other functions, 
depending on the grid options available.

The Associate, Remove, and New options are 
available only on certain Info Center record grids. 
They are used to add record associations, remove 
record associations, and simultaneously create 
new records when adding record associations. 

Required Fields Most Vision forms and table grids have required 
fields. When creating new records or adding items 
to a grid, you must enter data in these fields. 
Required fields are highlighted in yellow when 
empty and become white after data has been 
entered.

Access Method Description
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Multi-level Organization Structure

In CRM, you set up your company in the Company data source to reflect the way you 
want to organize your company’s employees, projects, and opportunities. For 
example, if your company is divided into regions, your System Administrator could 
rename the Company data source to “Regions Data Source” and change the field 
labels in CRM screens to match the terms used in your company’s regions. To link a 
company record to an employee, project, or opportunity, you select that employee, 
project, or opportunity record in its Data Source, then enter the company in the 
record’s Company field. 

Vision uses CRM’s “office location” model of companies in Firm Setup - Proposals. 
The firm’s proposal data is stored on the Additional Info tab.

For modules other than Proposals, Vision uses the “organization” concept for 
companies and bases it on a “profit center” model. An organization can have up to five 
levels, which allows firms to set up their organizational structure to correspond to 
service lines, office locations, departments, divisions, or other business units. You can 
link these organizations to Proposal Firms on their Associated Organizations tab.

You can link an organization record to an employee, project, opportunity, client, 
contact, marketing campaign, lead, or vendor records from the Employee, Project, 
Opportunity, Client, Contact, Marketing Campaign, Lead, and Vendor Info Centers, 
respectively.

Relational Fields Vision’s relational database allows you to link 
information from one area of the database to 
another, creating relationships between various 
data elements. If a data entry field is relational, the 
data you enter in the field displays as a hyperlink 
with blue, underlined text. You can click the 
hyperlink to jump to the related record in the 
database. Right-click the hyperlink to open the 
record in a new browser window.

• For general information about Organization Configuration, see 
“Organization” on page 140. 

• If your firm plans to use the Deltek Vision Multicompany feature, this 
may affect how you convert CRM company data. Please discuss this 
with your Deltek Vision representative.

Access Method Description
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Recall of the Last Opened Record

When you open applications in Deltek Vision, such as the Project Info Center or 
Proposals, Vision retrieves the last opened record for the current browser session. (A 
Vision browser session begins when you log on to Deltek Vision or when you open a 
Vision application in a new window. It ends when you close the browser window.) If it 
is your first visit to the application for the current browser session, no record is 
opened. 

Alerts and Workflows

Alerts are a Vision workflow function designed to notify you when an opportunity’s 
stage changes (for example, to Awarded) or when resource utilization percentages 
are exceeding, or falling short of, percentage thresholds that you specify for a plan. 

For more information about Alerts, see “System Alerts” on page 125.

Vision uses business process management to extend business processes through 
standard protocols that use advanced Vision functionality or third-party applications. 
These processes are referred to as "workflows" even though they do not always 
require the use of the workflows feature available through Vision Configuration.

The business processes are located in Configuration and are as follows:

User Initiated Workflow —The User Initiated workflow is triggered when you add, edit, 
or delete an Info Center record. For example, you could trigger a workflow whenever 
you save a new project record in the Vision Info Center application. If you set up such 
a workflow, Vision can send an email on your behalf, present a validation warning or 
error message to the user, or even pass along information about the project to an 
external program or stored procedure that you write yourself. Then, the external 
program or stored procedure could extend the workflow, for example, by passing the 
information to a project team collaboration site, where the project's information is 
routed to the Principal and Resource Manager for approval. 

Scheduled Workflow — The Scheduled workflow is triggered when you either click a 
user-defined button or by a set schedule. For example, you have added a Project 
Meeting Audit Scheduled Workflow button. When an impromptu project meeting is 
called because a client has scheduled an unexpected site visit, you can open the 
project record, click the Project Meeting Audit Scheduled Workflow button, and trigger 
a chain of scheduled workflows to alert the team members, validate project data, and 
update the project collaboration site. 

We Service Workflow — You can use Web Services that you write to extend the Vision 
business logic from many different areas, including Time and Expense, Purchasing, 
Resource Planning, and from any user-initiated or scheduled workflow described 
above. For example, you could specify a web service that sends purchase order (PO) 
information to another workflow program when that purchase order is submitted. that 
workflow program could initiate a two-tier approval system where POs equal to or less 
than $10,000 are approved by the employee’s manager only and all POs over 
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$10,000 must first be approved by a manager and then a director. Once the workflow 
has completed in the other workflow program, your custom web service program 
could mark the PO as approved in Vision by updating the appropriate field in the SQL 
Server database. 

For more information about Workflows, see “Workflow” on page 129.
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Utilities

Vision includes a set of utilities, available from the Utilities menu that perform specific 
functions on your database. The following list contains a summary of each type of 
utility. For more information about Utilities, see Chapter 9, “Utilities” on page 277.

Utility Description

Change Company If your enterprise uses Multicompany, use this utility 
to change companies and to default automatically (or 
not default automatically) to your home company at 
startup. Note that within Multicompany, all employees 
access the same Vision database. Therefore, you do 
not need to log on and off of different databases to 
perform company-specific tasks; you simply use the 
Change Company utility.

User Activity The User Activity utility allows the System 
Administrator to display information about active 
logged on users, application servers, process server 
activity, and queue names. 
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Advanced Utilities Data Import — Lets you collect data in files outside 
of Vision and bring the data into Vision for processing.

Batch Deletes — Allows you to delete multiple CRM 
Info Center records using a multi-select lookup for 
record selection. 

Search and Replace — Allows you to update fields 
globally for multiple records with a new value with 
information from another column or via an SQL 
expression. For example, you can create a run called 
Update Status for Projects, in which the Status field in 
selected project records would be replaced with 
Dormant.

Datastage TX Integration — The Datastage TX 
Integration utility allows you configure and execute 
data interface routines between source and target 
databases. This utility is not accessible through 
Vision; contact your Deltek consultant or view the 
Deltek Vision Datastage TX Integration technical 
paper at https://support.deltek.com for more 
information.

INPUT Web Service — The INPUT Web feature 
allows Deltek GovWin to collect information for 
selected opportunities from the INPUT Web service. If 
you are using this feature, you already subscribe to 
INPUT to track a listing of various advertised 
government opportunities. This subscription gives 
you access to INPUT’s database of federal and/or 
state and local data online. Using this feature, you 
can also select the opportunities you'd like to import 
into GovWin as opportunities.

Create Client from Vendor — The Create Client 
from Vendor utility configures Vendor Info Center 
records for automatic conversion into the Client Info 
Center. This is useful for CRM users who want to 
merge Client and Vendor Info Center data. 

Key Conversions Lets you convert the structure of your project 
numbers, employee numbers, client numbers, and so 
on. These routines also let you change an existing 
number to a new number.

Key Formats Lets you set the length and delimiters for your project 
number, employee numbers, client numbers, and so 
on.

Utility Description
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Process Server Lets you manage the Vision Process Server, which 
allows users to off load time-consuming processes 
from their workstations to another workstation so that 
they can continue using Vision without interruption.

Backup Database Lets you back up your Vision database.

Report Administration Lets you monitor reports currently running on your 
report server, manage printers, and load reports from 
your application server. 

Download Merge Macro Lets you make Vision supported merge codes (for 
use with custom proposal merge templates) available 
in Microsoft Word by creating a toolbar within 
Microsoft Word. 

Download Integration Microsoft Office and Outlook Integration allows you to 
integrate Vision information with Microsoft Word, 
Microsoft PowerPoint, and Microsoft Outlook. This 
includes sharing client, contact, lead, and activity 
information, inserting Vision Opportunity record 
information or Text Library text into PowerPoint 
presentations as well as searching the Vision Text 
Library for data for your Word documents. In addition, 
you can automatically generate Vision clients, 
contacts, and activities and even search the database 
directly from your desktop. 

The Download Microsoft Integration utility allows you 
to download the software files necessary for Microsoft 
Office and Outlook integration.

Utility Description
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Vision Text Editor

The Deltek Vision Text Editor is an integrated word processor. The Text Editor 
provides the extra features necessary to create simple text documents to be included 
in the Notes and Comment fields that appear throughout Vision. Although you can 
enter text directly into a Notes or Comments field, you must use the text editor to 
manipulate text (for example, to change a font size from 8 to 10 point, or change a text 
style from regular to bold).

Vision Text Editor

The Text Editor uses many of the same features and commands found in other 
standard word processors. If you have used other word processors, such as Microsoft 
Word, many of the menu and toolbar options will be familiar to you.

Accessing the Vision Text Editor

To access the Vision Text Editor: 

1. Open the appropriate application (such as Client Info Center) and select a record. 

2. In the Notes or Comments field, click the Text Editor icon. Vision opens the 
Vision Text Editor dialog.

3. Enter your required text and/or edits. 

4. When done, click the X in the upper-right corner of the dialog, and click Yes when 
prompted to save. Vision closes the Vision Text Editor dialog. Your entry displays 
in the Notes or Comments field.

Vision saves your Text Editor files in Rich Text Format, allowing you to 
copy and paste text from any standard Windows application into the Text 
Editor fields. Some Windows programs and Web pages have unique 
formatting and graphics options that Vision may not support; thus, you 
may have to reformat text that you copy and paste from other systems. 
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Info Center/Tab Designer

The Info Center/Tab Designer allows you to change the look and feel of the tabs and 
fields in all of the Vision Info Centers — this includes both standard and user-defined 
tabs.

To open an Info Center tab in design mode, you must first open an Info Center record. 
Then, right-click a tab name, and click Design from the shortcut menu. 

General Tab Design Dialog

When you open an Info Center tab in design mode, you can perform a variety of 
actions, including:

• Resizing and moving existing fields and labels

• Changing existing field labels and add new ones

• Determining whether fields should be hidden or locked, based on users’ security 
roles

• Determining whether fields are available for CRM, Processing, and/or Accounting

• Creating your own user tips for individual fields or custom help for an entire tab

• Hiding grid columns based on an employee’s security role

To learn more about the Info Center/Tab Designer, please see the Online Help topic 
titled, Tab Designer Overview, accessible from within the Vision user interface.

Integration with Microsoft Outlook, Microsoft 
Word, and the Windows Task Bar

Deltek Vision Desktop Integration and Microsoft Office Integration allows you to use 
the Microsoft tools you are familiar with, such as Microsoft Word, Microsoft 
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PowerPoint, Microsoft Outlook, and the Windows Task Bar, to access, manage, and 
manipulate Vision data quickly and easily. 

Vision’s Integration Tools includes the following:

• Microsoft Outlook Integration

• Microsoft Word Integration

• Microsoft PowerPoint Integration

• Desktop Integration

Use Deltek Vision Desktop Integration and Microsoft Office Integration for:

• Recording Microsoft Outlook emails, both received and sent, as Vision activities

• Accessing your Vision contacts and leads lists from within Microsoft Outlook

• Creating Vision activity, client, contact and lead records from within Microsoft 
Outlook

• Searching all of Vision’s Info Centers from your Microsoft Windows Desktop, 
without launching Vision

• Creating a new Vision client, contact, or activity from your Microsoft Windows 
Desktop, without launching Vision

• Searching the Vision Text Library from within Microsoft Word, and copy the text 
you find into Microsoft Word documents

To learn more, please see Chapter 7, “Vision Desktop and Microsoft Office 
Integration”.
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Using Deltek Vision

Vision's user-friendly interface lets you easily maneuver between applications, 
records, and forms. In addition, you can access the Vision Help system from any 
application as well as determine the look of your interface.

The Vision interface components are:

• Vision Terminology
• Global Icons
• The Main Menu
• User Options
• Internet Explorer

Vision Terminology

There are certain terms that are used throughout Vision, this and other guides, and 
the Vision Help system. Review the following definitions to understand and use Vision 
properly.

Records 

A record is a collection of data pertaining to an individual item (such as project, 
employee, or client). Information about the record is collected using various tabs and 
forms. For example, each contact is a record containing data from the General, 
Activities, Opportunities, Projects, Associations, and Files tabs in the Contact Info 
Center. You can modify, delete, and copy an existing record at any time. Also, you can 
add new records at any time. Records are maintained in the Info Center.

Options 

Options are selections or choices which appear on a menu or form. Options usually 
appear in drop-down list form. Options allow the user to select the item or response 
desired.

Configuration

Configuration refers to all the forms you use to set up the Vision application. However, 
this term is no longer intended solely for your System Administrator. Vision offers a 
variety of user-friendly ways that you can use to change the look and feel of the 
application, such as renaming tabs and labels, adding new tabs, and reformatting your 
Dashboard. 
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Global Icons

Global icons are function keys that let you maneuver around the Vision applications. 
They are located in the upper-right corner of your screen and can be accessed at any 
time. The global icons are explained below.

• Application Area — Shows which part of Vision you currently have open (in this 
case, it would be the Dashboard). 

• Dashboard — Sends you to the Dashboard application.

• Options — Opens the User Options dialog. From this dialog, you set user 
preferences for your Vision application (such as color scheme) and the application 
to open when you first log in.

• Search — Allows you to search for records in the Vision Info Centers. When you 
enter a search value using the Info Center Search tool, Vision locates every Info 
Center record in your database whose name contains the search value entered. 
Unlike the Find field or Binoculars icon, which you can use to search for records 
of the type currently open, the Info Center Search tool searches all Info Center 
record types. The Info Center Search tool is available from the Vision Info Center 
menu as well as from the Vision Global Icons. 

• Back — Moves you back to the application or record you were previously working 
in.

• Forward — Returns you to the application or record you were working in before 
using the Back icon.

• Help — Connects you to the Vision Help system. The Help system appears in its 
own window so you can continue to reference the application while using the help. 
Please note that the help buttons found in an application or a form are intended 
for the specific application you are working in.

• Logoff — Takes you out of Vision and back to the splash screen. From there, you 
can either log on again or exit Vision.

The Applications Menu

The Vision Applications menu is located on the left side of the Vision screen. It 
provides one-step access to each Vision application, as well as the Transaction 
Center, Utilities, Configuration, Inventory, and Deltek Support. When you click on a 
menu option, a drop-down list appears. Select the desired option and click. Selected 
items display underlined. 

Open an Application in a New Browser Window

From the Applications menu, you can open an application or form in a new browser 
window. This allows you to have multiple applications or forms open at the same time.
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Any record that displays as a hyperlink in a field or grid can also be opened this way. 
To do so, right-click on an item in the Vision Applications menu, then select the Open 
in new Window option.

Hiding the Vision Applications Menu

You can hide the Vision Applications menu at any time to enhance the size of the 
Vision screen. To do so, click the red X at the top of the Applications menu. To 
reinstate the menu, click the Applications global icon.

User Options

Vision's User Options feature enables you to configure Vision’s look and feel on your 
workstation. It also provides easy access to frequently-used data and allows you to 
change your Vision password. 

User Options allow you, by user name, to do the following:

• Set the Vision color scheme.
• Change your password.
• Set the database to connect with (if using Integrated Security).
• Determine how Vision retrieves records in lookups.
• Determine whether the currently logged in user’s record loads automatically when 

accessing the Employee Info Center or Employee Review
• Determine whether Vision shows the navigation menu.
• Determine whether Vision includes words that sound alike in its results when you 

perform both finds and searches. 
• Set the startup application.
• Set default printing options for reports.
• Override system-wide date and time and/or number formats for your use only.
• Establish how you receive activity reminders.
• Associate your e-support site username and password.

Setting User Options

To set up User Options:

1. Click the Options global icon at the top of your screen. Vision displays the User 
Options dialog.
3-76



Using Deltek Vision
2. Complete/modify the fields on each tab. The User Options fields are explained in 
the following table:

User Options Description

Change Password Click to open the Change Password dialog where you 
enter your Old Password, then enter your New 
Password, and confirm by entering the same 
password in the Confirm Password field.

• If you are a new user, the System Administrator 
will set up your username and original password. 
Contact your System Administrator to obtain a 
username and password.

• If you are a System Administrator, it is important 
to change your password regularly to ensure 
system security. If this is the first time you have 
logged on to Vision, the Old Password field 
should be left blank, as Vision is shipped with a 
blank password field. You must enter a new 
password to ensure system security and keep 
other users from logging in with Admin rights. 

A user’s login is automatically disabled after five 
consecutive unsuccessful logon attempts. When a 
user is disabled, the System Administrator must log 
on and re-enable the user’s login credentials. 

General Tab

Color Scheme Select the desired color scheme for Vision. The 
default is Bermuda Blue.

Default Country Vision automatically displays the Default Country 
selected on the Users tab of Role Security.

You may override Vision's Default Country setting by 
selecting a new Default Country. This drop-down lists 
all countries included in the Country Code Table. 
Select a country to use as the default when you 
create new Info Center records. 

After you select a country, Vision filters all States/
Provinces drop-downs based on the selected Default 
Country.
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Automatically retrieve 
records when opening 
lookups

Select this option if you want Vision to search for all 
records automatically when the lookups are opened. 
(Note that if a lookup limit rule is in place, Vision 
applies the rule when the search takes place. Lookup 
limit rules are set in Configuration, General, System 
Settings, Lookup tab.)

This option is only available if the option Allow users 
to automatically retrieve records in lookups is 
selected from Configuration, General, System 
Settings, Lookup tab.

Automatically hide 
navigation menu

Select this option to hide the navigation menu 
automatically after you select a menu item. 
Otherwise, Vision keeps the navigation menu open.

Find words that sound 
the same when 
performing searches

Select this option if you want Vision to include words 
that sound alike in its results when performing both 
finds and searches. For example, if you search for 
John Smythe, Vision will find John Smith.

Automatically retrieve 
your record in Employee 
Info Center/Employee 
Review

Select this option if you want your employee record to 
be automatically loaded when you go to Employee 
Info Center or Employee Review. 

This option is related to the feature which allows 
employees to update their own employee record and 
to view details associated with their payroll checks. 

Startup Tab

Startup Application You can select the page you want to open, by default, 
when users open Vision. Options include a blank 
page, a company cover page that you establish, your 
dashboard, or any option from the Vision main menu. 

Remember window sizes 
and positions for Vision 
screens and reports

Establish whether Vision remembers the size and 
position of the login screen, the main Vision window, 
or any Vision report from session to session.

When this option is cleared, all windows and reports 
display at 800x600 by default. 

Windows and reports that are maximized when this 
option is selected will be re-opened at nearly the size 
of the fully maximized screen area. 

When logging into 
Vision, automatically 
connect to

You can select a default database connection for 
Vision. Your database selection displays 
automatically on the Vision splash screen each time 
you log on.

This field appears only if Vision is configured for 
Integrated Security.

User Options Description
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3. Click OK.

For your changes to take effect, you must log off Vision and then log on again.

Internet Explorer

Deltek developed Vision using the highest current standards for Web-based 
applications. All Vision components run under the latest version of Microsoft® Internet 
Explorer.

Deltek Vision and the Internet

Vision's functionality is similar to many Web sites. It contains a side main menu frame 
displaying the information you can access as well as hyperlinks you can use to 
navigate you around the product and open application forms and screens.

For Further Information...

You can find more information concerning Microsoft Internet Explorer — such as 
features, Web accessories, and Internet Service Providers — by visiting the following 
Web site.

http://www.microsoft.com/Windows/ie

Reporting Tab Use the options on the Reporting tab to select a 
default printer, default page size, font, and margins, 
and to determine whether or not to display the first 
page of a report on screen when you print the report.

Formatting Tab Date, Time, and Number default formats are set, 
system-wide, in General Company Settings; however, 
you can override those setting for your individual use 
using the Formatting tab of User Options. The Short 
Date Format is used in most places throughout 
Vision. The Medium Date Format is used on checks 
and invoices. The Long date format, for the most 
part, is used in report headings and footers.

Activity Tab Use the options on the Activity tab to establish 
whether your activity reminders come as an email, a 
popup, or both.

Support Tab Use the Support tab to enter or change your user 
name and password for Deltek's e-support site. e-
support site user information can also be changed 
from the Users and Passwords form (Configurations, 
Security, Users and Passwords).

User Options Description
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Deltek Vision Dashboard

Overview

The Vision Dashboard is your portal into the Vision application. Use the Dashboard to 
create a personalized view of your business world to make using Vision a snap. By 
combining information drawn from different areas of Deltek Vision, you can design a 
single Web page that brings together all of the information and tools that you rely on 
most. Because dashboard content is delivered according to role-based security, 
administrators can easily manage the content for individuals or groups of users.

Vision Dashboard

Accessing the Dashboard

To access the dashboard, click the Dashboard icon that is available from any 
application.

Also, you can make your dashboard the opening application each time you log onto 
Vision. See the User Options book of the Vision Help, or “Setting User Options” on 
page 76 to learn how.
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About Dashparts

Because the Dashboard is divided into individual sections or blocks called dashparts, 
you can easily manage the contents of your Dashboard.

Dashparts 

Each dashpart provides access to specific records, Web links, reports, activities, and 
applications. You can access any dashpart without affecting your other dashparts. The 
various dashparts and the Vision Tip of the Day are described in the following table:

Dashpart Description

Record Content These dashparts provide you with one-click access to 
key records, including Clients, Contacts, Leads, 
Marketing Campaigns, Employees, Projects, 
Opportunities, Proposals, and Vendors. 

You can also add new individual records, such as 
client records or leads records, directly from the 
corresponding dashpart (Client or Leads dashpart, 
respectively).

Applications This dashpart provides you with one-click access to 
any Vision menu option.

Links This dashpart provides you with one-click access to 
your frequently used addresses on the Internet, 
Intranet, and FTP sites.

Reports This dashpart provides you with a clickable list of any 
Vision report favorite that you wish. You are one-click 
away from key reports.

To display a report’s content directly in your 
Dashboard, you create the report as a report favorite 
and then add the report as a Web Dashpart. See the 
Web Dashparts description later in this table.

For information about Report Favorites, please refer 
to the Report booklet in the Vision Online Help, 
available from the Vision user interface. 

Activity Content 
(Activities)

This dashpart displays your daily calendar of 
activities.

Alerts This dashpart provides reminders about information 
flow and daily activities.
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Deltek e-Support Alerts This dashpart displays the current user's Vision e-
support site alerts. Please note that the absence of a 
support username and password in the Vision 
database for the currently logged in user results in the 
message "Incorrect username or password" when 
adding this dashpart. You associate the user's e-
support site username and password with the user's 
Vision account from the Users tab of the Users and 
Passwords form (ConfigurationSecurity, Users and 
Passwords) or from the Options dialog, accessible 
by clicking the Options icon from any application.

Web Dashparts The Web dashpart option lets you create individual 
URL dashparts for your dashboard, such as 
dashparts that connect to Web site content, FTP site 
content, or Microsoft Outlook information. You create 
a Web dashpart by selecting Configure, Create Web 
Dash Part from the Dashpart toolbar.

You can also use the Create Web Dashpart option to 
create dashparts that display any Vision report that 
has been saved as a favorite directly in your 
Dashboard. 

Vision Tip of the Day The Vision Tip of the Day provides useful information 
about Vision. Tips include time-saving shortcuts and 
information regarding new Vision features.

Dashpart Description
3-82



Deltek Vision Dashboard
Configuring Your Dashboard

You can change the configuration of your Dashboard at any time to suit your particular 
needs.

The following is a list of how you can configure your Dashboard:

• Use the Dashboard Toolbar (Configure and Window options) to add dashparts, 
create Web dashparts, or save a dashboard layout for other users.

• Use the Dashpart Heading menu to select content for dashparts, specify height 
and width, display only the dashpart heading, or remove it from the dashboard 
display.

• "Drag and drop" your dashparts anywhere on the Vision screen.
• Resize your dashparts.
• Change the name of a dashpart.
• Set Dashboard lookup limits from Vision Configuration.

Dashboard Toolbar 

Use the Configure and Window buttons on the toolbar to add dashparts and manage 
the dashboard for other users.

The following options are available from the Configure toolbar option: 

• Add Existing Dash Parts — Select this option to add any dashpart that your role 
allows you to access.

• Create Web Dash Part — Select this option to add a dashpart that connects to 
intranet or Internet content such as Web sites, FTP sites, Microsoft Outlook 
information, report favorites, or files on your machine or a network drive. To create 
Web dashparts (or URL dashparts), your role must have the Allow users to add 
web parts option selected from the Access Rights tab of Role Security 
configuration with URL Dashparts selected from the Functional Area field.

• Save Dashboard for Users — Select this option to save dashboard layouts for 
other users. Implementing this security option, a user copies the layout and data 
currently available on his or her dashboard and overwrites another user's 
dashboard with the same layout and data. When you select this option, a dialog 
displays allowing you to select which users in which roles will have their 
dashboards overwritten. 

Your ability to save dashboards depends on your security role.

In the event that security rights differ between the user overwriting a dashboard 
and a user whose dashboard is being overwritten, security will take precedence 
for the user whose dashboard is being overwritten.
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The following options are available from the Window toolbar option:

• Cascade — This options cascades your dashparts. 

• Tile Horizontally —  This options arranges your dashparts horizontally in one 
row.
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• Tile Vertically  —  This options arranges your dashparts vertically in one column.

• Tile Grid —  This option arranges the dashpart in rows of 2 or more columns, 
depending on whether you hide the main menu.
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Dashpart Heading Menu

Each dashpart heading contains menu items you use to modify that particular 
dashpart. These heading options are outlined in the following table:

• Scroll bars appear in a dashpart when the number of records 
displayed is longer than the height of the dashpart. They also appear 
on the Vision screen when the number of dashparts exceeds the 
viewable area of the Vision screen or when dashparts are dragged 
beyond the bottom and right margins of the Vision screen. See Drag 
and Drop on page 87 for more information about dragging dashparts.

• You can specify how many records display at one time in any 
dashpart by entering a value in the Use dashboard lookup limits 
field on the Lookups tab of the General System Setup form 
(Configuration, General, System Settings).

Option Description

Dashpart Name Drop-
down 

Depending on the dashpart, selecting the Dashpart 
Name drop-down allows you to perform the following 
tasks:

• Configure — Establish the content of the 
dashpart. The options vary depending on the 
dashpart. For example, using the Configure 
option, you select Info Center records for Info 
Center dashparts while you select the types of 
activities to view and the type of display for the 
Activity dashpart.

• New — Add a new record to the associated Info 
Center or application.

• Clear — Remove all of the content from the 
dashpart. For example, clear all selected Client 
records from the Client dashpart. This does not 
delete the records from the Client Info Center.

• Print — Select this option to print a dashpart.

• Hide Dashpart — Remove the dashpart from the 
Dashboard display. To view this dashpart again, 
add it using the Configure, Add Existing 
Dashparts toolbar option.

• Hide All Others — Hide all other dashparts 
except the dashpart from which you select the 
Hide All Others option.

• Delete Dashpart  — Select to delete a dashpart.

• Set Color — Select the toolbar heading and line 
color.
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Drag and Drop

You can drag and drop dashparts. This means that you can place the dashpart 
anywhere on the Vision screen by placing your cursor over the dashpart heading, 
holding your left mouse button down, and then dragging the dashpart to its desired 
location. 

Dashparts can be dragged past the right margin and below the bottom margin of the 
Vision screen; however, they cannot be dragged past the left margin or above the top 
margin. Dashparts remain where they are dropped, even if that is on top of another 
dashpart. 

Maximize 
and
Restore

Clicking the maximize option expands a dashpart to 
completely fill the Vision screen. All other dashparts 
will be hidden.

When the dashpart is maximized, the expand/
collapse (up/down) arrows are disabled. Also, you will 
not be able to drag and drop or resize dashparts.

Click the restore icon to restore the dashpart to its 
original size.

Refresh Click this icon to refresh the contents of a dashpart, 
saving any changes you have made to that dashpart. 

Data is also refreshed any time you access the 
dashboard.

Up and Down Arrow Click the up arrow to collapse a dashpart. Only the 
dashpart heading will appear on your dashpart. It can 
still display as if the dashpart were expanded. Click 
the down arrow to expand the dashpart on your 
Dashboard.

Remove Click this icon to remove a dashpart from the Vision 
screen.

For more information about dashpart options specific to each dashpart 
type, see Dashpart Types in the Vision Online Help, available from within 
the Vision user interface.

Option Description
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Resize

To resize a dashpart’s width and height:

1. Hold your cursor over the right-bottom margin of the dashpart. Your cursor 
changes to a resize icon.

2. Resize your dashpart as desired. Dashparts may be resized past the bottom and 
right margins of the Vision screen.

Dashparts being resized appear on top of other dashparts, and remain on top while 
dragging. Resized dashparts also remain on top after the mouse is released.

Configure Dashboard Lookup Limits

Your System Administrator can set record retrieval limits that apply to all dashparts 
that contain lookup lists. This lookup limit is similar to the Vision system-wide limit set 
for all lookups, but applies only to the Dashboard.

Set Dashboard Lookup limits from the Lookups tab of the General System Setup form 
(Configuration » General » System Settings). 

Saving Dashboard Changes

Any changes made to your Dashboard are automatically saved whenever you leave 
the Dashboard to work in an application or log off Vision. Also, your changes are 
saved when you refresh a dashpart. 

The following list highlights Dashboard changes that are automatically saved:

• Any changes made to a record, report, activity, link or alert, even if those 
dashparts are subsequently removed or hidden from the Dashboard.

• Any dashpart that previously appeared on your Dashboard.

• The dashpart position on the Dashboard.

• The dashpart size (height and width).

• Expanded and collapsed dashparts.

• Maximized and minimized dashparts. If a dashpart had previously been 
maximized, the Dashboard will open displaying only that dashpart. 

• Tailored dashpart labels.

The only circumstance when a Dashboard is not automatically saved is when your 
Administrator overwrites your Dashboard changes. Please see Save Dashboard for 
Users on page 83 to learn more about this feature.
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Deltek Vision Lookups

Overview

Use lookup lists to locate a record, or a group of records that share a specific type of 
data. For example, you can use a lookup list to search for all of your contacts that live 
in a particular state or find all your projects with similar types. Also, you can access 
single records, such as an employee’s Employee Info Center record, using a specific 
employee number.

Lookup lists are available wherever you see the Find icon in the upper-right corner of 
a field. Click the Find icon to access a lookup list.

Lookup lists work by narrowing your search criteria, thereby eliminating the need to 
examine large numbers of records to find specific information. Instead, you have only 
the records you need at your disposal.

Select the Find words that sound the same when performing searches option, 
available from the General tab of the Option dialog, if you want Vision to include words 
that sound alike in its results when performing both finds and searches. For example, 
if you search for John Smythe, Vision will find John Smith.

For more information about searches in Vision, see Info Center Search in the Vision 
Help system.

Configuring Lookup Lists

In General System Setup, you can establish a lookup limit, determine the number of 
records that Vision retrieves during a lookup, and authorize users to automatically 
retrieve records in a lookup.

To set up lookup list options:

1. From the Vision main menu, click Configuration » General » System Settings » 
Lookups tab.

2. Complete/modify the fields on this tab, explained in the following table.

Lookups tabs field Description

Allow users to 
automatically retrieve 
records in lookups

If this option is selected, Vision controls whether 
records are automatically retrieved when lookups are 
initially opened. If the option is not selected, Vision 
does not retrieve records automatically in lookups.

If this option is selected, you can set a lookup limit to 
determine how many records to retrieve at one time.
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3. Click Save.

Use lookup limits Select this option to place a limit on the number of 
records Vision will retrieve in a lookup at one time. If 
your company has a large database, you may want to 
limit the number of records Vision retrieves at once 
since retrieval may take some time. 

If you selected this option, select the maximum 
number of records in the Maximum number of 
records field.

Maximum number of 
records

If applying a lookup limit rule (Use lookup limits 
field), then enter in this field the number of maximum 
records to retrieve at one time. 

When you select this option, two links appear at the 
top of the lookup after a search is performed: 
Previous Rows and Next Rows. Click Next Rows to 
retrieve the next batch of records matching the 
search. Click Previous Rows to browse back to 
previously viewed items.

Use Dashboard lookup 
limits

Select this option to place a limit on the number of 
records Vision will retrieve and display in a dashpart 
at one time. You may want to set a dashpart lookup 
limit to better fit content to the specified dashpart size 
and also to decrease the load time of your dashboard. 

If you selected this option, select the maximum 
number of records in the Maximum number of 
Dashboard records field.

Maximum number of 
Dashboard records

If applying a lookup limit rule (Use Dashboard 
lookup limits field), then enter in this field the 
maximum number of maximum records to retrieve at 
one time. 

When you select this option, two links appear at the 
top of any dashpart for which you can perform a 
lookup, after a search is performed. These links, 
Previous Rows and Next Rows, allow you to 
retrieve additional records. Click Next Rows to 
retrieve the next batch of records matching the 
search. Click Previous Rows to browse back to 
previously viewed items.

Lookups tabs field Description
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Lookup List Options

There are four basic search types to choose from when using a lookup list:

• Direct — The Direct lookup functions much like a Standard lookup, but it has 
fewer search options.

• Standard — Use the Standard lookup for one-time searches using simple criteria, 
such as name or number.

• Advanced — Use the Advanced lookup to enter additional criteria that limits the 
data retrieved by the search.

• SQL Where Clause — Use the SQL Where Clause lookup to enter your own SQL 
WHERE clauses that limits the data retrieved by the search. 

Which search type you choose depends on the complexity of your search. Each type 
of lookup is explained in detail in the Vision Help system. 

Quick Find Searches

An example of a 
key code is an 
Employee’s last 
name or a Client 
number.

Quick Find searches let you access a record by entering part of a valid key code, 
providing a valuable method of simplifying a record search. 

To perform a quick find search:

1. Click once inside the Find field of the record you are working in.

2. Enter either a single character (for example, the letter “a” or the number 3) or a 
string of characters (“ab” or “13”), and then press Enter. If you enter a single char-
acter, then Vision searches for every record beginning with that character. If you 
enter more than one character, Vision searches for every record that contains that 
string of characters.

If the information you have entered matches a value in the Vision database, Vision 
automatically opens the record.
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Multiple Record Matches

Sometimes when you use the Quick Find search, the information you enter produces 
more than one result. In the case of multiple record matches, Vision displays a box 
containing all the records that match the criteria you entered. 

To open a record from the list, click the record you wish to access.

Retrieve Results that Sound Similar

Vision provides the option to structure all Lookups to search not just on the exact 
search entry, as typed, but also for words that sound similar to the entered text. 

When this option is selected, Vision to includes words that sound alike in its results 
when performing both finds and searches. For example, if you search for John 
Smythe, Vision will find John Smith.

The Find words that sound the same when performing searches option is set in 
the User Options dialog. See “User Options” on page 76 for more information.

Record Grouping/Saved Searches

Record grouping allows you to use lookups to create group folders and associate 
records to the group through saved searches or queries. When you develop and save 
a search, you may then use the search as the basis for records that belong to the 
group. Any new records added to the database that match the search automatically 
become part of the group. This is particularly helpful in providing users easy access to 
common records within the database.

Your saved searches can be stored in Global (public) or Personal (private) folders, as 
shown in the following illustration.

If a search is saved in a global folder, it becomes available to all users. If a search is 
saved in a personal folder, only the user that created the search can access it. In 
addition, users must be given rights in security to add queries to the global folders. 
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To do this, select Save For All Roles for the Lookup/Reporting Organizing option 
from the General tab of Roles Security. (Configuration, Security, Roles, General tab). 

Global and Personal Searches

The record grouping functionality is available on all lookups (except Direct lookups), 
and saved searches can be accessed throughout the Info Center.

You can launch any saved search directly from a URL. To do this, open a 
browser window, and type the path to Vision on your server. Then append 
the string 
launchapp.aspx?initialpage=<appname>&keyValue=Search|<folder 
name>|<sub folder name>|<search name>.

For example, based on the Personal Search shown in the screen shot on 
this page and assuming Vision is installed to the path localhost/vision51, 
you could open the My Contacts Saved Search using the following URL:

Localhost/Vision51/
launchapp.aspx?initialpage=Contacts&keyValue=Search||Personal 
Searches|My Contacts.

Global Searches are 
available to all users; 
Personal Searches 
are private.
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Is Mine and Is Not Mine Organization Lookups

When using the Advanced Lookup option and narrowing your search using any of 
your firm’s defined Organization levels as a Search Type, you can use the “is mine” 
and/or “is not mine” Operator to further tailor your search. 

For example, if your firm has defined two levels of Organization — Profit Center and 
Office —  and you want to retrieve a list of all projects that belong to a particular profit 
center, but exclude certain offices from that list, you can use the is mine and is not 
mine operators. If an employee performs a project lookup with a Search Type of profit 
center and an Operator of is mine and a Search Type of office and an Operator of is 
not mine, Vision’s lookup functionality will return a list of projects associated with the 
currently logged in employee’s profit center, but not associated with his particular 
office location.  
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Deltek Vision Reports

You have several options for viewing/delivering a report:

• You can download a report as a viewable PDF file, which will display in a browser 
window (Adobe PDF (View) option).

• You can download a report as a PDF file (Adobe PDF (Save) option) and then 
print to your local printer by opening the PDF file from your client workstation. To 
print saved PDF files, you must first install the free Adobe Acrobat reader on your 
client workstation.

• You can set up network printers on the report server and then print the report 
directly from the Vision Reporting application to one of the network printers.

• You can schedule reports to run on the report server at a later date or time.
• You can specify print options specific to the selected printer, such as paper size, 

paper source (tray), whether or not to use color, and the scale at which to print.
• You can export a list-style report to an Adobe PDF file or a Microsoft Excel 

spreadsheet without necessarily generating or previewing the report first, using 
Data Export reports. 

• You can specify how long to save copies of previously run reports on your report 
server.

• You can save electronic copies of reports in Adobe PDF or Microsoft Excel format 
to your application server each time you print a report.

• You can purchase and install a separate application called, 
Visualizations to generate Visualization reports. These reports are 
graphical representations of the current health of your opportunities 
and projects. You can generate visualization reports using the 
standard Vision interface or run a Smart Client version of 
visualization reports, which generates reports more quickly. The 
Smart Client version includes all of the functionality of the standard 
interface as well as additional options for metric selection and 
coloring. 

• For more information about Vision reports, see the Reporting chapter 
in this guide.
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C o n f i g u r a t i o n

 In this chapter
� Overview
� Accessing Vision Configuration
� General System Configuration

� System Settings
� Company Settings
� User Defined Tabs
� Lookup/Report Labels
� Calculated Fields
� Custom Report Options
� Code Tables
� Project Templates
� Project Defaults
� Opportunity Settings
� Merge Templates
� Holiday Calendar
� Currency
� System Alerts
� Document Management
� Client Hierarchy

� Workflow
� Security Configuration 
� Organization
� Accounting
� Module Activation
� About Deltek Vision

Chapters 4-10 explain key Vision features, starting with 
the Configuration application. Each chapter corresponds 
to an application on the Deltek Vision main menu, or 
available for purchase and installation separately, and 
contains an overview, access instructions, key feature 
explanation, and  the application’s counterpart in CRM 
and Proposals (where applicable).
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Overview

Deltek Vision includes a Configuration application that allows your System 
Administrator to configure the Deltek Vision application to meet your organization’s 
business requirements. 

Vision Configuration includes the following:

• General System Configuration — Determine general system settings, such as 
system labels, email and server configuration settings and Lookup settings.

• General Company Configuration —  Determine general company-specific 
settings, such as company name and address, and date and number formats.

If you are using the Vision Multicompany feature, you will set company-specific 
settings for each company you create in Vision on the General Company Settings 
form. If you are not using the Multicompany feature, you simply set your firm’s 
company-specific information once on this form.

• Other General Settings — Configure additional general information from user-
defined tabs and fields to merge templates and firm holidays. In addition to the 
General System Settings form and General Company Settings forms, there are 
additional Configuration forms under the Vision menu’s General Configuration 
heading. The specific options may depend on applications your firm has 
purchased, such as Document Management or Multicurrency. 

• Workflow Configuration — Configure settings for user-initiated or scheduled 
workflows.

• Security Configuration — Create user roles and establish access rights (similar 
to Deltek CRM and Proposals’ Security).

• Organization Configuration — Enter and set up firm details (similar to Deltek 
CRM and Proposals’ Company Data Source).

• Accounting Configuration — Even if your firm has not purchased any 
accounting-related Deltek Vision modules, the Accounting System Settings form 
is available from Accounting Configuration. This is because the Service 
Estimating tool uses account ranges and labor categories, which are established 
on a system-wide basis from the Accounting Systems Settings form. Also note 
that the Billing module is available because specific rates are associated with 
labor categories from the Billing Labor Category Tables form.

• Module Activation — Select the Vision applications to be used.

• About Deltek Vision — View details about your version of Vision, such as the 
application version number and database version number.
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The contents of this guide refer to default tabs and fields. Some of the 
tabs and fields in your application may have been changed or added to 
meet your firm’s business requirements.

If you purchased other Vision applications, such as Accounting and/or 
Vision Planning applications, additional menu items, tabs, and fields are 
also available.

Contact your System Administrator for more information about the Vision 
applications being used at your firm.
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Accessing Vision Configuration

How do I access 
Vision 
Configuration?

In CRM and Proposals 3.x, you performed configuration and security functions from 
the System menu or Maintenance button on the Shortcut Bar. Comparable 
applications are available in Vision from the Configuration option on the Vision main 
menu.

Some functions you performed from the CRM and Proposals 3.x System 
and Maintenance menus, such as batch deletes, are accessible from 
Vision’s Utilities menu option, and not the Configuration menu. See 
“Utilities” on page 277.
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General System Configuration

General system configuration refers to the procedures you use to specify system-wide 
settings. 

In Vision, you specify most system-wide settings from the forms accessible from 
Configuration >> General on the main menu. This section describes the setup 
options available in each form.

General System Configuration is divided into the following sections:

• System Settings

• Company Settings

• User Defined Tabs

• Lookup/Report Labels

• Calculated Fields

• Custom Report Options

• Code Tables

• Project Templates

• Project Defaults

• Opportunity Settings

• Merge Templates

• Holiday Calendar

• Currency

• System Alerts

• Document Management

• Client Hierarchy

You configure user preferences, such as the Deltek Vision application’s 
color scheme, from the User Options dialog, which accessible by clicking 
the Options global icon at the top of the Vision application. For more 
information about User Options, refer to page 3-76.
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System Settings

To access Vision General System Settings, click Configuration » General » System 
Settings from the Vision main menu.

General System Settings Form

Vision General System Settings form is composed of the following tabs:

• Lookups — Use this tab to set record retrieval limits for lookups in searches and 
on the Dashboard.

• Email — Use this tab to define your default email server and delivery 
specifications for Vision help emails. For example, you can enter the email 
address for a contact person at your firm in the Default Sender field and the 
Deltek support email address in the Default Help Desk field. This directs all user 
questions to Deltek while all responses are sent to a single contact at your firm.

• Servers — Use this tab to set options for process queues, Actuate report servers, 
and application servers.

• Labels — Use this tab to enter different names for various default labels in Vision. 
You can specify your own singular and plural labels to replace the following 
default labels in Vision:
• Client
• Contact
• Marketing Campaign
• Leads
• Opportunity
• Employee
• All Work Breakdown Structure (WBS) labels
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• Vendor
• Text Library
• Proposal
• All Organization level labels
• Principal
• Project Manager
• Supervisor

• Numbering — Use this tab to review the number formats for your Vision records, 
such as project number formats.

• Synchronization — Use this tab to synchronize client information that is linked to 
contacts originating from Microsoft Outlook, Microsoft Exchange or Lotus Domino. 
This tab is only available if the Synchronization application is installed.

• Miscellaneous — Use this tab to share your calendar with other users or to set 
the polling interval for activity alerts. The polling interval determines at which 
frequency the process server checks for alert processes waiting in the queue and 
performs automated queue tasks on the alert processes.

• Audit Trail — Use this tab to enable and configure the Audit Trail feature. The 
Audit Trail feature allows you to keep track of changes made to your Info Center 
records. Audit trails are triggered when users perform update, delete, and insert 
actions on your Info Center records. 

• Document Management — Use this tab to set up and maintain your document 
sites, document libraries, and document folders.

• Labels that you customized in your CRM and Proposals database 
are converted to Deltek Vision as is. For example, if you renamed the 
Employee data source to Staff, this label appears in Vision as well, 
instead of the default Vision label, Employee.

• When you convert from Deltek CRM, the default label for 
Organization is converted to whatever label your firm used for the 
Deltek CRM Company Data Source, since much of the information in 
Organization configuration derives from the Company Data Source. 
Organization Level 1 is converted to the same label (Company), and 
Organization Level 2 is converted to Office, by default.

You can continue to use these labels, but keep in mind that the Vision 
Help System and all other Vision documentation refers to Companies 
as Organizations.

• If your firm plans to use the Deltek Vision Multicompany feature, this 
may affect how you use labels such as Organization and Company. 
Please discuss this with your Deltek Vision representative.
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General Company Settings

To access Vision General Company Settings, click Configuration » General » 
Company Settings from the Vision main menu

General Company Settings Form

Use the General Company Settings form to enter your firm name, byline, and address, 
and to address formats for Vision.

If you are using the Vision Multicompany feature, you will set company-specific 
settings for each company you create in Vision on the General Company Settings 
form. If you are not using the Multicompany feature, you simply set your firm’s 
information once on this form.

About Phone Formats

Phone formats are set up within the Phone Format code table. By using these formats, 
you ensure that the entry of phone numbers is consistent throughout Vision. In the 
Phone Format code table, you can enter multiple formats for a country. For example, 
for United States, you can create a format for regular phones and a format for cell 
phone.

• For information about setting up phone number formats in code 
tables, see the topic titled, “Code Tables Setup Overview” in the 
Vision Online Help. 

• For information about how phone formats are used in the Info Center, 
see “Setting Standard Phone Formats” on page 163.
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About Address Defaults

Vision includes settings that allow you to select State, Country, and Address formats in 
order to support international clients. You determine these formats within Code Tables 
Setup and General Company Setup.

• For information about setting up international address formats, see 
the “International Address Formats” topic in the Vision Online Help.

• For information about setting up phone number formats in code 
tables, see the topic titled, “Code Tables Setup Overview” in the 
Vision Online Help. 
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User Defined Tabs

In CRM, you create each Data Source’s custom tabs and their fields by opening the 
Data Source and selecting Maintenance » Add Tab Wizard. Tabs can include custom 
fields or grid-style columns of fields. 

Vision comes installed with standard tabs, whose names you can edit. You can also 
add user-defined tabs. You can reorder all Vision tabs, standard and user-defined, 
from Configuration » General » User Defined Tabs. You can add new tabs or 
reorder existing tabs for any Vision Info Center.

User Defined Tabs Form

Vision User Defined Tabs form is composed of the following tabs:

• Tabs — Use this tab to add or modify standard and user-defined Info Center tabs 
and to delete user-defined tabs.

• Fields — Use this tab to add, modify, and delete fields on standard and user-
defined tabs in Info Centers. 

• Grids — Use this tab to add, modify, and delete user-defined grids for Info 
Centers.

• Mappings — Use this tab to map field and grid data between the Opportunity Info 
Center and Project Info Center.
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Determine The Need for User Defined Tabs

Deltek recommends that your organization review its need for user-defined tabs and 
fields during the Vision implementation and planning process. 

In determining the additional data you need entered in each Info Center and how to 
set up new tabs and fields in each, review Vision’s standard tabs and fields to identify 
those that:

• Your organization does not use

• Need to be relabeled with your firm’s terminology, to make their purpose clear to 
your users

• Need to be reordered

• If your firm uses the Deltek CRM Custom Fields tab, when converting 
to Deltek Vision all data on this tab is converted to a Miscellaneous 
tab in the Info Center corresponding to the tab’s Data Source. Any 
custom tabs you created in Deltek CRM are converted to Vision as 
the same name you used in Deltek CRM.

• If your firm created custom fields tabs in the Company Data Source, 
these tabs are not converted to Deltek Vision because this data is 
migrated to the Organization application and not to an Info Center.

• In Vision, your System Administrator can delete a user-defined tab. 
This action permanently removes the tab, all of the fields associated 
with the tab, and any data entered into the fields, from every 
database record.

• If you decide to relabel tab and/or field names with you firm’s 
terminology, be sure to also make the corresponding label changes 
from the Lookup/Report Labels form (Configuration » General » 
Lookup/Report Labels).

• For more information about user-defined fields, including detailed 
instructions on adding user-defined tabs, please refer to the Vision 
Help System. To do this, click the Help global icon from any Vision 
application, and browse to the User Defined Tabs and Fields book, or 
open the User Defined Tabs form, and click Help on the toolbar.
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Refer to the following table for a description of data types from Deltek CRM and their 
counterparts in Vision.

CRM Data Type Vision Data Type Comments

Character Character This is also known as “string 
type” in CRM. Acceptable 
characters are alpha-
numerics, limited to a 
maximum of 40 characters.

CheckBox CheckBox

Currency, Number Numeric Use the Currency and 
Decimals columns as 
needed, to further define this 
data type.

Date Date

Lookup Lookup

N/A Search This data type lets you 
create a field from which you 
can open a record search. It 
is similar to the Lookup data 
type, but while the lookup 
field contains a drop-down 
list of records, the search 
field does not retrieve 
records until the user opens 
the dialog and clicks Search. 
Use this option if you have a 
large amount of records in 
your lookup list.

Memo Memo

N/A URL This data type lets you enter 
and save a Web site in the 
field. You can click the field 
and open its Web site in a 
new browser window.

N/A Client Each of the remaining data 
types lets you create a 
lookup field to search for 
records in that Info Center.

N/A Contact

N/A Employee

N/A Opportunity
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User Defined Tabs Application and the Info Center Designer

After you have added user-defined tabs, fields, and grids, you can use the Info Center 
Designer to easily re-arrange tab elements, resize fields and labels, and determine 
whether you want certain fields hidden or locked based on Security role. See “Info 
Center/Tab Designer” on page 167 for more information.

Lookup/Report Labels

Lookup/Report Labels is a custom label application that allows you to change the 
following types of labels related to lookups and reporting:

• Search Types — These labels consist of all the search types that appear in 
the drop-down menus for standard and advanced view lookups.

• Search Labels (Generic) — These labels are commonly used for standard 
labels, such as Code, Description, Name, and so on (especially for advanced 
sublist search labels). 

• Report Columns —You can change the default report column headings and 
alternate headings (which are mostly used on reports that allow cost and 
billing labels for the same column). Report column labels only apply to column 
selection reports.

• Report Groups — These labels are for items that can be grouped on reports. 
Changes made here will also change the heading label.

• All Application Types — Lists all of the above application types.

All labels are available in a single grid. This allows you to sort by label to change 
similar labels across multiple lookup/report types. Users can also filter the grid by 
different label types — specific report, specific lookup, and so on. 

If you attempt to change a label and that changed label exists somewhere else in the 
database, Vision gives you the option to change all labels that match the original 
changed label. If you are sure that all labels that would be changed are labels that you 
want changed, this feature can make it easier to change many labels at one time.

N/A Project 

N/A Organization

N/A Vendor 

N/A Text Library

CRM Data Type Vision Data Type Comments
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You access the Lookup/Report Labels form by clicking Configuration » General » 
Lookup/Report Labels from the Vision main menu.

Lookup/Report Labels Form

Use the automatic label change feature mentioned above with caution. 
Only select to change all other labels of the same name in the database if 
you are sure that these are labels that you want changed. There are 
instances where the same field name or tab name appears in different 
Info Centers, such as Name or Type. If you change one of these labels, 
and then select the option to automatically change all other labels of the 
same name, you may inadvertently rename fields or tabs you did not 
intend to rename.
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Calculated Fields

Use the Calculated Fields form to create global calculated fields available for selection 
on all column selection reports. Create custom calculations using any of the existing 
numeric columns available for a given report, such as the Employee List or Client List. 
Also, use this application to apply conditions to calculations. Calculated field columns 
are available for selection on column selection reports for all roles.

For example, if you are working on a Federal government contract and need to report 
both the “Get” and “Go” probability, you can create user-defined fields to calculate the 
Weighted Go Probability. 

On the General tab of the Opportunity Info Center, Revenue, Probability, and Wt. 
Revenue (weighted revenue) fields exist by default. The values entered in these fields 
can be used on reports to show the Weighted Get Revenue or the expected revenue 
multiplied by the probability of being awarded the contract. If you also need to report 
Weighted Go Revenue or the expected revenue multiplied by the probability of getting 
government funding for the project, you can create a user-defined field called Go 
Probability and then a calculated field called Wt. Go Revenue (for example). 
Establish the Wt. Go Revenue field as a calculated field that multiplies Revenue 
times Go Probability.

Access the Calculated Fields form by clicking Configuration » General » Calculated 
Fields from the Vision main menu.

Calculated Fields Form

You can also add calculated fields directly to a report from the Reporting 
application by clicking New Calculated Field. Access this field from the 
Columns tab of the report’s Options dialog.
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Custom Report Options

Vision reporting options determine which information is displayed in the current report, 
how the data is formatted, and the sequence in which the data appears. You select 
options for each standard Vision report from the Options dialog, available by clicking 
the binocular icon in a specific report’s Options field from the Reporting application 
(Reporting on the Vision main menu). Each report has options specific to that report.

Users who create custom reports using the e.Reporting Library can add additional 
options to their custom report options page from the Custom Report Options form. 
These additional options will appear on a Custom Options tab on the report's 
Options dialog. 

Access the Custom Report Options form by clicking Configuration » General » 
Custom Report Options from the Vision main menu.

Custom Report Options Form

• For more information about the e.Reporting Library, see the 
e.Reporting Library topics in the Vision Online Help. Access the Help 
by clicking the Help global icon from within the Vision application.

• For more information about Custom Report Options, see the Custom 
Report Options topics in the Vision Online Help.
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Code Tables

Code tables are user-populated drop-down lists of values available for user selection. 
After the tables are populated, each table’s items are available in a drop-down list 
accessible from any field using that code table.

In Deltek CRM, you maintained code tables from either their Data Source or from the 
Code Tables option in the Maintenance menu. In Vision you access the Code Table 
Maintenance form by clicking Configuration » General » Code Tables from the 
Vision main menu.

Code Table Maintenance Form

The Vision database is designed so that, in most cases, code table items each have a 
code and a description, even if the field using them is not labeled “code” or 
“description.” This code/description structure permits centralization of Code Table 
maintenance in Vision. When you change a code’s description from the Code Table 
Maintenance form, it changes for every Vision field using the code associated with 
that description.

The Code tables that appear in Vision depend on which Vision applications your firm 
uses. Although many code tables apply to all Vision applications, a few code tables 
are specific to Vision CRM and Proposals. 

Some code tables contain system entries, which cannot be deleted.
Deltek Style Guide 4-113



Configuration
Code Table Example

When you set code table values, those values become available from drop-down lists 
in the corresponding Info Center.

For example, you can use the Client Relationship Code Table to define options for 
describing relationships between different client records in your Client Info Center. 

Client Relationship Code Table Example

Code Tables and SF330 Proposals

The SF330 Proposals form includes two sections, or blocks, that users complete by 
selecting codes stored in code tables. These blocks are found on the Part II tab of the 
SF330 Proposals application —  Block 9 (Employees by Disciplines) and Block 10 
(Profile of Firm’s Experience). You can auto-populate these fields with up to 22 codes 
by inserting codes on the SF330 tab of the Firm Setup - Proposals form. The project 
codes and discipline/skill codes you enter on the SF330 tab will be copied to the fields 
on Block 9 and Block 10 based on the firm you select to include on your proposal. The 
codes you enter on the SF330 tab are only defaults. From Block 9 and 10 on the 
proposals form, you can choose to add (up to 22) or delete codes as needed. 

Define relationship types in 
Client Relationship Code 
Table Maintenance.

Then select the 
appropriate relationship 
from the Relationship 
field in the Client Info 
Center.
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Block 9 codes originate from the Employee Skill/Discipline code table. Block 10 codes 
originate from the Project Codes code table. The codes used by the SF330 form are 
added in a column (SF330 column) in each of the code tables. Each code table 
contains both a set of existing SF254/SF255 codes and SF330 codes.

Project Templates

Although it is most common for CRM and Proposals Vision users to create projects 
from existing opportunities, you can use project templates to create new projects with 
an existing level structure and field values. After your firm decides how you want to 
structure projects to collect data (Work Breakdown Structure), project templates are 
an efficient way to ensure that projects created by users at your firm conform to this 
structure. 

In Vision you access the Project Template form by clicking Configuration » General » 
Project Templates from the Vision main menu.

Project Template Form

The Vision Project Template form is composed of the following tabs:

For details about these code tables and how they relate to the SF330 
form, see “Project Codes” on page 243 and “Employee Skill/Discipline 
Codes” on page 245.

For information about Work Breakdown Structure, please see “Projects 
with Three-level Work Breakdown Structure (WBS)” on page 209.
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• Background — Use this tab to enter background or history information, including 
project codes, descriptions, and awards received that apply to this type of project.

• Clients/Contacts — Use this tab to link one or more client records and/or one or 
more contact records to this project record template.

• Dates & Cost — Use this tab to enter dates and costs, including contract, bid and 
start dates, estimated and actual completion dates, project and firm costs, and 
comments for this type of project.

• Documents — If your firm has purchased and activated the Document 
Management application, use this tab to associate a document with a project and/
or phase and task record. You can check out and edit associated documents, as 
well as check them back in once you are done. Also, there are options to 
disassociate the document from the project record, delete it altogether, and view 
the history of the document.

• General — Use this tab to enter, edit, or review information about a project 
including the project name and number, the name of the organization in your 
company working on the project, primary client and contact names, project 
manager, principal and supervisor names, project type and status, and user 
record access rights.

• Location — Use this tab to enter the address information, phone and fax 
numbers, and email address for this type of project. The Location tab allows you 
to maintain contact information for the actual project site.

• Marketing Campaigns — Use this tab to enter information on all of the marketing 
campaigns associated with these types of projects.

• Team — Use this tab to organize information about the team of employees and 
vendors who are working on this type of project. If you are planning to create 
SF330 proposals, it is critical that you insert all of the vendors/consultants and 
employees who you would want to include on the SFF330 proposal for each 
project. Team information is also useful to enter before preparing SF254/SF255 
proposals; though it is not critical. Remember that Info Center links are bi-
directional. So when you link a vendor or employee to the project record from the 
Team tab, the same link is made in the Vendor Info Center (Projects tab) and 
Employee Info Center (Projects tab) to the project record template.
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Project Defaults

The Project Defaults feature allows you to establish system-wide default values for 
certain project data fields and options. For example, if all of your projects are 
performed for the federal government, you can select the Federal Projects option on 
the General tab in Project Defaults. Then, each time you create a new project or 
project template, the Federal Projects option is automatically selected

Project defaults are also used when you create new project templates. You can 
override project default values when you create new project records and new project 
templates, as needed.

You access the Project Defaults form by clicking Configuration » General » Project 
Defaults from the Vision main menu. 

Project Defaults Form

The Project Defaults form includes all of the standard tabs found in the Project Info 
Center (except for the Files tab). However, not all of the fields and options on each tab 
are available for use as defaults. 

The default values you specify in Project Defaults apply only when you create a new 
project from scratch. 

• When you create a new project from an existing project or a project template, 
Vision uses the values found in the existing project or project template. 

• When you create a new project from an opportunity, Vision uses default 
values only for fields that are not mapped from the opportunity record to the 
project record.

Project default values apply only at the project level (WBS1). They do not apply to 
phases and tasks (WBS2 and WBS3). 
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Opportunity Settings Configuration

Use Opportunity Settings to establish the guidelines for various features within the 
Opportunity Info Center, including Service Estimates, Estimated Revenue, Estimated 
Revenue Allocation Templates, and integration with the Salesforce Systems 
application, Business Value Selling (BVS) Sales Process. 

Service Estimates and Estimated Revenue work together to allow you to create a 
simple estimate for labor, units, expenses, and/or consultants on-the-fly for your 
opportunities. You may also create commonly used clauses to be used on Opportunity 
Estimate reports, and create estimated revenue allocation templates. 

The optional BVS Sales Process tab allows you to define the link to use as the 
reference for launching the BVS Interface. 

Opportunity Settings are only available to clients who own CRM. For clients who own 
only the CRM application, the following areas become available when you enable 
Opportunity Estimates: Accounts key conversion, Units key conversion, Accounts key 
format, Units key format, and the Accounts tab in Configuration » Accounting » 
System Settings.

You access the Opportunity Estimates Configuration form by clicking Configuration »  
General » Opportunity Settings from the Vision main menu. 

Opportunity Settings Configuration Form

The Vision Opportunity Settings form is composed of the following tabs:

• Service Estimates — Use this tab to enable and set up default values for the 
Opportunity Info Center Service Estimate feature, such as creating commonly 
used clauses to be used on Opportunity Estimate reports.

• Estimated Revenue — Use this tab to enable and set up default values for the 
Opportunity Info Center Service Estimate feature, such as setting up allocation 
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default values and setting up and saving templates for use as the basis for 
Estimated Revenue entries on the Opportunities, Estimated Revenue tab.

• BVS Sales Process — Use this tab to enter the link or URL that Vision should 
reference when the Business Value Selling (BVS) Interface is launched from the 
General tab of the Opportunity Info Center. BVS is an opportunity qualification 
application that must be purchased separately from Vision, from Salesforce 
Systems, in order to use the integration feature. 

For more information about these features in this guide:

• See, “Determine Estimated Services and Materials” on page 198.

• See, “Determine Estimated Receipt of Revenue” on page 198.

• See, “Access the Business Value Selling (BVS) Interface from 
Salesforce Systems” on page 201.

For information about these features in the Vision Online Help See the 
Service Estimate Tab and the Estimated Revenue Tab topics, or the topic 
called, “How to Use the Opportunity Info Center with the BVS Interface” 
within the Opportunity Info Center Vision Online Help.
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Merge Templates

Merge templates contain data merge codes as well as your company's style 
specifications for proposals or Info Center merges: page layouts, font settings, 
graphics locations, and other details. From the Vision Merge Templates form, you add, 
update, delete, or export custom merge templates within the Vision database. The 
templates are linked to the selected Info Center. Default SF254/SF255/SF330 
proposal merge templates are accessed from the SF254, SF255, or SF330 Proposal 
Form’s Template Editor and not accessed from the Merge Templates form. 

You access the Merge Templates form by clicking Configuration » General » Merge 
Templates from the Vision main menu.

Merge Templates Form

All users have access to SF254/SF255/SF330 merge templates, regardless of their 
role. However, you can control users’ access to the Info Center and Custom 
Proposals merge templates in order, to conform to your firm’s security policy.
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For information about granting a role access to custom merge templates, see Access 
to Custom Proposals Merge Templates, on page 2-35.

• SF330 merge templates cannot be modified in the same way as 
SF254/SF255 merge templates. Please see the SF330 Proposals 
book of the Vision Help for information specific to the SF330 merge 
templates. 

• The .rtf merge templates, and the merge process itself are 
compatible with Microsoft Word 2007. However, you cannot insert 
graphic placeholders in the header or footer of a document. This 
applies to all .rtf merge templates and template merge processes, 
whether in the Custom Proposals application, in an Info Center, or in 
other types of proposals. 
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Modifying Sample Custom Proposals Merge Templates

Vision comes installed with a set of sample merge templates for custom proposals. 
These Rich Text File (.rtf) documents are each designed for a specific Info Center. You 
can use these samples as a starting point to create your own custom templates (for 
example, adding your company logo). 

To modify Vision custom merge templates:

1. Click Configuration » General » Merge Templates from the Vision main menu. 
The Merge Templates form displays:

2. Use the Merge Templates form to export the default merge templates to Microsoft 
Word, modify them, and either save them with new filenames and import them 
into the Vision database or update the existing templates. For help using this form, 
click Help on the Merge Templates toolbar.
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Holiday Calendar

The Holiday Configuration form allows you to specify standard non-working days for 
your firm (for example, Saturday and Sunday) and to specify which days you consider 
holidays. Non-working days and holidays display as shaded cells when employees 
access the Vision Activity Calendar.

You access the Holiday Configuration form by clicking Configuration » General »  
Holiday Calendar from the Vision main menu.

Holiday Configuration Form

• From the list in the Non-working days section of the form, select the days of the 
week that are standard non-working days for your employees.

• Use the grid options on the Holiday grid to Insert, Copy, and Delete the days you 
recognize as holidays. Click the Calendar icon in any Date field on the grid to 
access a drop-down calendar. 

• You must enter holidays each calendar year.
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Currency

Currency Configuration allows you to maintain data for the currency that your firm 
uses, including code, description, symbol, and units.

Currency Configuration Form

If your firm has enabled the Multicurrency application, you can establish each 
currency from this form. To use multiple currencies, you must first purchase the 
Multicurrency application, and then activate the application from Module Application 
(for information, see “Accounting System Settings and Billing Labor Category Tables” 
on page 142). After you do this, an Enable Multicurrency button displays on the 
Currency Configuration form. You must click the Enable Multicurrency button and 
select your firm’s functional currency. For more information about Vision Multicurrency 
application, please see the Multicurrency Concepts book in the Vision Help.

If your firm does not use the Multicurrency application, you maintain information about 
the single currency your firm uses in Vision from the Currency Configuration form. 
4-124



General System Configuration
System Alerts

Alerts currently available for Deltek Vision CRM and Proposals include an Opportunity 
status alert that notifies employees when an opportunity’s status has changed. You 
specify the opportunities to include in the notification process, which employees to 
notify, and which status to notify about. 

CRM alerts (as well as Accounting alerts) are set on a system-wide basis from the 
System Alerts form. Time, Expense, Planning, and Purchasing alerts are set at the 
company level from the Company Alerts form. If your firm uses CRM and Proposals 
Vision applications only, you do not need to configure Company Alerts.

Access the System Alerts Configuration form by clicking Configuration » General » 
System Alerts from the Vision main menu.

(System) Alerts Configuration Form

From the (System or Company) Alerts Configuration form, you can do the following:

• Select the category of alerts you want to set from the Folders field.

• Establish rules for an Alert, such as opportunities to include in the notification 
process, which employees to notify, and which status to notify about. You 
establish rules by clicking the ellipsis (...) button in an alert’s Options field or by 
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clicking the Options grid option for a selected alert. Doing this opens the Alert 
Configuration dialog. 

Document Management

With Vision Document Management, you can store, share, and collaborate on a set of 
documents for every company, contact, lead, marketing campaign, opportunity, 
employee, project, vendor, and text library. You can link a single document to just one 
record or to multiple records in multiple Info Centers. 

Document Management provides:

• Web-based access to all documents

• The ability to link documents to specific Info Center records

• The ability to organize documents into sites, libraries, and folders

• The ability to store photos, graphics, and other digital assets 

• Check-in and check-out capabilities so that multiple users do not attempt to 
update the same document at the same time

• Document changes that are tracked and assigned different version numbers for 
auditing and rollback purposes (if versioning is enabled in Vision)

• Cross-document text searches for various document formats, including Word, 
PDF, and Excel

• Security settings to control document access and editing

• The ability to share documents with clients, partners, and suppliers, by creating 
outward-facing portals

Access the Document Management Configuration form by clicking Configuration » 
General » Document Management from the Vision main menu.

For information about getting started using Document Management, please see the 
Vision Help topic, How to Set Up and Use Document Management. Vision Help is 
available from the Vision user interface.

• Before establishing alerts, you need to activate alerts by setting the 
alert polling interval to a level other than zero (0). A value of 60 is 
recommended. You establish a polling interval from the Polling 
interval for activity alerts (seconds) field on the Miscellaneous tab 
of Configuration » General » System Settings.

• You can also use the Workflow application to create alerts. The 
Workflow application requires additional setup and knowledge of the 
Vision database tables, but allows for more flexibility when setting up 
alerts. Please see “Workflow” on page 129, for more information. 
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Document Management and Microsoft® Windows® Share-
Point™ Services (WSS) 

Document Management employs Microsoft Windows SharePoint Services, a leading 
collaboration platform already used by many professional services firms. SharePoint 
is tightly integrated with Windows Server™ 2003, to take advantage of the 
performance, stability, and security features of the Microsoft .NET Framework. 

Deltek Vision’s Document Management also works with SharePoint Portal Server.

Security

Document Management ensures that documents are accessible only to the 
appropriate people. You control which employee roles have access to which 
document libraries, and what document editing and management tasks each role can 
perform.

How it Works

With Document Management, documents are grouped into sites, libraries, and folders 
for efficient organization and easy manageability. Document Management also allows 
you to limit a role's access to documents. The hierarchy of document storage is as 
follows:

• Site — The top level of document storage. Think of a site as the room in which 
your libraries and folders are stored.

• Document Library — Think of a document library as a filing cabinet in a room 
(site) in which many folders are stored. You set security access by document 
library.

• Folder — Within your document libraries (filing cabinets), you can have limitless 
numbers of documents stored in limitless numbers of folders and subfolders.

Client Hierarchy

The Client Hierarchy feature enables you to create a hierarchy of records in the Client 
Info Center, which will display parent/subsidiary relationships. This allows users who 
have large hierarchical firms/agencies as clients to obtain and view project and 
opportunity data at a corporate-wide level. 

Client Hierarchy configuration consists of setting up the number of levels in the 
hierarchy.

Setting up client hierarchy is not required. Firms who have a significant number of 
client parent/subsidiary relationships, where understanding the hierarchy is valuable, 
may want to consider using this feature.
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Access the Client Hierarchy Configuration form by clicking Configuration » General 
» Client Hierarchy from the Vision main menu.

Client Hierarchy Configuration Form

To learn more about how the Client Hierarchy feature works in Client Info 
Center, see the Client Hierarchy Overview topic in the Vision Online Help. 
To learn more about how this feature works in Client, Project, and 
Opportunity reporting, see the appropriate report overview topics in the 
Vision Online Help.
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Workflow

Workflows allow you to create conditions within Info Centers where events, such as 
alerts and changes to the data, can be initiated by user interaction with a record or on 
a schedule (time and date) that you have previously determined. With Workflows you 
can automate the process of updating data or of being alerted each time a specific 
event takes place. This creates a timelier, more collaborative and accurate completion 
of tasks. 

Once an event takes place, (whether it be a user action or triggered by a query) Vision 
performs an action based on the conditions you set, such as sending an email alert, 
changing the value of a column, creating an activity, or invoking a Web service 
(customized code that resides on your firm’s servers or on a third-party server).

Both the event and the action can have zero or more conditions. If the conditions of 
the event are not met, none of the actions for the event will take place. If the 
conditions of the event are met, Vision evaluates the conditions of each action to 
determine whether or not that action should take place.

There are two kinds of workflows: user-initiated workflows and scheduled workflows.
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User Initiated Workflows

User initiated workflows are triggered by a specific user action. Actions include 
adding, changing, or deleting a record or a portion of a record.

Access the User Initiated Workflow form by clicking Configuration » Workflow » 
User Initiated Workflow from the Vision main menu.

User Initiated Workflow Form
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Scheduled Workflows

Scheduled workflows are database queries that run at regular intervals via the 
process server and are triggered when user-defined conditions are met.

Access the Scheduled Workflow form by clicking Configuration » Workflow » 
Scheduled Workflow from the Vision main menu.

Scheduled Workflow Form

Workflows and the Info Center

Workflows use the tables in Info Centers, such as the following, to create actions.

• Project / Client Association (PRClientAssoc)

• Employee Resume (EMResume)

• Marketing Campaign Leads (MktCampaignLeads) 

When you create a workflow, you determine whether you want it to apply to the entire 
application record or to only a part of the record. For example, you may want to create 
a workflow alert that is generated when a project association is added to a Project Info 
Center record.
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To create workflows you must use data from Info Center database tables. Therefore 
you must refer to the Deltek Vision Data Dictionary to create workflows and workflow 
actions. The latest version of the Data Dictionary is available from the Deltek Vision 
online Help.

Additional Advanced Documentation for 
Workflows

Below is a list of additional documentation available on the e-support site. The actions 
that these documents describe require knowledge about Web servers and/or the 
development of a Microsoft .NET assembly. If you do not have development 
experience, please contact Deltek's Custom Development Group for assistance. This 
group provides help on a time and materials basis.

Note that this list will be added to on a regular basis.

• Extending Data-Validation Business Logic for Timesheets

• Extending Data-Validation Business Logic for Expense Reports

• Invoking a Web Service to Process Workflow Actions

• Invoking a Custom Method to Process Workflow Actions

• Test Client Application for Vision Web APIs / Web Services

Example Workflows

• Notify Sales when an opportunity’s state is changed from Pending to Awarded.

• Notify the supervisor of a project when the status of an opportunity for that project 
is changed to Closed.

• Notify supervisors via the Dashboard when their employees' Employee Type has 
been changed.

• Notify specific employees when those employees are associated with a project, 
and then schedule a meeting with those employees one week later.

Workflow Log

The Enable Workflow Log option on the Miscellaneous tab of the System Settings 
form (Configuration, General, System Settings) allows you to determine whether you 
want to keep a log of workflow actions and for how long the actions should be kept. 
The log records workflow execution progress, such as when events start and when 
individual actions succeed, fail, or are not executed because of the conditions defined 
are not met. This option is mainly used as a troubleshooting tool in determining why 
workflow alerts do or do not work correctly.
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Workflows and Alerts

Vision Alerts and Workflows are similar in the they move information along. However, 
Workflows can be configured to a greater degree to better meet you company's 
business rules. Not only can they be configured to notify you when an action occurs, 
but they can also be configured to perform a specified action such as updating 
information in a field. 

For more information about Alerts, see “System Alerts” on page 125.
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Security Configuration

Vision's security features enable the Vision System Administrator to grant or restrict a 
user's access to applications and forms within Vision. To define each user's rights to 
Vision, the System Administrator first creates user “roles” that reflect your 
organization's business rules. For example, a “marketing” role may enable a user to 
only view those portions of Vision that relate to marketing.

After you create roles, you can assign each user or a group of users to a role. 
Because every user must have a role, this “role-based” security system provides 
tremendous flexibility and ensures users have access to the specific information they 
need, down to the record level. Record level security further defines a user's security 
rights by assigning access to specific rows of data based on certain criteria. 

Vision verifies users when they log onto Vision with their username and password, as 
assigned by the System Administrator. The user may not change their username, but 
may change their password after the initial log in. 

Upon log on, Vision identifies the user as having a specific role. Because of this role, 
Vision only lets the user perform actions where his or her security role has appropriate 
access.

Security Configuration is divided into two parts:

• Roles

• Users and Passwords

Before discussing the two parts of the Security Configuration form, we will look at a 
comparison of CRM and Proposals security and Vision security.

CRM and Proposals Security and Vision Security 
Comparison

Deltek Vision uses role-based access rights, where each user or group of users is 
assigned a role that Vision recognizes and references for the user’s access rights. 
Administrators can assign tab, form, and field-level access rights, including view-only, 
modify-only, and full rights, based on these roles.

Refer to the following table to compare security options in Deltek CRM and Proposals 
to those available in Deltek Vision. For more information about Vision security, refer to 
the Vision Help book titled Security. Vision Help is available from the Vision user inter-
face only.
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CRM/Proposals Security Vision Security

User Security — Establish user 
accounts and groups that 
determine a user’s level of access 
rights. 

Create User accounts — Create user 
accounts and passwords used for logging on 
to Vision.

Role Security — Establish roles with varying 
levels of access rights, and add access to any 
of the following from Role Security:

• Companies (if using Multicompany 
Feature)

• System Dashparts

• Web Dashparts

• Favorite Reports

• Lookups

• Merge Templates

• Reports

• Report Printers

• Saved Options

• Saved Searches

• Application Tabs

• Users

Then add users to established roles.

User Groups — Set up groups of 
Deltek CRM and Proposals users 
and assign access rights to 
records, reports, and style sheets 
to the entire group. 

Record Association — Assign 
access rights for users or groups 
to records within each data 
source. 

Configuration » Security » Roles » General 
tab — Assign a role access to the Info Center 
menu options from the General tab of Role 
security.

Configuration » Security » Roles » Record 
Access tab — Assign a role various levels of 
access to the various Info Centers, such as 
Full or Read Only. Also, select specific 
records and assign Record Level View and 
Record Level Update for all Info Center 
records, such as Projects and Clients. Record 
level rights must coincide with the rights given 
to the Info Center as a whole. 

Note: If your firm has purchased the Planning 
application, in addition to granting access 
rights to Info Center records from the Record 
Access tab, you also grant access to Project 
Planning.
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Report Association — Use the 
Reports tab to associate reports 
with users or groups.

Configuration » Security » Roles » Access 
Rights tab — Further refine a role’s access to 
lookups and reports throughout Vision.

General Tab — Define a role’s ability to save 
or delete searches, favorites, or reports from 
the Lookup/Reporting Organizing field on 
the General tab.

Style-sheet Association — 
Associate style sheets with users 
or groups. Use style sheets when 
merging data from Deltek CRM 
and Proposals into professional- 
looking, customized documents.

Configuration » Security » Roles » Access 
Rights tab — In Vision, style sheets are 
called merge templates. All users have access 
to SF254/SF255/SF330 merge templates, but 
you can assign user access to custom merge 
templates. Assign a role access to custom 
merge template from the Access Rights tab.

Security Type —- Select either 
Office Location security or Record 
security. Office Location limits the 
record set by office location while 
Record security limits the specific 
records each user can access.

Configuration » Security » Roles » Record 
Access tab — Establish a role’s access to 
specific records from the Record Access tab.

General tab — Select which organization’s 
records appear in Organization lookup and in 
General Ledger reporting from the 
Organization Record Access field. 

CRM/Proposals Security Vision Security
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Roles

Roles are the backbone of Vision security. You establish roles with various access 
rights, and then assign users to each role. Each user must be assigned to one, and 
only one, role.

Access role security by clicking Configuration » Security » Roles from the Vision 
main menu.

When you create a role in Vision, you can select various levels of access for the role. 
If users have been created, you can assign users to the role. This is helpful for 
establishing roles for each business unit within your organization. If users have not 
been created, though, you can create a role, create users, and then assign users to 
the role.

Vision allows you to select from a list of standard/default roles or to create new roles 
either from scratch or by copying an existing role and changing its properties to create 
a new role. 

The Roles form contains the following tabs:

• General — Assign roles access to multiple Info Centers and other areas of Vision 
from the General tab. Also specify the type of role, organization record access, 
priority level for scheduling jobs on the process server, and rights to save or delete 
searches, favorites, email templates, and reports.

• Record Access — Use the Record Access tab to establish detailed levels of 
access for each role to each Info Center. For example, use the General tab to 
grant a role access to Info Centers, then from the Info Centers tab, grant Add/
Modify access to the Project Info Center. 

From the Record Access tab, you can:

• Select the access rights for the role for each Info Center. For example, select 
the Add/Modify access rights option for the Project Info Center to let the role 
look at, modify, and add records, but not delete records.

• Further restrict access by determining which records a role can view or 
update within an Info Center from the Record Level Review and Record 
Level Update fields.

• Access Rights — Use the Access Rights tab to control the access right 
information for the following Vision functions:

• Companies — This option is available when your firm has enabled the 
Multicompany feature. Use this function to assign a role's access rights to 
companies for each Vision role. A role may have access to only its home 
company or to multiple companies. See the Vision Help topic, Security and 
Multicompany, for more information. 

If your firm has purchased the Planning application, in addition to 
granting access rights to Info Center records from the Record Access 
tab, you also grant access to Project Planning.
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Note that the list of available companies, as shown in the Available 
Companies column, is based on the companies that are set up in 
Organization Configuration.

• System Dashparts — Use the System Dashboard option to establish access 
rights to the standard Vision dashparts.

• Web Dashparts — Use the Web Dashparts option to give user’s the right to 
add Web dashparts, such as dashparts connecting to Web sites or FTP sites. 
Also establish access rights to these user-created Web dashparts.

• Favorite Reports — Use the Favorite Reports option to assign report 
favorites either by individual role or globally to several Vision roles. The 
features on this tab work in conjunction with Vision Reporting. You must use 
the Organize Favorite Reports dialog to configure favorite reports before 
assigning favorite reports to one or more roles.

• Lookups — Use the Lookups option to assign access rights to lookups for 
each Vision role. 

• Merge Templates — Use the Merge Templates option to grant a role access 
to Custom Proposals merge templates. Merge templates are the counterpart 
of Deltek CRM and Proposals style sheets. See “Proposals” on page 235 for 
general information about Merge Templates. See “Access to Custom 
Proposals Merge Templates” on page 35 for specific instructions on granting 
a role access to merge templates.

• Reports — Use the Reports option to assign a role's access rights to reports 
for each Vision role. Available reports display in the Available Reports 
column. Selected reports display in the Reports for this Role column. You 
can grant access to standard Vision reports and to custom reports that you 
create using the Actuate e.Report Designer and Deltek e.Reporting Library.

• Report Printers — Use the Report Printers option to assign access rights to 
server printers for each Vision role. 

• Saved Options — Use the Saved Options option to assign a certain 
combination of report option settings to each role for use with Vision 
Reporting. 

• Saved Searches — Use the Saved Searches option to assign a set of saved 
search criteria that will be available for each lookup type when users conduct 
a standard or advanced search. 

• Application Tabs — Use the Info Center Tabs option to establish a role’s 
access rights to the tabs within each Vision application, including any custom 
tabs added by your firm.

• Users — Use the Users option to assign users to a role within Vision.

For each Vision function there is a list of available items and items that the role has 
access to. Available items (such as lookups, dashparts, and so on) appear in the 
Available <Items> column. Selected items appear in the <Items> for this Role 
column. 
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Users and Passwords

You establish user accounts and assign passwords in Vision from the Users and 
Passwords form, accessible by clicking Configuration » Security » Users and 
Passwords from the main menu.

Users are the individuals in your firm who use the Vision application. When 
implementing Vision security, you must create user records for every person who will 
use Vision. 

User and Password Configuration contains the following tabs:

• Users — Enter a user's general information including username, Vision password 
and assigned Role, as well as Vision report settings, such as the report server to 
use, default margins, and date and time formats.

• Generate Users — Use existing Vision Employee Info Center records to generate 
new Vision users.

• Password Policies — Establish and maintain system-wide password policies.

Use User and Password Configuration to do the following:

• Configure users for Windows Integrated Security by selecting the Integrated 
option on the Users tab. This option allows the user to run Vision without 
physically logging in from the Splash Screen, as long as the user is logged into 
Windows using the proper network credentials. If the user is not logged into the 
network, they will be prompted for their network identification and password.

• Establish the user’s role or group’s (of users) role from the Role field on the Users 
tab.

• Enter a unique identification number associated with an employee from the 
Employee field on the Users tab. Please note that you can also establish generic 
users (for example, Admin) who are not associated with an employee number.

• Create Vision users from employee records entered in the Vision Employee Info 
Center from the Generate Users tab.

• Select generated users’ roles, name types (username format, such as first name 
last name), passwords, and default printers for Vision printing purposes.

• Establish settings for user passwords, including the number of login attempts 
allowed, and expiration rules from the Password Policies tab.

• Enter a user’s Deltek e-support site username and password in the Support User 
and Support Password fields to allow the user seamless access to e-support 
services, such as the Knowledge Base (accessible by clicking Help » Knowledge 
Base from the Vision Global Icons.) Each individual user can also enter or change 
this username and password from the Options dialog, accessible by clicking the 
Options Global icon. When this information is changed either in the Options 
dialog or from the Users and Passwords form, the change is made in both 
locations. 
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Organization

Deltek CRM and Proposals and Deltek Vision both include features that allow the 
System Administrator to organize company information. Deltek Vision uses the same 
basic functions that are found in CRM and Proposals’ 3.x Company Data Source. The 
Vision information, though, is included in an application called Organization, which 
enables you to create individual “organizations” within your firm. These organizations 
are business units that incur expenses and/or generate revenue. 

Unlike Deltek CRM and Proposals, Vision’s Organizations can be multi-level/
hierarchical, up to five levels, allowing for more flexibility in organization structure. 

While this hierarchical organization structure offers both flexibility and customization, 
to successfully generate government proposals, like SF254/SF255/SF330, or to 
include company information in custom proposals, such as your firm name, you must 
still maintain company-level information by office location. To offer flexibility while still 
offering required functionality, Vision provides the ability to configure organizations as 
well as to maintain firm/company information (Firm Setup - Proposals) for proposals. 
Vision also offers the ability to associate these two. 

Much of the company information from CRM and Proposals is converted into Vision as 
proposal firms (Firm Setup - Proposals). A two-level organization structure is also 
created and individual offices correspond to the 2nd level of the organization. After 
organizations are created, they are also associated properly with respective proposal 
firms. Without this association, Info Centers, such as projects and employees (which 
are the main entities handled in government proposals at the firm/company level), 
cannot be effectively linked to government proposals. For information about Firm 
Setup - Proposals, see “Deltek Vision Proposals Configuration Overview” on 
page 238.

The following sections describe some of the additional features available from Vision 
Organization Configuration. 

• The CRM and Proposals label your firm uses for Company overrides 
the default Vision label of Organization when you convert from CRM 
and Proposals (for example, Configuration » Company from the 
Vision main menu). You can continue to use this label, but keep in 
mind that the Vision Help System and all other Vision documentation 
refers to Companies as Organizations.

• If your firm created CRM Company Data Source custom fields tabs, 
these tabs are not converted to Deltek Vision. 

• If your firm plans to use the Deltek Vision Multicompany feature, this 
may affect how you convert CRM company data and how you set up 
Organization data in Vision. Please discuss this with your Deltek 
Vision representative.
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General Setup

Use the Organization General Setup form to establish the general organization 
settings for your firm and to associate organizations with projects and employees. 
This is necessary to keep track of which projects and employees belong to which 
organizations.

You must determine the general settings before you can enter subcode and 
organization information.

Access the Organization General Setup form by clicking Configuration » 
Organization » General from the Vision main menu.

From the Organization General Setup form, you can:

• Establish organizations with up to five levels of hierarchy. To modify the number of 
levels of organization, use the Key Formats utility. For more information, see the 
Key Formats Help book, available from the Vision Help.

• Define singular and plural labels for Organization levels.

• Enable the Multicompany feature.

Codes

From the Organization Codes form, set up the individual subcodes for each level of 
your organization. Combine these subcodes to create your organization codes. 

Access the Organization Codes form by clicking Configuration » Organization » 
Codes from the Vision main menu.

The Organization Codes form includes these tabs:

• Subcodes — Use this tab to define subcodes for each level of your organization 
structure.

• Organization — Use this tab to combine your subcodes to create unique codes 
to identify each organization in your firm.
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Firm Setup - Proposals

Proposal Firms are designed to store information about your firm for use in SF254/
SF255/SF330 Proposals. If Custom Proposals use firm-wide data, this data is also 
retrieved from Firm Setup - Proposals. See “Configure Proposal Firms” on page 239 
for details. 

Access the Firms form by clicking Configuration » Organization » Firm Setup - 
Proposals from the Vision main menu.

Accounting System Settings and Billing Labor 
Category Tables

Even if your firm has not purchased any accounting-related Deltek Vision modules, 
the Accounting System Settings form is available from Accounting Configuration. This 
is because the Service Estimating tool uses account ranges and labor categories, 
which are established on a system-wide basis from the Accounting Systems Settings 
form. 

Access the Accounting System Settings form by clicking Configuration » 
Accounting » System Settings from the Vision main menu.

The Accounting System Settings form includes these tabs:

• Accounts — Use this tab to set up the starting account numbers in your chart of 
accounts for consultants and expenses used with the Service Estimating tool.

• Labor Categories — Use this tab to create a master list of labor categories and 
descriptions.
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Billing Labor Category Tables

Also note that the Billing Labor Category Tables form is available from the Deltek 
Vision Billing menu, even if your firm has not purchased the Billing module. This is 
because specific rates are associated with labor categories from the Billing Labor 
Category Tables form. You can use these labor category tables with the Service 
Estimating feature, available from the Opportunity Info Center. 

Access the Billing Labor Category Tables form by clicking Billing » Billing Rate 
Tables » Labor Categories from the Vision main menu.

For more information about the Service Estimating feature available from 
the Opportunity Info Center, please see “Determine Estimated Services 
and Materials” on page 198.
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Module Activation

The Vision Module Activation form allows you to activate the Vision applications that 
your company uses. 

Access the Module Activation form by clicking Configuration » Module Activation. 

Module Activation Dialog
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About Deltek Vision

The About Deltek Vision dialog displays important information about the version of 
Vision you are running, the configuration of your database, and the configuration of 
your Actuate report server.

Access the About Deltek Vision dialog by clicking Configuration » About Deltek 
Vision from the Vision main menu. 

About Deltek Vision Dialog

Click the Details button to view a list of installed hot fixes and custom components.

You can also access the About Deltek Vision dialog by clicking the Vision Global Help 
icon and selecting the About option from the drop-down menu.
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Deltek CRM and Proposals to Deltek V
I n f o  C e n t e r  
R e c o r d s  
( D a t a  S o u r c e s )

In this chapter
� Overview
� Accessing the Vision Info Center
� Using the Info Center
� Document Management and the Info Center
� Integration with Third-party Applications and 

Info Center Data
� Clients
� Contacts
� Leads
� Marketing Campaigns
� Opportunities
� Employees
� Projects
� Units (Service Estimating Tool Only)
� Vendors
� Accounts (Service Estimating Tool Only)
� Text Library
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Overview

. Vision includes a fully integrated data storage component called the Info Center. The 
Info Center is home to the same type of data records found in CRM and Proposals 
Data Sources. 

The following Info Centers are available:

• Clients (or Combined Clients and Vendors Info Center)

• Vendors (Consultants)

• Contacts 

• Leads

• Marketing Campaigns

• Opportunities (Prospect Project) 

• Employees

• Projects

• Units (Service Estimating Tool Only)

• Text Library (Boiler Plate)

• Accounts (Service Estimating Tool Only)

Create, copy, 
delete, edit, and 
review records 
using the Info 
Center.

Use the Vision Info Centers to perform the same record maintenance functions — 
create, copy, delete, edit, review — that you completed using Data Sources in CRM 
and Proposals. The Info Center provides you with all the tools you need to maintain 
the records critical to your firm’s business operations. 

This chapter provides a summary of the Vision Info Centers and explains key 
differences between each Vision Info Center and the corresponding CRM and 
Proposals Data Source.

• Note that CRM consultant and client contacts are all converted to the 
Contact Info Center in Vision.

• When you convert from CRM and Proposals to Deltek Vision, the 
labels that your firm used in CRM and Proposals Data Sources are 
converted to Vision. If your firm changed the CRM and Proposal 
Defaults (for example from Employee to Architect), this is what you 
see in Vision after you convert. Your System Administrator can 
change these labels at any time from the Vision Configuration, 
System Settings, Labels tab. In all Vision documentation (books and 
Vision Help), all Info Centers are referred to using the Vision default 
label.

• If your firm created CRM Company Data Source custom fields tabs, 
these tabs are not converted to Deltek Vision. 
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• Options from some Info Center drop-down lists must first be set up 
from Configuration. For example, the relationship categories you 
select from the Client Info Center Associate a Client dialog box are 
established in the Client to Client Relationship dialog (Configuration 
» Code Tables. Click Client to Client Relationship). For more 
information see “Code Tables” on page 113. 

• If you are using other Vision applications, such as the Vision 
Accounting or Vision Resource Planning applications, additional 
menu items, tabs, and fields will also be available. Contact your 
System Administrator for more information about the Vision 
applications being used at your firm.
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Accessing the Vision Info Center

How do I access 
the Info Center?

In Deltek CRM and Proposals you access all of the data sources from the Data 
Sources button on the Shortcut Bar. In Deltek Vision, you access this information from 
the Info Center option of the Vision main menu:

Compare CRM Data Sources to the Vision Info Center

After migration, information that was stored in the Company Data Source 
is accessible from Vision Organization Configuration, and not from a 
Vision Info Center. See “Organization” on page 140 for more information.
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Using the Info Center

There are many features available in the Vision Info Center to help you manage your 
records with greater efficiency.

Finding Records

Enhanced lookup and search capabilities provide you with various ways to find Info 
Center records in your database. 

The two principal ways to search for Info Center Records are:

• Info Center Search Dialog

• Individual Info Center Search

Info Center Search Dialog

The Info Center Search dialog is a feature that allows you to locate records by 
searching multiple Info Centers simultaneously. To access the Info Center Search 
dialog, click the Search icon on the Vision toolbar.

Info Center Search Dialog

For additional information about each of the Vision Info Centers, click the 
Help button on the toolbar of any Info Center record.

Search Icon
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The Info Center 
Search tool does 
not search unit 
records, and the 
search only 
retrieves 
records to which 
you have 
security access 
rights.

The Info Center Search dialog consist of two tabs.

• Options — Use this tab to select the Info Centers you want to search, enter 
search text, and specify what record values to search on.

• Results — This tab displays the results of your search.

To search for records, select the Info Centers you want to search using the checkbox 
in the Search column on the Options tab. Then, use the Search Column field to 
select the record values you want to search on—for example, account number, client 
name, employee last name, and so on. When you access the Info Center Search 
dialog, the Search Column contains default search values for each Info Center. To 
change the search values, click in the Search Column and then click the Ellipsis 
icon. Vision displays a list of available columns for the selected Info Center.

Info Center Search Columns — Contacts

Finally, enter a full or partial search value in the Search Text field and click the 
Search button. Vision searches your database for records that contain the value 
entered. Vision then displays a list of all matching records (accounts, clients, contacts, 
employees, projects, and vendors) on the Results tab.
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Info Center Search Results Tab

The example above shows the results returned using “city” as the search text. You can 
click a record name in the list on the Results tab to open the corresponding Info 
Center record.

Individual Info Center Search

You can also search for Info Center records of a particular type by opening an Info 
Center and using one of three tools (available in all Info Center record types). To 
access these search features, click Info Center from the Vision main menu and then 
click the name of the Info Center you want to open.

To find a record of the type selected, complete one of the following procedures:

• Enter a partial value in the Find field of any Info Center (using either numbers or 
letters), and then press Enter. Vision searches your database for record numbers 
and/or names that contain the value entered. If more than one matching record is 
found, Vision displays a list of matching records. If only one matching record is 
found, Vision opens the record.

The following 
lookups are 
available: Client, 
Contact, Lead, 
Marketing 
Campaign, 
Opportunity, 
Employee, 
Project, Vendor, 
and Text Library

• Click the Find icon in the Find field of any Info Center to search for records using 
a Lookup. The Info Center currently open determines the type of Lookup that 
displays.

• Click the Folder icon beside any Info Center to search for records using a saved 
search.
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Finding Records in the Info Center

Click here 
for saved 
searches.

Click Search to 
open the Info 
Center Search 
tool, and search 
for records in any 
Vision Info 
Center. You can 
also open the 
Search tool from 
the Info Center 
main menu.

Enter partial 
record values 
here, and press 
Enter.
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Opening Records

When you 
access one of 
the Info Centers, 
Vision retrieves 
the last record 
opened in the 
current browser 
session. A 
browser session 
begins when 
you log on to 
Vision or when 
you open a 
Vision 
application in a 
new browser 
window. A 
browser session 
ends when you 
close the 
browser 
window. If this is 
your first visit to 
the Info Center 
for the current 
browser 
session, Vision 
opens a blank 
record.

There are two methods available for opening a record.

• Open a record in the current browser window.

Click Info Center on the Vision main menu and then click an Info Center option 
from the menu tree. Vision opens the selected Info Center in the current browser 
window. You can then select a record to open.

If you open a record using this method, Vision closes the application or record you 
currently have open.

• Open a record in a new browser window.

Click Info Center on the Vision main menu, right-click an Info Center option from 
the menu tree, and then click the Open in New Window pop-up option. Vision 
opens the selected Info Center in a new browser window. You can then select a 
record to open.

Using this method allows you to open records without exiting the application or 
record you currently have open.

You can launch any saved search directly from a URL. To do this you 
open a browser window. Type the path to Vision on your server. Then 
append the string 
launchapp.aspx?initialpage=<appname>&keyValue=Search|<folder 
name>|<sub folder name>|<search name>.

For example,assuming Vision is installed to the path localhost/vision51, 
you could open a Personal Saved Search named My Contacts using the 
following URL:

Localhost/Vision51/
launchapp.aspx?initialpage=Contacts&keyValue=Search||Personal 
Searches|My Contacts.
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Determine When the Record was Last Modified

After an Info Center record is open, you can hover your mouse over the name of the 
record in the Context area to determine when the record was last modified and the 
name of the Vision user who modified the record as well as the date the record was 
created.

View Last Modified Date

In this Vendor Info 
Center example, as the 
mouse hovers over the 
Vendor name, William 
Apple, in the Context 
area, Vision displays 
the date the record was 
last modified, the name 
of the user who 
modified the record 
(ADMIN), and the date 
the record was created.
5-156



Using the Info Center
Creating and Deleting Records

There are several methods available for creating new records. 

The following methods are available in all Info Centers:

• Create a new record from scratch. 

• Copy an existing record, modify the copied record, and then save the modified 
copy to create a new record.

Open any Info Center, and use the toolbar to select the appropriate option when 
creating a new record.

Creating New Info Center Records

Additional 
methods for 
creating new 
records.

• In the Project Info Center, you can also create a new project record from an 
opportunity, from a project template, or from a combination of a project template 
and an opportunity.

• In addition, you can create new records “on-the-fly” from certain Info Center tabs. 
This feature allows you to create a record in a separate browser window while 
keeping the current record open in your main browser window. 

Use this feature to:

• Create a new contact record from the Contacts tab of Client Info Center.

 
Toolbar Options
New <Record type> — Create a new record from scratch.
Copy Current <Record type> — Create a new record by 
copying the current record.
Select a <Record type> to Copy — Create a new record by 
selecting and copying another record.
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• Create a new client or vendor record from the General tab of Contact Info 
Center.

• Create a new contact record from the Contacts tab of Vendor Info Center.

• Create a new client record from the General tab of Project Info Center.

• After you create or edit a record, you must click Save on the toolbar to save your 
entries.

• To delete a record from your database, open the record, and click Delete on the 
toolbar. Vision displays a Confirm Delete dialog. Click Yes to delete the record.
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Duplicate Record Check

Click the Help 
button on the 
dialog to learn 
more about the 
duplicate record 
check.

When you create a new client, contact, marketing campaign, lead, employee, project, 
or vendor record, Vision automatically checks your database for possible duplicate 
entries. Vision displays a list of existing records that match, or closely match, the 
name of the record you are trying to create.

Potential Duplicate Records Found Dialog

Printing Records

There are three methods available for printing records.

• Print the current record.

• Print a record not currently open (within the same Info Center).

• Print all records currently open (within the same Info Center). 

Open an Info Center, and use the toolbar to select the appropriate option when 
printing a record.

Printing Info Center Records

Toolbar Options
Print Current <Record Type> — Print the current record.
Print Active Group — Print all records currently open in the 
selected Info Center.
Select <Record Type> to Print — Select a record (or 
records) to print.
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Merging Records

You can merge data from multiple records within the same Info Center into a Word 
document. You merge records using a Deltek Vision merge template or one that you 
modify or create in Microsoft Word using the Deltek merge template macro (Utilities »  
Download Macro). You load templates to use in various Info Centers from Merge 
Template Configuration (Configuration » General » Merge Templates). 

Open any Info Center, and use the toolbar to select the appropriate option when 
merging records.

Merging Info Center Records

Toolbar Options
Merge Current <Record Type> — Open the Merging dialog 
with the current record selected for merging.
Merge Active Group — Open the Merging dialog with all 
records currently open in the Info Center selected for merging.
Select <Record Type> to Merge — Open the Merging dialog, 
from which you select a record (or records) to merge.
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Setting the Display of Info Center Records

The Client, Contact, Lead, Marketing Campaign, Opportunity, Employee, Project, 
Vendor, and Text Library Info Centers contain a View toolbar option that allows you to 
determine how to display Info Center data.

Your options are:

• Tab View — The Tab View displays all tabs for the Info Center and the fields on 
each of these tabs. The Tab View is the default format that is referenced in the 
Vision Online Help.

• Grid View — The Grid View displays several Info Center records simultaneously, 
in a grid format. You can customize the grid columns and fields to quickly locate 
and evaluate Info Center data. For example, to locate an opportunity that is 
associated with a particular client, when you do not remember any details, you 
can use the Grid View to filter the opportunity records by client, then review the list 
to locate the desired record.

• The Merge option displays on an Info Center toolbar after you have 
created at least one merge template for the specified record type.

• Use merge templates to merge Info Center data into a Word 
document and to merge information from the custom proposals 
application. You cannot use the Info Center merge functionality to 
merge graphics or merge with a template containing the [Merged 
Description] or [Merged Resume] codes. You must use the Custom 
Proposals application merge feature for these tasks. You can use any 
sample merge template to merge Info Center data into a Word 
document from the Info Center except the Project Template - (Project 
Team, Project Codes, Descriptions and Awards.rtf) and Employees 
Template -(Merged Resume for Custom Proposal Module Only.rtf). 
These templates can be used only within the Custom Proposals 
application because they contain merge codes proprietary to the 
Custom Proposals application.

• The .rtf merge templates, and the merge process itself are 
compatible with Microsoft Word 2007. However, you cannot insert 
graphic placeholders in the header or footer of a document. This 
applies to all .rtf merge templates and template merge processes, 
whether in the Custom Proposals application, in an Info Center, or in 
other types of proposals. 

• See “Merge Templates” on page 120 and the Configuration book in 
the Vision Online Help for additional information.
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Customize the Info Center Grid View

When using the Grid View for the Clients, Contacts, Leads, Marketing Campaigns, 
Opportunities, Employees, Projects, Vendors, and Text Library Info centers, you can 
customize the fields and columns that display in the view. 

For instructions on customizing the view, see the topic, Customize the 
Info Center Grid View in the Vision Online Help.
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Setting Standard Phone Formats

To create consistency within records and reports, the Vision administrator has the 
option to establish a default format for phone number entry. When users type phone 
numbers in fields after this default format has been established, the format is applied 
automatically. To override this format you click the detail button (...) on a Phone field. 
Vision then displays the Phone Format Selection dialog that lists the default country, 
description, and format for phone numbers. You may choose to override the default 
format and select a new format for the current record's phone number. This change 
applies to the Phone and/or Fax fields in the Clients, Contacts, Leads, Employees, 
and Vendors Info Centers.

Data Entry and Record Associations

Data is entered and stored in the Info Center using a series of tabs. The tabs may 
contain data fields and/or data grids.

Many data grids 
(and some data 
fields) are 
relational, which 
means that 
when you enter 
data in one 
record, a 
corresponding 
entry is made in 
another record. 
The resulting 
record 
association may 
create a link 
between data 
grids in each 
record or 
between a data 
grid in one 
record and a 
data field in 
another record.

• Use data fields to enter data in much the same way you did in CRM and 
Proposals. 

• Use data grids to add data to a record and/or to create associations between 
records. The grid options available depend on the Info Center and grid type you 
have open. Grid options include:

• Associate — Add a record association to a grid.

• New — Create a new record and add an association to a grid.

• Edit — Modify an association on a grid.

• Remove — Delete an association from a grid.

• Insert — Add an item to a grid.

• Delete — Remove an item from a grid.

• For information about setting up phone number formats, search for 
phone number formats from the Vision Online Help and see “General 
Company Settings” on page 104. 

• For information about setting up international address formats, see 
the “International Address Formats” topic in the Vision Online Help.

For more information on record associations, see the individual Info 
Center sections of this chapter. To learn how record associations work, 
see the examples on the following pages. 
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Grid Settings

Size and order grid columns as desired. Vision saves the settings to use each time 
you open the grid.

You can resize and reorder the columns in any Info Center grid, and Vision will save 
these settings for the next time you open that Info Center grid.

Grid to Grid Association Example

If you add Steve Anderson to the Employees grid on the Associations tab of the 
Atlantic Research Corporation client record, Atlantic Research Corporation is 
automatically added to the Clients grid on the Associations tab of Steve Anderson’s 
employee record.

Client Info Center to Employee Info Center Grid to Grid Example

The Client-Employee 
association displays in both 
the Client record and the 
Employee record.
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Right-click a 
hyperlink and 
click the Open in 
new window 
option to open 
the associated 
record in a new 
browser 
window.

The entries in both records display as hyperlinks. This means that you can click either 
entry to open the associated Info Center record. For example, if you open the client 
record for the Atlantic Research Corporation and click Steve Anderson’s name in the 
Employees grid, Vision opens Steve Anderson’s employee record.

Grid to Field Association Example

If you add George DeRosa to the Contacts grid on the Contacts tab of the Atlantic 
Research Corporation client record, Atlantic Research Corporation is automatically 
entered in the Client field on the General tab of George DeRosa’s contact record.

Client Info Center to Contact Info Center Grid to Field Example

The Client-Contact 
association displays in 
both the Client record 
and the Contact record.
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Right-click a 
hyperlink and 
click the Open in 
new window 
option to open 
the associated 
record in a new 
browser 
window.

The entries in both records display as hyperlinks. This means that you can click either 
entry to open the associated Info Center record. For example, if you open the client 
record for the Atlantic Research Corporation, and click George DeRosa’s name in the 
Contacts grid, Vision opens George DeRosa’s contact record. 
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User Defined Tabs Fields and Labels

You can create 
your own tabs 
and fields and 
change the look 
and feel of 
standard tabs 
and fields to 
meet your 
business needs.

Each of the Vision Info Centers contain a set of standard tabs and fields for storing 
your data. To supplement the standard tabs and fields, Vision allows those with a role 
type of Administrator to create tabs and fields from Configuration. 

You can add tabs to each Info Center and create data fields and data grids for each of 
the tabs you add. While you cannot add fields to any of the standard tabs from the 
User Defined Tabs application, you can rename the standard tabs and most of the 
fields on the standard tabs. You can also change the order in which standard tabs 
(and/or user-defined tabs) display when you open Info Center records.

• Click Configuration » General » User Defined Tabs  to create your own tabs 
and fields and to change the order in which tabs display. 

• Click Configuration » General » System Settings, and use the Labels tab to 
rename the default Info Center tabs.

Info Center/Tab Designer

The Info Center/Tab Designer allows those with a role type of Administrator to change 
the look and feel of the tabs and fields in all of the Vision Info Centers (and the 
Activities dialog) — this includes both standard and user-defined tabs.

To open an Info Center tab in design mode, you must first open an Info Center record. 
Then, right-click on the desired tab name, and click Design from the pop-up menu. 
Vision opens the Tab Design dialog.

Only Vision users with a security Role of type Administrator can access the Info 
Center/Tab Designer.

When you open an Info Center tab in design mode you can perform a variety of 
actions, including:

• Resizing and move existing fields and labels.

• Changing existing field labels and add new ones.

• Determining whether fields should be hidden or locked, based on users’ security 
roles.

• Determining whether fields are required for CRM.

• Attaching Help icons to Info Center tabs that when clicked display pop-up 
messages that you specify. You may want to use this feature to create firm-
specific notes related to a particular tab or field or to link to internal documents 
that may aid users with data entry.

• Adding short helpful field-level “tool tips” that will appear directly on the Vision Info 
Center screen when a user’s mouse rolls over a field label.
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Company Data Source Custom Fields Tabs

Company Data 
Source Custom 
Fields Tabs are 
not converted 
from CRM and 
Proposals to 
Vision Info 
Centers.

If your firm created CRM Company Data Source custom fields tabs, these tabs are not 
converted to Deltek Vision because there is not a corresponding Vision Info Center. 
The Company Data Source information is converted to the Vision Organization 
application and Firms Setup - Proposals. Please see “Organization Setup” on page 37 
for more information about how CRM Company data is converted.

• See “User Defined Tabs” on page 106 and the Configuration 
topics in the Vision Online Help for additional information and 
instructions for creating user defined tabs and fields.

• See the Info Center/Tab Designer topics in the Vision Online 
Help for additional information and instructions on 
customizing Info Centers. 
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Activities

You can schedule activities for records in all Info Centers except Vendor and Text 
Library. The Client, Contact, Lead, Marketing Campaign, Opportunity, and Project Info 
Centers all contain an Activities tab, from which activities are scheduled. For 
employee records, you can schedule activities from the Activities grid on the CRM 
Info. tab. (You cannot schedule activities from the Units or Account Info Centers. 
These Info Centers are available when only CRM and Proposals modules are active 
for the purposes of the Service Estimating Tool only).

When you schedule an activity, Vision inserts the activity details on the Activities grid 
of the current Info Center record, on the Activities grid of any other record you link to, 
and on the Activities grid in the record of each employee (Owner) included in the 
activity. 

For example, if you schedule an activity for Atlantic Research Corporation in the Client 
Info Center, you can specify a Contact, Opportunity, Project, Marketing Campaign, 
and Employee (Owner) record to associate with this activity. 

Schedule Activities from the Info Center

You can also schedule a client activity using the Activity Calendar or the Activity 
Manager. When you schedule an activity using one of these tools and associate the 
activity with a client, Vision automatically inserts the activity details on the Activities 
grid of the specified Info Center record.

See “Activity and Calendar” on page 219 and the Calendar/Activities 
topics in the Vision Online Help for additional information and instructions 
for creating activities or using the Vision Calendar feature.

Schedule an activity from the Activities tab or the CRM Info. tab 
if scheduling an Employee activity. Notice how you can link this 
client activity with other Info Center records, such as a contacts 
or opportunities.
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Filter Options on the Activities Tab

By default, the Activities grid displays all activities related to the current record or 
activities accessible to the Role of the currently logged in user (as specified on the 
Record Access tab of the Roles form). However, you may want to view activities for a 
specific time frame or may want to see only meetings or pending activities. The Filter 
Options and Filter Open grid options allow you to specify your own criteria for 
filtering the activities that display in the Activities grid. This allows you to limit the list of 
activities in the grid to only those activities you need to see at any given time.

There are two filter options available from Info Center Activities grids:

• Filter Options — When you click Filter Options, Vision opens the Activities Filter 
dialog that you can use to define the parameters of your filter. In addition to 
selecting such filter criteria as activity type or date from the Activities Filter dialog 
you can:

• Save Filter Options — Click Organize to open the Organize Options dialog, 
and save the filter options you specified for the Activities grid. After you save 
your filter options, they are available when you select the Open option from 
any Activity grid. 

• Clear Filter Options — Click Clear to clear the filter options you specified for 
the Activities grid. This action clears the filter from the grid; it does not clear 
your saved filter options. If you clear the filter from the grid, all activities 
related to the current record once again display in the grid.

• Open Filter — Select to open a saved Activities Filter and apply it to the Activities 
grid. You can also open a saved Activity from the Activity Filter dialog.

When you apply a filter to an Activities grid in one Info Center record, the filter is 
applied to all records in that Info Center. After you apply a filter, Vision remembers 
your selection and applies it the next time you open that Info Center (Client, Project, 
Contacts, and so on). You can change your filter settings at any time.

Vision does not automatically apply the filter settings you specify for one Info Center to 
any other Info Centers, nor does it apply the settings to the Activity Manager. 
However, if you save your filter settings, you can use them throughout the Info Center 
and in the Activity Manager.
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Linked Files and URLs

Each Info Center contains a Files tab. Use the Files tab in an Info Center to link 
external text and graphics files to an Info Center record. You link an external file to an 
Info Center record by adding it to the Files grid. When you add a file to the Files grid, 
Vision automatically creates a hyperlink between the file name in the grid and the 
corresponding file location. You can then click the file name to open the file. 

You can link to files accessible on a local or network drive, Web sites, FTP sites, email 
addresses, and newsgroups. Following is an example of how you may link files to 
client records.

Use the Insert File or Insert URL Buttons to Link to a Variety of Files

Send Emails From the Info Center

From the Contact, Lead, Opportunity, Employee, and Project Info Centers you can use 
the Info Center email feature to send emails to individual employees, contacts, leads, 
or to a large number of people. To use this feature, you must first enter email 
addresses in the Email or Email Address field on the General tab of each Contact, 
Lead, and/or Employee Info Center record that you want to include in an email. You 
can also use this feature to create email templates 

Email templates allow users to enter regular text and insert database fields into an 
email's subject or body. These fields are then replaced with actual data, such as an 
employee's name from the Employee Info Center, when the email is sent.

Click Insert File to link 
to a file on a local or 
network drive.

Click Insert URL to 
link to a Web site, FTP 
site, email address, or 
newsgroup.
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Both the ability to send standard emails or template-based emails are useful, but it is 
likely that you will find one or the other more useful, depending on the task at hand. 

When to Use Standard Emails

Deltek Vision’s standard email functionality is more efficient because only one email is 
sent when you click Send, and all other recipients are copied on that one email.

Here are some examples of when to use standard email functionality rather than 
template-based email functionality:

• You do not want to use database fields in the Subject or Message fields of the 
email.

• It is appropriate (for performance reasons perhaps) to send only one email to all 
addresses (To, CC, BCC), rather than a separate email per record selected in the 
Records field, as must happen with template-based emails.

• You want to use the content of the email one time only, and you want to send it to 
one contact, lead, or employee only.

When to Use Template-Based Emails

When using template-based emails, every recipient in the Records field of the Email 
Templates dialog is sent an individual email. Then everyone in the Email fields on the 
To, CC, and BCC tabs are sent one email per recipient in the Records field. For 
example, let's say you select 10 records in the Records field. Then you select one 
record in the Emails field on the CC tab. When you click the Send button, each one of 
those 10 recipients in the Records field will receive just one email, an email that 
contains merged data specific to that individual (for example, with his name in the 
salutation). The one recipient in the CC field will receive 10 emails, one for each 
person in the Records field. This is because when you use database fields, Vision 
merges different data (for example a different first name) into each email, making 
each email unique. 

Here are some examples of when to use email templates rather than standard email 
functionality:

• You want to send the same email to multiple people and you want to use fields 
from the database in the Subject or Message fields. For example, if you want the 
email to include a database field for an employee’s first name (for example, “Hello 
[Contacts.First Name]”).

• You want to include database fields in the email, and you want to use the email 
repeatedly to send emails to different employees, leads, or contacts.

See the Email topics in the Vision Online Help for additional information 
and instructions for sending emails from the Contact, Lead, Opportunity, 
Project, or Employee Info Centers.
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Document Management and the Info Center

With Vision Document Management, you can store, share, and collaborate on a set of 
documents for every company, contact, lead, marketing campaign, opportunity, 
employee, project, vendor, and text library. You can link a single document to just one 
record or to multiple records in multiple Info Centers. 

When your firm enables the Document Management feature, a Documents tab is 
added to each Info Center. From this tab you can upload, link, check in, check out, 
disassociate, delete, and view the history of documents. 

Document Management provides:

• Web-based access to all documents

• The ability to link documents to specific Info Center records

• The ability to organize documents into sites, libraries, and folders

• The ability to store photos, graphics, and other digital assets 

• Check-in and check-out capabilities, so that multiple users don't attempt to update 
the same document at the same time

• Document changes that are tracked and assigned different version numbers for 
auditing and rollback purposes (if versioning is enabled in Vision)

• Cross-document text searches for various document formats, including Word, 
PDF, and Excel

• Security settings to control document access and editing

• The ability to share documents with clients, partners, and suppliers, by creating 
outward-facing portals

See the Document Management topics in the Vision Online Help 
for additional information and instructions on enabling and using 
Document Management.
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Document Management and Microsoft® 
Windows® SharePoint™ Services (WSS) 

Document Management employs Microsoft Windows SharePoint Services, a leading 
collaboration platform already used by many professional services firms. SharePoint 
is tightly integrated with Windows Server™ 2003 to take advantage of the 
performance, stability, and security features of the Microsoft .NET Framework. 

As of the release of Deltek Vision 5.1, Document Management is compatible with 
Microsoft Sharepoint 2007.

Security

Document Management ensures that documents are accessible only to the 
appropriate people. You control which employee roles have access to which 
document libraries and what document editing and management tasks each role can 
perform.
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Merging the Client and Vendor Info Centers 

Sometimes, how a client is connected to your firm on various projects can be 
complicated. In some cases you may be connected through another firm (in a sub 
relationship) or directly with the client (in a prime relationship). In cases where your 
connection is a prime connection, you may have other firms as sub-relationships off of 
this prime relationship. Because of this, the same firm may be connected with you in a 
client or vendor relationship, depending on the project.

To help stream-line your processes, Vision allows you to merge the Client and Vendor 
Info Centers into one central repository. Using the combined Client Info Center allows 
you to avoid the tiresome task of maintaining records in two places (Client and Vendor 
Info Centers) just to be able to associate each firm appropriately on the opportunity 
and project records. 

If your firm is not using Vision’s accounting features, many of the features of the 
Vendor Info Center are not applicable to your situation. For example, if you are a CRM 
only user, you may not use Vendors at all. And if you use the Vision Proposals 
application, you may need to access vendor information only when entering team 
information during proposal creation. 

Even if your firm does use Vision Accounting, your marketing department can use the 
combined Client and Vendor Info Center. Marketing can keep all of their sub-
relationships, including those that they need to include on proposals, in the combined 
Client Info Center and accounting can keep their true payable vendors in the Vendor 
Info Center. If, in the future, the Accounting department wants to change a sub-
relationship client into a true payable vendor, they can use Vision’s feature to create a 
vendor from a client. 

Vision’s single combined Client and Vendor Info Center can track all firms or 
companies with which you interact, and manage the important data where there is a 
prime or sub relationship. As an example of this single Info Center implementation, 
you could name the single Info Center, “Firms,” enter all client and vendor data in this 
one location, and eliminate the need to maintain the data in two separate places.

From within this “Firms” Info Center, you can mark certain client records as vendor 
only or vendor as well as client. This will allow you to access vendor record 
information for proposal purposes without having to turn on extraneous Vendor Info 
Center information that is unnecessary for your firm.

In addition, you can use this “Firms” Info Center to mark certain records as neither 
client nor vendor. For example, you may want to store information on a partner or a 
competitor. You can create user-defined fields that represent the various relationships 
you may want to capture, such as partner or competitor. Then when creating a record 
in the “Firms” Info Center, you can select one of these user-defined fields to mark the 
record as appropriate. Although Vision only uses information marked as client or 
vendor in its other applications, you can run reports to include the user-defined 
relationship records that you create. 
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The Create Client from Vendor Utility

After you convert from Deltek CRM and Proposals to Deltek Vision, if you want to 
merge the Client and Vendor Info Centers into a single Info Center, you must first 
import any vendor records into the Client Info Center. You do this using the Create 
Client from Vendor Utility. For more information, see “Create Client from Vendor” on 
page 288.
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Integration with Third Party Solutions and Info 
Center Data

Integration with Cyber Recruiter

Vision offers integration with Visibility Software's Cyber Recruiter. This integration 
allows Vision users who also own Cyber Recruiter to increase the overall efficiency of 
their hiring process by reducing data entry for employees hired from within the Cyber 
Recruiter system. 

The integration between Cyber Recruiter and Deltek Vision occurs on the Cyber 
Recruiter side. You must own Visibility's Cyber Recruiter to take advantage of the 
integration. For information about integrating, please see the Human Resources and 
Payroll Systems documentation, available from the Cyber Recruiter Help menu. Click 
Help » User manuals » HR/Payroll Systems. 

Please contact Visibility Software with questions or concerns about integrating Deltek 
Vision with Cyber Recruiter.

Integration with Busines Value Selling (BVS) 
Interface from Salesforce Systems

If your firm owns both the Salesforce Systems BVS interface and Vision, you can 
enable the BVS interface in Vision. After the feature is enabled and configured, you 
can integrate data between Vision and Salesforce software to help qualify 
opportunities. BVS automatically updates the following information in the Vision 
opportunity record: 

• Stage 

• Associated Contacts and their roles

• Close Date

• Revenue Amount

• User

For example, you create a new opportunity in Vision, and open BVS Sales Process to 
qualify the opportunity. Through further evaluation in BVS, you decide the opportunity 
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is not worth pursuing. When you save and close the record in BVS, Vision updates the 
opportunity information and changes the Stage setting to Do Not Pursue.

See “Access the Business Value Selling (BVS) Interface from Salesforce 
Systems” on page 201 for more information. Additionally, refer to topics in 
the Vision Online Help related to BVS integration and the Opportunities 
Info Center.
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Clients

Client records store your firm’s past, current, or prospective clients. As is the case in 
Deltek CRM and Proposals, information you enter in Vision for each client can be 
searched and included in custom proposals, reports, and SF254,SF255, and SF330 
proposals. 

In Deltek CRM and Proposals, this information was stored in the Clients Data Source. 
Access the Client Info Center in Vision by clicking Info Center » Clients from the 
Vision main menu:

Client Info Center

The Client Info Center consists of the following standard tabs:

• General — Use this tab to enter client name, number, and address information.

• Contacts — Use this tab to maintain a list of all client contacts. You can enter 
multiple contacts for a client. 

• Activities — Use this tab to schedule and manage activities related to this client.

• Opportunities — Use this tab to associate one or more opportunity records with 
a client record.

• Projects — Use this tab to maintain a list of all the projects your firm has 
completed or is in the process of completing for the client.

• Associations — Use this tab to associate one or more client records with another 
client record and to define relationships between the associated records. Also use 
this tab to associate one or more employee records with a client record.

• Files — Use this tab to link to files and graphics related to the client. 

• Additional Info — Use this tab to add additional information, such as minority 
status, to the client record. 
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Vision Client Features New to CRM Users

• Merge the Client and Vendor Info Centers into a Single Info Center

• Save multiple addresses per client.

• Store an active link to the client’s Web site in the Web Site field.

• Save a phone and fax number for each address.

• Link client records by creating client-to-client associations. 

• Link employee and client records.

• Define a list of client, employee, or client-to-client relationships to associate with 
any client record.

• Establish aliases for each client.

Merge the Client and Vendor Info Centers 

To help stream-line your processes, Vision allows you to merge the Client and Vendor 
Info Centers into one central repository. This single Info Center can track all firms or 
companies with which you interact and manage the important data where there is a 
prime or sub relationship. For more information, see “Merging the Client and Vendor 
Info Centers” on page 175.
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Multiple Addresses Per Client

The ability to enter an unlimited amount of addresses for each client allows you to 
consolidate clients with multiple locations into a single record while still having access 
to multiple addresses. Consider using this feature to specify one location as the 
primary office and label other addresses by their location, such as the Tampa Office. 
You add multiple addresses by clicking the Add Address button. The button appears 
when you save the first address.

Add Multiple Addresses Per Client

Click to add an address. The 
button only appears after 
you save the first address.
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Web Site Address

Store a URL to the client’s Web site along with the client record. You can launch the 
Web site in a new browser window directly from the client record.

Store Active Links to Web Sites

Store active links to client 
Web sites. Click the link to 
open the site in a new 
browser.
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Phone and Fax Number

Save both a phone and a fax number for each client record. Also, to create 
consistency within records and reports, the Vision administrator has the option to 
establish a default format for phone number entry. When you click the detail button on 
a Phone field, Vision displays the Phone Format Selection dialog that lists the default 
country, description, and format for phone numbers. However, you may choose to 
override this format and select a new format for the current record's phone number. 
For more information, see “Setting Standard Phone Formats” on page 163.

Client-to-Client Associations

Associate one client record with another and select how the clients are related from a 
list of pre-defined associations established in the Client to Client Relationship Code 
Table (Configuration » General » Code Tables » Client to Client Relationship). 
For example, you can link a parent company with its subsidiary, tag the association as 
“parent” to “subsidiary,” and enter additional description if desired.

Define Associations Between Clients

Employee-to-Client Associations

Associate one client record with as many employee records as desired, and select the 
type of relationship (such as “friend” or “client manager”) from a list established in the 
Employee Relationship Code Table (Configuration » General » Code Tables » 
Employee Relationship).

Click Associate to 
open the Client 
lookup, and select 
a client to 
associate.

After selecting a client from 
lookup, select a relationship 
for each client. List options are 
established from Client to 
Client Relationship Code 
Table Maintenance.

You can enter an 
additional description 
in the Description 
area.
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Define Associations Between a Client and Employees
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User-Definable Client, Employee, and Client-to-Client Relation-
ships

From Code Table Maintenance (Configuration » General » Code Tables), you can 
define client relationships and employee relationships as well as client-to-client 
relationships. The values you enter in the Client Relationship code table are available 
for selection from the Relationship field of the Client Info Center General tab. The 
values you enter in the Employee Relationship code table are available for selection 
from the Relationship field on the Employee grid of the Client Info Center 
Associations tab. The values you enter in the Client to Client Relationship code table 
are available for selection from the Associate a client dialog accessible by clicking 
Associate on the Associations grid of the Client Info Center Associations tab. Th  
following illustrates the forms used to define a client relationship and select the 
relationship from the Client Info Center.

Define Client Relationships Tailored to Your Firm

Define relationship types 
in Client Relationship 
Code Table Maintenance.

Then select the 
appropriate relationship 
from the Relationship 
field in the Client Info 
Center.
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Establish Aliases for Each Client 

You can set up alternative names, nicknames, or aliases for each client you create in 
the Client Info Center. For example, you might set up a client called United Parcel 
Service with the aliases UPS or U.P.S. Aliases are used for searching (including Quick 
Find searches - see “Quick Find Searches” on page 91) and for duplicate record 
checking (see “Duplicate Record Check” on page 159).

Establish Alternate Client Names

Click the ellipsis (...) 
button in the Name 
field to display a 
drop-down where 
you can enter as 
many alternate 
names as you need 
for the currently 
opened client. 
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Contacts

Contact records contain information about individual client or consultant contacts, 
including names, addresses, phone numbers, related activities and files, links to 
ongoing and completed projects, and details about future opportunities. 

In Deltek CRM and Proposals, contact information was stored in the Client Contacts 
Data Source. Access the Contact Info Center in Vision by clicking Info Center » 
Contacts from the Vision main menu.

Contact Info Center

The Contact Info Center consists of the following standard tabs:

• General — Use this tab to enter contact name, number, and address information.
• Activities — Use this tab to schedule and manage activities related to this 

contact.
• Opportunities — Use this tab to associate one or more opportunity records with 

a contact record.
• Projects — Use this tab to maintain a list of all the projects your firm has 

completed or is in the process of completing for the contact.
• Associations — Use this tab to link one or more contact records to another 

contact record and to define relationships between the linked records.
• Marketing Campaigns — Use this tab to enter information on all of the marketing 

campaigns associated with this contact. 
• Files — Use this tab to link to files and graphics related to the contact. 
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Vision Contact Features New to CRM Users

• Link address from Client or Vendor Info Center to Contact Info Center.
• Save multiple contact addresses.
• Specify whether an address is the mailing address.
• Link contact records by creating contact-to-contact associations.
• Link employee and contact records.
• Use expanded broadcast email campaign functionality.
• Specify a Preferred Name, such as a nickname, for a contact.

Link to Client or Vendor Address

When you associate a contact with a Client or Vendor record, the primary address for 
the Client or Vendor is automatically entered as a default. 

You can override this default in two ways: By editing a saved client or vendor address 
and maintaining the link to the Client or Vendor Info Center (doing this changes the 
address in the associated client or vendor record); or by selecting Other/Home 
Address as the address type, entering a new address and breaking the link to the 
Client or Vendor Info Center.

In Vision, you can link a contact to either a client record or a consultant firm record. By 
default, consultants are labeled Vendors in Vision.

Client/Vendor to Contact Address Links

In this 
example, the 
primary  
address 
stored in the 
Client Info 
Center is 
populated in 
the contact 
record. Any 
changes 
made to Client 
Addresses in 
the Contact 
Info Center 
flow back to 
the Client Info. 
Center.

Link to a Client or 
Vendor record.

Select Client 
Address or 
Vendor Address, 
and then select the 
stored address 
from the second 
drop-down list. If 
you select Other/
Home Address, 
you must enter the 
address to use in 
the Address fields. 
This address is not 
linked to the Client 
or Vendor Info. 
Center.
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Multiple Contact Addresses

In Vision, you can link any contact record to one of several saved Client Addresses, or 
you can create an address specific to a particular contact. Any changes made to client 
address information from the contact record flow back to the associated client record. 
To create an address specific to a contact record, select Other/ Home Address from 
the address type field, and enter the address in the fields provided.

Mailing Address Indicator

You can mark any stored address in any contact record as the mailing address. Vision 
uses the marked address for mailing campaigns.

Specify a Mailing Address

Select 
Mailing 
Address to 
use this 
address for 
mailings.
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Contact-to-Contact Association

Associate contacts and select the relationship from a list of pre-defined associations 
established in the Contact to Contact Relationship Code Table (Configuration » 
General » Code Tables » Contact to Contact Relationship).

Define Associations Between Contacts

Employee-to-Contact Associations

Associate one contact record with as many employee records as desired, and select 
the type of relationship (such as “friend” or “client manager”) from a list established in 
the Employee Relationship Code Table (Configuration » General » Code Tables » 
Employee Relationship).

Define Associations Between a Contact and Employees

Click Associate to open the 
Contacts Lookup and select a 
contact to associate.

After selecting a contact from 
lookup, select a relationship for 
each contact. List options are 
established from Contact to 
Contact Relationship Code Table 
Maintenance.

You can enter an 
additional 
description in the 
Description area.
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Expanded Broadcast Email Campaign Functionality

Send broadcast emails to the contact currently viewed on screen, all contacts whose 
records are currently open, or specific contacts you select.

Specify a Preferred Name

The Contact Info Center allows you to associate a Preferred Name with a Contact 
record. You can also associate a Preferred Name with an Employee record from the 
Employee Info Center.
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Leads

The Lead Info Center contains information about the people and companies who have 
come to your company’s attention as “leads” to future business with potential clients. 
A lead is essentially an unqualified prospect that you plan to cultivate to lead your firm 
eventually to future opportunities, and, ultimately, projects.

The Lead Info Center provides you with a separate location for storing and managing 
the records of marketing-related prospects. For example, if your firm rents or 
purchases lists of marketing prospects, you can import those lists to the Leads Info 
Center and manage such individuals or companies from there, rather than 
commingling them with your Contacts Info Center records.

Use the Lead Info Center to maintain all lead information, including names, 
addresses, phone numbers, related activities and files, and links to ongoing and 
completed marketing campaigns. 

Access the Lead Info Center by clicking Info Center » Leads from the Vision main 
menu.

The Lead Info Center contains the following tabs, by default:

• General — Use this tab to enter the lead's first and last name, title, business 
address and various phone numbers.

• Marketing Campaigns — Use this tab to enter information on all of the 
marketing campaigns associated with this lead. 

• Activities — Use this tab to schedule and manage activities related to this lead.

• Files — Use this tab to link to files and graphics related to the lead. 

Key Lead Features in Vision

• Add, copy, delete and edit lead records.

• Convert leads to opportunities, contacts, and/or clients.

• Send emails to one or more leads.

• Associate a lead with an employee record.

The term “lead” is used in Vision to represent prospect contacts or 
unqualified contacts that may lead to future business. Your firm may use 
a different term to describe these people and companies. If so, consider 
changing the term “lead” to your firm-specific term throughout Vision.
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Lead Record Maintenance

Perform maintenance, including adding new leads, editing lead records, or deleting 
records using buttons from the Leads toolbar.

For information about adding records, see “Creating and Deleting Records” on 
page 157.

Lead Conversion

From the Convert Lead dialog you can qualify a lead by converting it to a client, 
contact, and/or an opportunity. When you qualify leads, all of the marketing campaigns 
that were associated with the lead are associated with the new client, contact, or 
opportunity. At the time you qualify a lead, you can also associate it with additional 
marketing campaigns.

You can also disqualify a lead and select a status to use for future reference, such as 
“using competitor”. You access the Convert Lead dialog from the Leads toolbar or by 
clicking Convert on the Leads grid of the Marketing Campaigns Info Center.

Emails and Broadcast Emails

Use the Email toolbar button to send an email to one lead or to send a broadcast 
email to multiple leads that you specify.

Associate a Lead with an Employee Record

Use the Owner field to associate an employee record with the currently opened lead 
record.
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Marketing Campaigns

Use the Marketing Campaign Info Center to centralize the information related to each 
of your firm's marketing campaigns. The Info Center includes areas for a campaign's 
managers, goals, budget, metrics, and activities as well as the leads, opportunities, 
and projects generated from the campaign.

Access the Marketing Campaign Info Center by clicking Info Center » Marketing 
Campaigns from the Vision main menu.

The Marketing Campaign Info Center contains the following tabs, by default:

• General — Use this tab to enter the essential information about the marketing 
campaign such as the name, status, budget, and targeted revenue. This tab also 
includes linked fields, where you can specify the campaign's organization, project 
and team members. 

• Leads — Use this tab to enter information on all of the leads associated with the 
campaign. 

• Activities — Use this tab to schedule and manage activities related to the 
campaign. 

• Contacts — Use this tab to associate one or more contacts with the campaign.

• Opportunities — Use this tab to associate one or more opportunities with the 
campaign.

• Projects — Use this tab to associate one or more projects with the campaign.

• Files — Use this tab to link to files and graphics related to the marketing 
campaign. 

Key Marketing Campaign Features in Vision

• Associate a marketing campaign with a project, opportunity, or contact. After you 
make the association, the association also appears on the Marketing Campaigns 
tab of the Project, Opportunity, or Contacts Info Center.

• Link more than one lead to an activity. 

Associate a Marketing Campaign with Other Info Center 
Records

You can associate a marketing campaign with a project, opportunity, lead, or contact 
from the Projects, Opportunities, Leads, or Contacts tab, respectively. For information 

If your firm has Vision's Accounting module installed, you can monitor 
campaign performance against a budget by creating a promotional 
project and linking it to the campaign record. 
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about associating Info Center records, see “Setting the Display of Info Center 
Records” on page 161.

Link a Campaign to an Activity and the Activity to Multiple 
Leads

From the Activities tab of the Marketing Campaign Info Center, you can link a 
marketing campaign to an activity, such as a meeting or a conference. Then from the 
Campaign/Leads tab you can associate multiple leads with the campaign activity. 

For more information about activities, see “Activities” on page 169. 
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Opportunities

An Opportunity record contains information about future project opportunities your 
company is interested in pursuing. Like the CRM and Proposals 3.x Prospect Projects 
Data Source, the Vision Opportunity Info Center contains information about 
opportunities throughout the entire sales cycle. Opportunities are centrally located and 
so available to track dates and milestones, run proposals, and view employees on the 
team.

When you convert from CRM and Proposals to Vision, the label that your firm used for 
the CRM and Proposals Prospect Projects Data Source carries over to Vision.

Access the Opportunity Info Center by clicking Info Center » Opportunities from the 
Vision main menu.

The Opportunity Info Center consists of the following standard tabs:

• General — Use this tab to enter, edit, or review information about an opportunity, 
including the opportunity name, number, description, status, type, and source, 
revenue and probability figures, open and close dates, and an associated 
organization or client name, if applicable.

• Team — Use this tab to organize information about the team of employees and 
vendors who are working on an opportunity. This information is critical for the 
auto-population of information on SF330 Proposals created from opportunities.

• Clients/Contacts — Use this tab to link one or more client records and/or one or 
more contact records to an opportunity record.

• Proposals — Use this tab to keep track of all the proposals associated with an 
opportunity.

• Service Estimate — Use this tab to determine the estimated services and 
materials required for an opportunity. 

• Activities — Use this tab to schedule and manage activities related to this 
opportunity.

• Location — Use this tab to enter, edit, or review address information for an 
opportunity.

• Project Codes — Use this tab to enter the project codes associated with an 
opportunity. Project codes allow you to break down the type of work you expect to 
do on a particular project and then enter estimated fees for the work.

• Marketing Campaigns — Use this tab to enter information on all of the marketing 
campaigns associated with this opportunity.

• Files — Use this tab to link to files and graphics related to the opportunity.

• Estimated Revenue — Use this tab to enter dates when revenue is expected to 
be received. This information can be used in the Opportunity Forecast Report to 
accurately reflect the potential revenue stream for that opportunity.
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Vision Opportunity Features New to CRM Users

• Determine the estimated services and materials required for an opportunity.

• Estimate when revenue will be received for an opportunity.

• Link from opportunities to promotional and regular projects.

• Use tracking fields.

• Define probability codes and descriptions tailored to your firm.

• Create unlimited client associations.

• Use expanded proposal logging capabilities to create a link to a proposal.

• Two ways to associate a Project Manager, Principal, and/or Supervisor with an 
opportunity.

• Create an SF330 proposal from an Opportunity.

• Search for an Opportunity by SF330 Code.

• Associate a vendor with a stored vendor address.

• Access to the Salesforce Systems Business Value Selling (BVS) interface. 
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Determine Estimated Services and Materials

Use the Service Estimates tool (Service Estimates tab of the Opportunity Info Center) 
to determine the estimated services and materials required for an opportunity. While 
using this tab, you can enter the labor, expense, consultant, and/or unit cost estimates 
on-the-fly for an opportunity. As you enter and change this information, you can 
continue to refresh the data to view an updated analysis of each estimate. 

Although your firm may have exclusively purchased and enabled CRM and Proposals 
related Deltek Vision modules, the Chart of Accounts Info Centers, Units Info Centers, 
and Billing Labor Categories Rate tables are all enabled because they are necessary 
to use the Service Estimates tool.

A related Opportunity Service Estimate report (Reporting » Opportunity) provides a 
way to preview and then print estimates for prospective clients. This report is similar to 
an invoice generated through the Deltek Vision Billing Template Editor (available if 
your firm purchases the Vision Billing module) and employs similar options to control 
content and appearance. 

Determine Estimated Receipt of Revenue

Use the Estimated Revenue tab to enter dates when revenue is expected to be 
received. This information can be used in the Opportunity Forecast Report to 
accurately reflect the potential revenue stream for that opportunity.

The default values and templates for this tab are set on the Estimated Revenue tab of 
Configuration » General » Opportunity Settings.

For more information about the Service Estimate feature, please see 
“Opportunity Settings Configuration” on page 118 or see the Service 
Estimate feature topics in the Vision Online Help.

For more information about estimating revenue, please see “Opportunity 
Settings Configuration” on page 118 or see the Estimated Revenue 
topics in the Vision Online Help.
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Link to promotional and regular projects

In CRM and Proposals 3.x, the only link between an opportunity and a project 
occurred when a user posted an opportunity from the Prospect Projects Data Source 
to the Project data source. In Vision, when an opportunity is won, you can easily 
create a project from that opportunity without losing the history associated with the 
opportunity and without much additional data entry. You create projects from 
opportunities from the Project Info Center.

Tracking fields

In Vision, you can store additional information about the opportunity, such as the date 
the opportunity was created, the source, and the number of days the opportunity has 
been in the pipeline for your firm. 

Define Values for Selection from the Probability Field

The values in the Probability field are defined from a code table. This allows you to 
create more meaningful values to assist in pipeline analysis. Code table values are 
established from Configuration.

Define Probability Codes and Descriptions Tailored to Your Firm

Your firm establishes 
Probability Codes 
and Descriptions 
from Code Table 
Maintenance. These 
codes are then 
available for selection 
from the Probability 
field on the General 
tab of the Opportunity 
Info Center. If a 
description exists, it 
displays next to the 
Probability field.
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Unlimited client associations

In Vision, you can associate any number of clients to the opportunity from the Clients/
Contacts tab of the Opportunity Info Center. For more information, see “Setting the 
Display of Info Center Records” on page 161.

Expanded proposal logging capabilities

The proposals grid in Vision has a link to the actual proposal created in the Custom 
Proposal, SF255, or SF330 applications.

Two Ways to Associate Project Manager, Principal, and/or 
Supervisor With an Opportunity

You can associate a single Principal, Project Manager, and Supervisor with an 
opportunity from the General tab of the Opportunity Info Center.

From the Team tab, you can associate as many project managers, supervisors, or 
principals with an Opportunity, as well as any other role you have established for 
employees. Employee roles are established from the Employee Role code table. 

There is no link between these fields on the Team tab and the General tab.

Create an SF330 Proposal from an Opportunity

The SF330 Proposals form was created by the government as an improvement upon 
and in some cases replacement for the SF254/SF255 forms. Vision provides the 
ability to create all three types of forms. When using SF330 forms, however, you can 
create new proposals from Opportunities.

Search for Opportunities Based on SF330 Code

Project Codes are associated with an Opportunity on the Project Codes tab. Each 
project code has a corresponding SF330 code. Although this SF330 Code field is not 
used by the SF330 Proposals application, it is included in the Project Codes grid to 
help with Opportunity searches. This field enables you to perform an Advanced 
search for all Opportunities associated with a particular SF330 code or codes from 
any Advanced Opportunity lookup within Vision. Select Project Code - SF330 as your 
Advanced Search Type.
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Associate a Vendor Address with an Opportunity’s Vendor

From the Vendors grid on the Team tab you can associate any Vendor in the grid with 
an address stored in the vendor’s Info Center record. By default, Vision displays the 
address description associated with the vendor's primary address.

If you have entered more than one address for a vendor in the Vendor Info Center and 
you want to display an address other than the primary address in the Address field, 
you can use the Address Description field to select a different address description. 

Access the Business Value Selling (BVS) Interface from Sales-
force Systems

If your firm owns both the Salesforce Systems BVS interface and Vision, you can 
enable the BVS interface in Vision. After the feature is enabled and configured, you 
can integrate data between Vision and Salesforce Systems BVS software to help 
qualify opportunities. BVS automatically updates the following information in the 
Vision opportunity record when integration is enabled: 

• Stage 

• Associated Contacts and their roles

• Close Date

• Revenue Amount

• User

For example, you create a new opportunity in Vision, and open BVS Sales Process to 
qualify the opportunity. Through further evaluation in BVS, you decide the opportunity 
is not worth pursuing. When you save and close the record in BVS, Vision updates the 
opportunity information and changes the Stage setting to Do Not Pursue.

Enable the BVS Interface

To enable integration with BVS:

1. From the Vision main menu, click Configuration » General » Opportunity Set-
tings »  BVS Sales Process tab.

2. On the BVS Sales Process tab, enter the URL to access the BVS Sales Process 
interface. This is the URL Vision should reference when the BVS Interface is 
launched from the Genera tab of the Opportunity Info Center.

To use BVS from the Opportunity Info Center:

1. From the Vision main menu, click Info Center » Opportunities » General tab

2. Create and save an opportunity.

3. On the General tab, click the BVS Sales Process link. Vision automatically 
updates the following information in the BVS record:

• Stage 
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• Associated Contacts and their roles

• Close Date

• Revenue Amount

• User

4. Use the checklists and forms within BVS that are configurable to necessary infor-
mation and save when complete.

5. Open Vision and refresh the opportunity by clicking outside of the opportunity 
record to access another info center. When you come back to the original opportu-
nity record, Vision will have refreshed the data. 

6. If the changes impacted the Funnel Phase within BVS, BVS updates the opportu-
nity Stage field within Vision.

7. Save the opportunity.
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Employees

Employee records contain information about the personnel who work for your 
company, including personnel in any branch offices and consultant firms. As with 
Deltek CRM and Proposals, in Vision you can store general employee data, such as 
skills and education as well as details about an employee’s customers, opportunities, 
and scheduled activities. You can search for employee information as well as include 
it in custom proposals, reports, and SF254, SF255, and SF330 proposals.

In Deltek CRM and Proposals, employee information was stored in the Employee 
Data Source. Access employee information In Vision by clicking Info Center » 
Employees from the Vision main menu.

Employee Info Center

The Employee Info Center consists of the following standard tabs:

• General — Use this tab to enter, edit, or review an employee’s profile information, 
including employee name, ID number, title, phone numbers, and other general 
information.

• Personal — Use this tab to enter, edit, or review an employee's address, home 
phone number, social security number, and other personal information.

• Experience — Use this tab to enter, edit, or review information about an 
employee's experience, including their skills, education, and professional licenses 
or registrations.
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• Projects — Use this tab to associate one or more project records with an 
employee record. When you associate an employee record with a project from 
this tab, the Project record also stores a link back to the employee on the Project 
Info Center’s Team tab. If you are planning to create SF330 Proposals, it is 
important to associate employee records with the appropriate projects in order to 
help automate SF330 proposal creation. The project long name is stored on this 
tab for your convenience.

• CRM Info. — Use this tab to maintain a central storage location for all sales 
related data. You can keep track of all employee sales detail, from every 
opportunity in the pipeline to every scheduled activity.

• Files — Use this tab to link to files and graphics related to the employee. 

• Resumes — Use this tab to enter, edit, or review employee resume text 
information. If you are using Vision Proposals, this information is useful for quickly 
locating, retrieving, and inserting employee and consultant resumes (for SF255 
proposals) and locating, retrieving, and inserting text information in Block 18 
Other Professional Qualifications (for SF330 proposals). This helps streamline 
proposal production. For more information about how stored resume information 
is used on the SF254/SF255 form, see the SF255 Proposals book of the Vision 
Help. For more information on how stored resume information is used on the 
SF330 form, see the SF330 Proposals book of the Vision Help. Help is accessible 
from within the Vision user interface.

• Associations — Use this tab to associate one or more client and/or contact 
records with an employee record. You can associate clients and contacts with 
whom your firm has completed previous projects as well as prospective clients 
and contacts for future work. 

Vision Employee Features New to CRM Users

• Include an employee photo with each record.

• Use phone number fields and personal information fields.

• Take advantage of expanded registration information.

• Track employee start and end date per project.

• Integration with Visibility Software Cyber Recruiter. Vision offers integration with 
Visibility Software's Cyber Recruiter. This integration allows Vision users who also 
own Cyber Recruiter to increase the overall efficiency of their hiring process by 
reducing data entry for employees hired from within the Cyber Recruiter system. 

If your firm has purchased the Accounting or Time & Expense 
application, additional tabs appear in the Employee Info Center.
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Employee Photos

You can now display a picture of the employee on the screen for reference purposes. 
This option may not be enabled, depending on your role’s security privileges.

Add an Employee Photo to an Employee Record

Phone number fields and personal info

Store both work and mobile phone numbers for any employee.

Expanded registration information

The licenses (formerly Registrations) grid includes the Last Renewal field, which is 
used to track when people have last renewed their licenses:

Track License Renewals from the Experience Tab

Click Photo, 
Update to open 
the Employee 
Photo Update 
dialog. Then 
select a photo.
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Track Start and End Date per project

From the Projects tab of an employee’s record, enter the start and end date for each 
project on which the employee works.

Use the Projects Tab to Track Employee Start and End Dates

If your firm has also purchased, installed, and activated the Accounting 
application, an Hours field appears on the grid and a Refresh Hours 
button appears on the grid. The Hours field records the actual amount of 
hours the employee posted to each project. If you edit this field, clicking 
Refresh Hours will restore the column amount to the actual number of 
hours the employee has posted to the project.
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Projects

Project records contain information about all your company's current and completed 
projects. As with Deltek CRM and Proposals, you can search on project information as 
well as include it in custom proposals, reports, and SF254, SF255, and SF330 
proposals. 

In Deltek CRM and Proposals, project information was stored in the Projects Data 
Source. Access project information in Vision by clicking Info Center » Projects from 
the Vision main menu.

Project Info Center

The Project Info Center contains the following tabs, by default:

• General — Use this tab to enter, edit, or review information about a project 
including the project name and number, the name of the organization in your 
company working on the project, primary client and contact names, project 
manager, principal and supervisor names, project type and status, and user 
record access rights.

• Team — Use this tab to organize information about the team of employees and 
vendors who are working on a project. If you are planning to create SF330 
proposals, it is critical that you insert all of the vendors/consultants and employees 
who you would want to include on the SFF330 proposal for each project. Team 
information is also useful to enter before preparing SF254/SF255 proposals; 
although, it is not critical. Remember that Info Center links are bi-directional. So 
when you link a vendor or employee to the project record from the Team tab, the 
same link is made in the Vendor Info Center (Projects tab) and Employee Info 
Center (Projects tab) to the project record.

• Clients/Contacts — Use this tab to link one or more client records and/or one or 
more contact records to a project record.

• Activities — Use this tab to schedule and review project activities. 
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• Background — Use this tab to enter a project's background or history 
information, including project codes, descriptions, and awards received.

• Dates & Cost — Use this tab to enter project dates and costs, including contract, 
bid and start dates, estimated and actual completion dates, project and firm costs, 
and comments.

• Location — Use this tab to enter a project's address information, phone and fax 
numbers, and email address. The Location tab allows you to maintain contact 
information for the actual project site.

• Files — Use this tab to link to files and graphics related to the project. 

• Marketing Campaigns —  Use this tab to enter information on all of the 
marketing campaigns associated with this project. 

Vision Project Features New to CRM Users

• Create up to three levels of project hierarchy, or Work Breakdown Structure 
(WBS).

• Utilize expanded project and project team fields.

• Use the project Activities grid to link activities to projects.

• Use the project Awards grid to track project-related awards.

• Create unlimited client associations.

• Track project completion dates separately by construction-related activity and all 
project activity. 

• Search for projects by SF330 project code.

• Associate a vendor with a stored vendor address.

If your firm has installed other Vision applications, such as the Accounting or Time 
& Expense Vision applications, additional tabs appear in the Project Info Center.
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Projects with Three-level Work Breakdown Structure (WBS)

In Vision you can define up to three levels for your projects’ WBS. This gives you 
added flexibility when setting up and managing your projects. Although you can create 
up to three levels of project hierarchy, be aware that only level one (WBS1) can be 
used with Vision Proposals.

The default labels for the WBS levels in the Project Info Center are:

• WBS1 = Project

• WBS2 = Phase

• WBS3 = Task

To add a phase (after you have created a project record), from the Project Info Center, 
click New, New Phase on the Project Toolbar. To add a task to a project (after you 
have created a project and a phase), click New, New Task on the Project Toolbar.

If a project has phases and/or tasks, a small icon displays to the left of the project 
name and number. Click this icon to display a list of phases and tasks, and then click a 
phase or task in the list to access the phase or task information.

Add Up To Three Levels of Hierarchy for Each Project

WBS Level 1 - Project

WBS Level 3 - Task

Click the push pin icon 
to pin the WBS tree to 
the application form.

Create up to three levels of Work Breakdown Structure (WBS). Each 
shape indicates a level of WBS. Click the icon to open the WBS Tree, from 
which you can view and open each level.

WBS Level 2 - Phase
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Expanded Project and Project Team Fields

About project team fields:

• The Employees and Vendors grids each have a Team Status column so that you 
can show team members as proposed versus active.

• The Short Name and Long Name fields (General tab of Project Info Center) 
facilitate the use of short names in lookups and long names in proposals. 

• A County field is included with the project address (Location tab of Project Info 
Center).

• Work Breakdown Structure (WBS) is the basis for dividing project 
scope into discreet, manageable packages of work that balances the 
needs of management with an appropriate and effective level of 
project data.

• Be aware that although you can create up to a three level project 
hierarchy, proposals can only reference the first level of this hierarchy 
(WBS1).

• For more information about WBS in general, refer to the Work 
Breakdown Structure Concepts in the Vision Online Help. For 
information about how the three-level WBS affects project creation, 
refer to the Project Info Center book in the Vision Help system.

• After you open the WBS tree, you can keep it open by clicking the 
push pin icon in the upper right of the WBS tree dialog.

If your firm has also purchased, installed, and activated the Accounting 
application, an Hours field and a Refresh Hours button appears on the 
Employees grid and a Cost Amounts field and a Refresh Cost 
Amounts button appears on the Vendors grid. The Hours and Cost 
Amounts columns display the actual number of hours or cost the 
employee or vendor posted for the project. For users with access to the 
Project Labor Detail or Project Expense Detail reports, the hours or cost 
amount listed in either of these fields displays as a hyperlink to the 
appropriate report. When the hours link is clicked, the Labor Detail report 
for the active employee and project runs. When the cost link is clicked, 
the Expense Detail report for the active vendor and project runs.
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Project Activities Grid

You can link projects to activities from the Activities tab of the Project Info Center. 
Activities can be linked both to a project and to an employee on the project team 
(Activity Owner). For more information, see “Activities” on page 169.

Project Awards Grid

The Awards grid is used to track project awards.

Construction Complete and Professional Services Complete 
Dates 

Track project completion dates separately for construction-related activities and for all 
work, including professional services provided after the construction portion of the 
project is complete. These fields are used when completing the resume section of the 
SF330 proposals form.

Track Various Project Completion Dates: Construction vs. Professional Services

The Construction 
Complete Date and 
Professional Services 
Complete dates are 
used in the resume 
portion (Part I Section 
E) of the SF330 
Proposal.
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Search for Projects Based on SF330 Code

Project Codes are associated with a project on the Background tab. Each project code 
has a corresponding SF330 code. Although this SF330 Code field is not used by the 
SF330 Proposals application, it is included in the Project Codes grid to help with 
project searches. This field enables you to perform an Advanced search for all 
projects associated with a particular SF330 code or codes from any Advanced project 
lookup within Vision. Select Project Code - SF330 as your Advanced Search Type.

Associate a Vendor Address with a Project’s Vendor

From the Vendors grid on the Team tab, you can associate any Vendor in the grid with 
an address stored in the vendor’s Info Center record. By default, Vision displays the 
address description associated with the vendor's primary address.

If you have entered more than one address for a vendor in the Vendor Info Center and 
you want to display an address other than the primary address in the Address field, 
you can use the Address Description field to select a different address description. 

Associate Vendor with Vendor Address

Click the Find icon to open an 
Address lookup, and select the 
address to associate with the 
vendor. The addresses 
available for selection are 
those saved for the vendor in 
the Vendor Info Center.
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Vendors

Vendor records contain information about the vendors and consultants from whom 
your company acquires the materials and services needed to complete your projects 
or with whom your firm partners. Vendor is the default label for information that was 
labeled Consultant in Deltek CRM and Proposals. As with Deltek CRM and Proposals, 
you can store details in Vision about  the contacts, projects, and specialties of each 
individual vendor. 

When you convert from CRM and Proposals to Vision, the label that your firm used for 
the Consultant Data Source is carried over to the Vision Vendor Info Center.

Access vendor information by clicking Info Center » Vendors from the Vision main 
menu.

Vendor Info Center

The Vendor Info Center contains the following tabs, by default:

• General — Use this tab to enter, edit, or review a vendor's name and address 
information, status, phone and fax numbers, tax numbers and codes, vendor 
minority status and specialty, vendor record user availability, Internet Web site 
address, and other information about vendor.

• Contacts — Use this tab to associate one or more contact records with a vendor 
record. 
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• Opportunities — Use this tab to associate one or more opportunity records with 
a vendor record. When you associate a vendor record with an opportunity from 
this tab, the Opportunity record also stores a link back to the vendor on the 
Opportunity Info Center’s Team tab. If you are planning to create SF330 
Proposals from opportunities, it is important to associate vendor records with the 
appropriate opportunities in order to help automate SF330 proposal creation.

• Projects — Use this tab to associate one or more project records with a vendor 
record. When you associate a vendor record with a project from this tab, the 
Project record also stores a link back to the vendor on the Project Info Center’s 
Team tab. If you are planning to create SF330 Proposals, it is important to 
associate vendor records with the appropriate projects, to help automate SF330 
proposal creation.

• Files — Use this tab to link to files and graphics related to the vendor.

Vision Vendor Features New to CRM Users

• Merge the Client and Vendor Info Center.

• Track minority status using minority status fields.

• Link the vendor record to a particular office within your firm using the 
Organization field.

• Save multiple addresses per vendor record.

• Store a link to the vendor’s Web site in the Web Site address field.

• Link contacts to vendor records.

• Establish aliases for vendor names.

Organization field

The Organization field on the General tab of the Vendor Info Center allows you to link 
one of your firm’s office locations to a vendor firm.

Multiple addresses per vendor record

You can save multiple addresses for each vendor record, just as you can in the Client 
Info Center. This allows you to consolidate vendors that have multiple locations into a 
single record while still being able to access and utilize multiple addresses for the 
vendor.

• Your firm can change the Vendor label to Consultant or any other 
label from the Labels tab of General System Setup (Configuration » 
General » System Settings).

• If your firm has purchased the Accounting application, an Accounting 
tab appears in the Vendor Info Center.
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Web site address field

Store a link to the vendor’s Web site from the Web Site address field on the General 
tab.

Link Vendors and Contacts

In Vision, just as you can link a contact to a vendor record from the Contact Info 
Center, you can also link a contact to a vendor record. See “Link to Client or Vendor 
Address” on page 188.

Merge the Client and Vendor Info Center

To help stream-line your processes, Vision allows you to merge the Client and Vendor 
Info Centers into one central repository. This single Info Center can track all firms or 
companies with which you interact and manage the important data where there is a 
prime or sub relationship. For more information, see “Merging the Client and Vendor 
Info Centers” on page 175.

Minority status

Minority Status fields have been added to the Additional Info tab so that you can track 
the minority status of vendor firms.

Track Minority Status
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Establish Aliases for Each Vendor 

You can set up alternative names, nicknames, or aliases for each vendor you create in 
the Vendor Info Center (Similar to how you create client aliases). For example, you 
might set up a vendor called United Parcel Service with the aliases UPS or U.P.S. 
Aliases are used for searching (including Quick Find searches - see “Quick Find 
Searches” on page 91) and for duplicate record checking (see “Duplicate Record 
Check” on page 159).

Establish Alternate Names for a Vendor

Click the ellipsis (...) 
button in the Name 
field to display a 
drop-down where 
you can enter as 
many alternate 
names as you need 
for the currently 
opened vendor. 
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Text Library

The Vision Text Library Info Center contains saved text and file links that you can 
access when creating proposals, resumes, and reports.

Use the Text Library Info Center to store commonly used text passages for insertion 
into custom proposals, employee resumes, or project reports. You can store text items 
directly in the Text Library (General tab) or save links to external documents and 
graphic files (Files tab).

When you convert from CRM and Proposals to Vision, the label that your firm used for 
the Boiler Plate Data Source is carried over to the Vision Text Library Info Center.

Access text library information by clicking Info Center » Text Library from the Vision 
main menu.

Text Library Info Center
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Chart of Account and Unit 

The Chart of Accounts and Unit Info Centers are available to you even if you have not 
purchased any accounting-related Vision modules. This is because both accounts and 
units are required to use the Service Estimating Tool. For more information about the 
Service Estimating tool, please see “Determine Estimated Services and Materials” on 
page 198.

This section contains information about using these Info Centers with the Service 
Estimating Tool. For information about using these Info Centers for other accounting-
related purposes, please see the Deltek Vision Online Help.

Chart of Accounts

Use the Chart of Accounts Info Center to add, edit or delete expense or consultant 
accounts. You can then select these accounts from the Expense or Consultant grids 
on the Service Estimate tab of the Opportunity Info Center.

Access Chart of Accounts information by clicking Info Center » Accounts » Chart of 
Accounts from the Deltek Vision main menu.

Units

Use the Unit Info Center to set up cost and billing rates for recurring expenses (units) 
that have originated within your firm. Units in Deltek Vision are goods or services 
(such as training materials) that are billed at a flat rate per item. These rates are then 
available to be selected from the Units grid of the Service Estiamate tab of the 
Opportunity Info Center.

In Deltek Vision, individual unit records are stored in unit tables, which enable you to  
organize and maintain your unit information efficiently. You can create separate unit 
tables to group unit records by opportunity, unit type, and so on. This makes it easier 
for you to find and use unit records when using the Service Estimating tool.

Access the Unit Info Center by clicking Info Center » Units from the Deltek Vision 
main menu.
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Overview

The Vision Activity and Calendar applications provide a variety of options for 
scheduling and managing your daily activities, including phone calls, meetings, tasks, 
and other important business functions.

Some of the key Vision Activity and Calendar features include: 

• The ability to schedule and maintain information about all types of activities, and 
assign team members to each activity.

• The ability to set up recurring activities.

• The ability to associate multiple contacts with an activity.

• The ability to share your calendar with other CRM and Proposals users.

• Activity alarms and reminders to keep you and your team members on track.

• Different calendar views to match your working requirements.

• The ability to print a daily, weekly, or monthly view of your calendar.

• Activity alerts that work like Outlook to remind you of scheduled activities. These 
reminders can be delivered via email or pop-up within the application, with links to 
the related application area.

• Compatibility with Microsoft Outlook and an interface that mirrors Microsoft 
Outlook’s design for streamlined data entry and email capabilities. 

• Ability to create user-defined tabs and fields on the Activities dialog, which is used 
to schedule, edit, or review an activity.

• Ability to mark activities as private, viewable only by the activity owner and activity 
attendees.

• Fields to indicate the location of the activity and to show time as busy, free, out of 
the office, and so on.

• Support for all-day events, multi-day events, and the ability to schedule multiple 
meetings concurrently.

While CRM and Proposals integrated the activity calendar with the Data Sources, 
Vision includes two separate applications, a Calendar and Activity Manager, both of 
which integrate with the Vision Info Center and Dashboard.

When you schedule or modify an activity in Vision using either the Activity Manager, 
Calendar, Info Center, or Dashboard, the activity information automatically displays in 
the other three applications. And, when you delete an activity using any one 
application, the activity is also deleted from the other applications. The following 
sections provide an overview of the Vision Calendar and Activities features, an 
overview of security related to these features, and each of the four applications 
(Activity Manager, Calendar, Info Center, and Dashboard), as they relate to creating 
and managing activities in Vision.
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Note that the following exceptions apply to the above stated rule that an action taken 
in one application, which is related to an activity, flows through to the other 
applications (Activity Manager, Calendar, Info Center, or Dashboard):

• The Activity Calendar only displays phone calls, meetings, and tasks — to view 
other activities, you must use the Activity Manager, Info Center, or Dashboard.

• Project Planning tasks display only on the Activity Calendar — they do not display 
on the Activity Manager, the Dashboard, or in the Info Center.

• Info Center email, merge, and workflow activities display only on the Dashboard 
and in the Info Center — they do not display on the Activity Calendar or the 
Activity Manager.

You can also manage email activities from Microsoft Outlook, or manage 
any type of Vision activity from your Microsoft Windows Task Bar, if your 
firm is using Desktop Integration. Please see “Vision Desktop and 
Microsoft Office Integration” on page 303.

You can also use the Workflow application to create activities on the fly 
based on actions that users take in Vision. Please see “Document 
Management” on page 126 for more information. 
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Accessing Calendar and Activities

Where do I 
access the 
Vision Calendar 
and Activity 
Manager?

In CRM and Proposals 3.x, you access the Calendar and Activity Manager for an 
employee or client, for example, by clicking the appropriate toolbar icon from within 
the individual record. 

From Vision, you access both applications from the Calendar/Activities menu option 
on the Vision main menu, as well as from within individual Info Centers, such as the 
CRM Info. tab of the Employee Info Center, or the Activities tab of the Client Info 
Center.
6-222



Calendar
Calendar

Use the Calendar to schedule, edit, or review your activities. Click the appropriate 
Calendar tab to select the monthly, weekly, or daily view. Access the Calendar by 
clicking Calendar/Activities » Calendar from the Vision main menu:

Calendar

From the Calendar form, you can do the following:

• Click View » Tasks to display general tasks on the Activity Calendar, in addition to 
other standard activity types (such as phone calls and meetings).

• Click View » Pending Activities Only to display only pending activities. When 
you select this option, activities marked completed no longer display. You can 
select both Tasks and Pending Activities Only to display only pending activities, 
including pending tasks on the calendar.

• Click View » Share Calendar to select users with whom you want to share your 
Activity Calendar. See “Activity Maintenance” on page 6-229. for more 
information.

• Click View » Open Calendar to open another user's Activity Calendar. 
• Click View » My Calendar to return to your Activity Calendar if you currently have 

another user's Activity Calendar open. This option is only enabled when you have 
another user's Activity Calendar open.

• Click Print to open the Options for Activity Calendar dialog to select options to 
print a daily, weekly, or monthly view of activities.

• Click a date or meeting link to open the Activity dialog, from which you can add or 
edit activity details.
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Calendar Sharing

You can share your Calendar with other CRM and Proposals users at your firm. 

Enable Calendar Sharing

To enable calendar sharing, your System Administrator must select the Allow users 
to share their calendars option on the Miscellaneous tab of General System Settings 
(Configuration » General » System Settings):

Enable calendar sharing from the General System Settings form

Share Your Calendar

Specify the users with whom you want to share your Calendar and specify each user’s 
access rights to your Calendar. Those users can then open and view your Calendar 
using the Calendar and Activities application.

Sharing the Activity Calendar

Click View, Share 
Calendar to open the 
Share Calendar dialog, 
from which you grant 
users access to view 
your calendar.
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Activity Manager

The Activity Manager is a comprehensive activity log from which you can access and 
review details about any completed or pending activity. 

Access the Activity Manager by clicking Calendar/Activities » Activity Manager 
from the Vision main 
menu:

Activity Manager

Use the Activity Manager to schedule, copy, delete, edit, or review activities. You can 
also click any Info Center related link found in the Activity grid, such as the Client 
associated with the activity, and open that Info Center record. 

When you open the Activity Manager, it automatically defaults to your own activity 
view. If you are the administrator, you may also view other employees’ activities and 
schedules. The Activity Manager also provides a filter option to filter activities by type, 
date, or associated Info Center record (for example, client or project).

Using Activity Filters 

By default, the Activities grid displays your activities for the current month. However, 
you may want to view activities for a different time frame, or you may want to see only 

Info Center email, merge, and workflow activities do not display in the 
Activities grid on the Activities Manager form. Info Center email, merge, 
and workflow activities display only in the Activities grids of the 
associated Info Center records.

The Activities grid displays a list of 
your scheduled activities. By default, 
the grid displays your activities for the 
current month. However, you can use 
the Filter grid option to specify 
different options for determining which 
activities display in the grid.

The Details 
section 
displays 
information for 
the activity 
currently 
selected in the 
Activities grid.
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activities for a specific project, or you may want to review only pending activities. The 
two Filter grid options, Filter Options, and Open Filter, allow you to specify your own 
criteria for filtering the activities that display in the Activities grid, save this criteria, and 
then retrieve it from either the Activity Manager form, the Activity dashpart, or the 
Activities or CRM Info. tab in the Info Center. Using filters allows you to limit the list of 
activities in the Activities grid to only those activities you need to see at any given 
time.The two Activities filter options are:

• Filter Options  —  When you click Filter Options, the Activities Filter dialog 
opens. Filter on predefined filter options such as the activity type, activity date, or 
the Info Center record (for example, Project or Client), associated with an 
activity, using the Standard Filter Type. You can also define your own filter 
criteria using and Advanced Filter Type. 

• Open Filter —  From the Activities Filter dialog you can also save your filter 
criteria, much the same way you can save search criteria in Lookups, or report 
options from the Vision Reporting application. When you click Open Filter, your 
saved filters display for your selection.

Using a Previously Saved Set of Filter Options

Using the Activity Merge Feature

Use the Activity Merge feature to create simple data lists containing information from 
the activity records in your Vision database. The Merge function allows you to select 
activity records and then specify the data you want to view from the selected records. 
When you complete the merge, Vision creates a printable report showing only the 
activities and data specified.

Click Open Filter to display a 
list of previously saved sets of 
activity filter criteria. Once 
saved, these options are 
available for selection from the 
Activity Manager, Info Center, 
and Dashboard
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Before you can merge records, you must first create a Merge template and then link it 
to the appropriate Info Center or Activities record type in Vision. Use the Merge 
template to specify the types of data you want to include when you merge records. 
You can create as many Merge templates as you like, depending on what types of 
data are most useful to you.

Note that the Merge option displays on the Activity Manager toolbar only after you 
have created at least one Merge template and associated it with the Activities record 
type.

Opening the Merging Dialog to Specify Merge Options

Activity Reports

You can print an Activity Calendar, Activity List or Activity Summary report from the 
Activity Manager form.

• Activity Calendar — Displays a snapshot of your phone calls, meetings, and 
tasks for a given month, week or day. 

For more information about using the Activity Merge feature, please refer 
to the Calendar and Activities book of the Vision Help, accessible from 
the Vision user interface.

Click Merge to open the Merging dialog. From 
this dialog, you select a Merge template. The 
template itself contains the specific information 
about the data to include in the report, such as 
a list of all clients with their addresses.
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• Activity List — Displays a list of all activities that meet the criteria you specify. 
Use the Activity List report to review activity start and end times, locations, 
subjects, attendees, and more.

• Activity Summary — Displays details for selected activities that you have 
scheduled and/or completed. Use the Activity Summary report to review activity 
start and end times, locations, subjects, and attendees, and to share this 
information with other persons at your firm.

Print the Activity Calendar, Activity List and Activity Summary reports from the Activity 
Manager form:

Print, Email, Save Options for, or Schedule Activity Reports

You can do the following with Activity reports:

• Send to a printer.

• Preview on screen.

• Schedule a print job to run at a later date.

• Send an electronic copy of the report as an email attachment to an address you 
specify.

• Send a link to the report in Vision via an email. If the recipient of the email is 
logged into Vision, clicking the link opens the report in a new browser window. If 
the recipient is not logged in, he or she is prompted to log in, and then the report is 
displayed.

• Save an electronic copy of the report in Adobe PDF, RTF, Microsoft Word, or 
Microsoft Excel format to the application server.

• Download an electronic copy of the report in Adobe PDF, RTF, Microsoft Word or 
Microsoft Excel format to your machine or to a network machine that you specify.

 From the Reporting dialog you can select 
the Calendar, List, or Summary report, 
select activities to include on the report, and 
set printing options. 

Click Print, Print 
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Activity Maintenance 

Within the Activity Manager, you use the Activities dialog to enter activity details, 
associate an activity with a particular client, opportunity, marketing campaign, or 
project, associate an activity with one or more contacts or leads, add or delete activity 
attendees, schedule follow-up activities, or schedule recurring activities.

Access the Activities dialog by clicking Insert or Edit from the Activities grid.

Activities Dialog

Create User-Defined Tabs and Fields on the Activities Dialog

Create new Activity dialog tabs and fields to better suit your company's needs. Using 
User-defined Tabs (Configuration » General » User Defined Tabs), you can add 
new tabs and fields. You can also determine the order of tabs and fields. Before you 
begin adding new tabs, carefully determine what information you need to gather that is 
not captured elsewhere in Vision. Also consider how you want this information 
grouped.

After you have created new tabs and/or fields, you can use the Designer to easily re-
arrange tab elements, resize fields and labels, and determine whether you want cer-
tain fields hidden or locked based on Security role. 

For more information about using User-Defined Tabs and fields, please 
see “User Defined Tabs” on page 106.
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Redesign the Look of Activity Dialog Tabs

You can use the Designer to redesign the Activity Dialog tabs. You can easily re-
arrange elements, resize fields and resize and rename labels, and determine whether 
you want certain fields hidden or locked based on Security role. 

To do this, select a tab, right-click on the tab label, and select Design from the pop-up 
menu.

Open the Designer to Redesign Activity Dialog Tabs

Make an Activity Private

Select the Private check box from the Activity dialog to restrict viewing rights for the 
selected activity to the activity owner and employees listed on the Attendees tab only.

Mark an activity private

Right-click on a 
field to open a pop-
up that allows you 
to open the 
Designer. 
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Activity Manager
Link multiple contacts or leads to one activity

From the Contacts tab, you can link as many contacts as necessary to any given 
activity. Similarly, from the Leads tab, you select as many leads as necessary.

Associate Contacts with an Activity

Select Notify 
Contacts to email 
the activity’s details 
to each of the 
selected contacts.

Click Insert to open 
the Contact Lookup 
from which you can 
select one or more 
contacts to associate 
with this activity.
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Establish Recurring Activity

Use the Recurrence tab of the Activities dialog to flag an activity as a recurring event, 
and to specify the frequency and duration of the activity recurrence:

Set a Recurring Activity’s Duration and Frequency

When you set up a recurring activity, the information you enter on the Detail, 
Attendees, Leads, and Contacts tabs remains the same for each occurrence of the 
activity, thereby saving you time and ensuring that the activity information remains the 
same for each scheduled occurrence of the activity. If you make any changes to the 
activity, those changes are effective for each occurrence of the activity.

Recurring activities display on the Activity Calendar on the date of each occurrence. 
However, recurring activities display only once (as a single record) in Info Center 
Activities grids and on the Activity Manager. If you have set a reminder for a recurring 
activity, Vision will send the reminder at the designated time prior to each occurrence 
of the activity.
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Info Center
Info Center

In addition to the two applications accessible from the Calendar/Activities option of 
the Vision main menu, you can also use the Info Center to manage activities. You can 
schedule, copy, delete, edit, or review activities directly from the Activities tab of 
individual Client, Contact, Marketing Campaign, Lead, Opportunity, and Project Info 
Center records, or the CRM Info. tab for Employee Info Center records.

For more information about activities and the Info Center, see “Activities” 
on page 169.
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Dashboard

When you configure your Dashboard, you can choose to include the  Activities 
dashpart, which displays a list of scheduled activities. You specify which activities 
display in this dashpart by setting type, date, employee, and status options from the 
Select Timeframe dialog, accessible by clicking Options » Configure. From the 
Activities dashpart, you can view activity details, schedule new activities, and delete 
existing activities:

Manage activities from the Dashboard

For more information about the Dashboard, see Deltek Vision Dashboard 
on page 3-80.

Click Options » 
Configure to open 
the Activities Filter 
dialog and 
determine which 
activities display on 
the Dashboard.

Click 
Options»N
ew to 
create a 
new activity 
from the 
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Proposals
Overview

Deltek designed Deltek Vision Proposals to match CRM and Proposals 3.x. Deltek 
Vision Proposals includes SF254 Proposals, SF255 Proposals, SF330 Proposals, and 
Custom Proposals applications. Because Vision Proposals runs in a browser 
environment, it offers flexibility and streamlined procedures for retrieving and 
presenting data.

The redesign incorporating browser efficiency is minimally apparent. You will 
recognize most of the screens and menu options; the main differences are in 
terminology. For example, Deltek CRM and Proposal’s “style sheets” are called 
“merge templates” in Deltek Vision Proposals.

  

This chapter describes the Vision counterpart of each of the main features in Deltek 
Proposals. 

• The database conversion process does not convert proposal 
documents or style sheets. Conversion may render these items 
unusable in CRM and Proposals 3.x. Therefore, you should back up 
your CRM and Proposals database before converting to Deltek 
Vision.

Having a backup copy of your CRM and Proposals database leaves 
you free to refer to your CRM and Proposals data, style sheets, cus-
tom style sheets, and custom reports when re-creating them in Vision 
Proposals.

• For more information about Vision Proposals, see the Proposals 
book of the Online help, accessible from within the Vision application.
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Accessing Vision Proposals
Accessing Vision Proposals

You access proposals from Vision’s Proposals menu, similar to the Proposals menu in 
CRM and Proposals 3.x.
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Deltek Vision Proposals Configuration Overview

Since configuring Deltek Vision Proposals involves several steps, this section includes 
a summary of those steps. For more information about Proposals-related Vision 
configuration, see “Configure Vision for Use” on page 33.

Proposals configuration considerations include:

• Security

• Organizations (optional)

• Proposal Firms 

• Custom Proposal Merge Templates

Configure Security 

To use Vision, you must configure roles and assign users to these roles, which provide 
varying levels of security access to Vision applications and features. 

When creating roles and assigning users, keep in mind that users have full access to 
SF254/SF255/SF330 Proposals merge templates, regardless of Role settings. Role 
settings control access to Custom Proposal merge templates and Info Center merge 
templates only.

Configure Organizations

In place of CRM’s Company concept, Vision uses an Organization concept, based on 
a “business unit” model of your company. You set up an Organization for each of your 
company’s business units, which may be profit centers, office locations, or other 
organizing principle. 

Company data source information is now encompassed in Vision Organization 
configuration, but Vision’s Organization model includes additional features, such as 
the ability to have a multi-leveled organization structure. For more information about 
comparing the CRM Company data source model to the Vision Organization model 
see “Organization” on page 140. 

Much of the company information from CRM and Proposals is converted into Vision as 
proposal firms. A 2-level organization structure is also created during conversion and 
individual offices correspond to the 2nd level of the organization. Once organizations 
are created, they are also associated properly with respective proposal firms. Without 
this association, Info Centers, such as Projects and Employees (which are the main 
entities handled in govt. proposals at the firm/company level), cannot be effectively 
linked to government proposals.
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Deltek Vision Proposals Configuration Overview
Configure Proposal Firms

For use with the Proposals modules, Vision uses a “Proposal Firm” concept, based on 
an “office location” model of your firm. You set up a Proposal Firm for each of your 
firm’s office locations whose personnel and other project-related data you plan to use 
in proposals. Most of your CRM and Proposals Company Data Source data is 
converted to the Vision Proposal Firms application (Configuration » Organization » 
Firm Setup - Proposals).

 You should understand the following about Proposals configuration:

• You do not have to install the SF254/SF255/SF330 Proposals module to set 
up your firm’s proposal firms. However, you must set up Proposal Firms, and 
enter appropriate data, to use the SF254/SF255/SF330 Proposals module. 
These forms will not work properly without Proposal Firm data. During the 
conversion process, Company Data Source information is converted to Firm 
Setup - Proposals.

• You select profile and discipline codes to auto-populate in Part II Block 9 and 
Block 10 of the SF330 form from the comprehensive lists of codes stored in 
the Project Codes and Employee Skill/Discipline code tables. You do this by 
inserting the default codes you want to use on the SF330 tab of Firm Setup - 
Proposals. This is just a default list that Vision will use on the SF330 form 
based on the firm selected on the form. You can add or delete codes from the 
SF330 form (up to a maximum of 20 disciplines and 22 project codes). For 
more information about the SF330 tab, see “Proposals Firm Setup” on 
page 38.

• In Custom Proposals, if your proposal uses any merge codes that retrieve 
firm-wide data, you must set up a Proposal Firm and enter that data. For 
example, your firm's name and address do not exist in any of your 
Organization records. To make your firm’s name and address retrievable by 
Custom Proposals, create a Proposal Firm record and enter them there. 

• Create a Proposal Firm for each office location, then add its related 
organization(s) on the Associated Organizations tab of the Firm Setup - 
Proposals form. An Organization can be listed for only one Proposal Firm, but 
each Proposal Firm can list multiple Organizations.

• To maintain each organization's data for use according to the "office location" 
module, enter the appropriate office location data on all tabs in Firm Setup - 
Proposals.

If your firm plans to use the Deltek Vision Multicompany feature, this may 
affect how you configure Organizations. Please discuss this with your 
Deltek Vision representative.
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• If the SF254/SF255/SF330 Proposals module is not installed, the Additional 
Info tab omits the Service Fees grid. Also the SF330 tab does not display if 
the Proposals module is not installed.
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Deltek Vision Proposals Configuration Overview
Grant Access to Custom Proposals Merge 
Templates

While Deltek CRM and Proposals 3.x uses style sheets for custom proposals, and 
template sets for SF254/SF255/SF330 proposals, Vision SF254/SF255/SF330 
proposals and custom proposals both use “merge templates” that integrate your 
proposal text into a standard format. 

Merge templates contain data merge codes as well as your company's style 
specifications for proposals: page layouts, font settings, graphics locations, and other 
details.

Deltek Vision includes a default set of SF254/SF255 merge templates that are not 
editable by users. However, you can create your own set of SF254/SF255 merge 
templates, based on the default set. All Vision Proposals users have full access to 
SF254/SF255 proposals default merge templates, regardless of their security Role.

Deltek Vision also includes a default set of SF330 merge templates that are not 
editable by users. Although you can create your own set of SF254/SF255 templates 
based on the defaults, the functionality of the SF330 merge templates differs slightly. 
Please refer to the SF330 Proposals book of the Vision Help, accessible from the 
Vision user interface, for details about SF330 merge templates. All Vision Proposals 
users have full access to SF330 proposals default merge templates, regardless of 
their security Role.

For Custom Proposals, Deltek Vision includes a set of sample merge templates, 
which users can edit and upload. In some cases, your firm may not grant all users the 
right to upload merge templates via Configuration » General » Merge Templates. In 
this case, the System Administrator must upload merge templates.

After adding custom merge templates to the Vision database, the System 
Administrator can assign specific custom (sample) merge templates to each role, so 
users only have access to the templates they need to create custom proposals. 

The basic steps for using custom proposals merge templates with Vision are:

• Use the Configuration » General » Merge Templates feature to select the 
appropriate Vision Info Center, and then add, update, delete, or export custom 
merge templates within the Vision database. Templates are linked to the selected 
Info Center.

• Go to Configuration » Security » Roles » Access Rights tab and select Merge 
Templates from the Functional Area field to give each role access to the 
appropriate merge template(s).
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Merge Codes

Each Deltek Vision Proposals module includes merge codes that correspond to each 
Info Center. These merge codes are designed for use with the Info Centers and differ 
from Deltek CRM and Proposals merge codes. Vision also offers more merge codes 
and merge code types than were available in Deltek CRM and Proposals.

For more information about merge codes and merge code types, please 
refer to the Proposals book of the Vision Help, accessible by clicking the 
Help global icon from within the Vision user interface.
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Project Codes

Vision Proposals comes installed with the standard government profile codes used in 
SF254/SF255 proposals and the additional 42 profile codes used in SF330 proposals. 
They are known as Project Codes in Vision and are stored in the Project Codes code 
table (Configuration » General » Code Tables » Project Codes). 

Project Codes Code Table - Stores SF254/SF255/SF330 Profile Codes

The Vision conversion process converts the standard profile codes in your Deltek 
CRM and Proposals database. 

When you migrate from CRM and Proposals 3.x to Vision, Vision populates the 
Project Codes code table with a comprehensive list of SF330 codes, as well as 
SF254/SF255 codes. Because the SF330 form came into existence after pre-existing 
Vision applications that also used project codes, the Project Codes table contains two 
code values. In the Code column is the code used by other Vision applications, such 
as the SF254/SF255 forms, and in the SF330 Code column is the code specific to the 
SF330 form. To populate the tables with a comprehensive list of SF330 codes, Vision 
adds new rows in the tables for new codes (populating both the Code and SF330 

• The terms profile code and project code are interchangeable in this 
context of Vision proposals. The SF330 and SF254 form refer to the 
codes as Profile Codes. The Vision table from which these codes 
are derived refers to them as Project Codes.

• The options available for selection from Block 10 (Profile of Firm’s 
Experience) on both the second page of the SF254 and the Part II 
tab of the SF330 Proposals forms originate from the Project Codes 
code table. You can auto-populate these proposal form fields with up 
to 22 codes by inserting codes on the SF330 tab of the Firm Setup - 
Proposals form. For more information about the SF330 tab, see 
“Configure Proposal Firms” on page 239.
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Code fields with the same value), inserts the corresponding SF330 code in the SF330 
Code column for existing codes also used by the SF330 form, and in some cases 
combines existing codes, to comply with new SF330 regulations. 

To view and maintain the Project Code Table:

1. Click Configuration » General » Code Tables from Vision’s main menu.

2. Click the Project Codes link in the Description column.

3. From the Project Codes form,

• use Insert or Delete to add or remove project codes.

• use the checkboxes in the Active column to select the project codes your firm 
uses.

4. Click Save.

• When you add a new SF330 project code by entering the new code 
in the SF330 field, Vision populates the same value in the Code field.

• For project codes not specific to the SF330 form, the SF330 field 
should be left blank.
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Employee Skill/Discipline Codes

Vision Proposals comes installed with the 24 standard government discipline codes 
used in SF254/SF255 proposals and the additional 38 discipline codes used in SF330 
proposals.  These codes are installed in the Employee Skill/Discipline code table 
(Configuration » General » Code Tables » Employee Skill/Discipline Codes).

Employee Skill/Discipline Code Table - Stores SF254/SF255/SF330 Codes

When you migrate from CRM and Proposals 3.x to Vision, Vision populates the 
Employee Skill/Discipline code tables with a comprehensive list of SF330 codes, as 
well as SF254/SF255 codes. Because the SF330 form came into existence before 
pre-existing Vision applications that also used discipline codes, the Employee Skill/
Discipline table contains two code values. In the Code column is the code used by 
other Vision applications, and in the SF330 Code column is the code specific to the 
SF330 form. To populate the tables with a comprehensive list of SF330 codes, Vision 
adds new rows in the tables for new codes (populating both the Code and SF330 
Code fields with the same value), inserts the corresponding SF330 code in the SF330 
Code column for existing codes also used by the SF330 form, and in some cases 
combines existing codes, to comply with new SF330 regulations. 

The options available for selection from Block 9 (Employees by Disciplines) on the 
Part II tab of the SF330 Proposals originate from the Employee Skills/Discipline code 
table. You select the defaults that appear in Block 9 (up to 20) by inserting codes into 
the Disciplines grid on the SF330 tab of Firm Setup - Proposals. For more information 
about the SF330 tab, see “Configure Proposal Firms” on page 239.

Disciplines/skills that are not specific to SF330, should not have a value 
entered in the  SF330 Code.
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Master Document Feature

Vision Proposals does not have a feature for creating master documents. You can, 
however, still merge your proposal files to Microsoft Word and manually create a 
master document in Microsoft Word.
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Custom Proposals

Vision Custom Proposals is designed for use in creating any submission requested by 
a private or public entity, other than an SF255 or SF330 proposal. The Custom 
Proposal uses data from the Vision Info Centers. 

With Vision Proposals, you can search the Info Center for appropriate employee, 
project, lead, marketing campaign, consultant, text, graphics, and client reference 
records to insert into private- and public-sector proposals. The data selected for 
proposals can then be tailored to meet your clients’ specifications.

Once you have selected the appropriate records, you merge them with a custom 
merge template and work with the final document in Microsoft Word. 

You can re-use merge templates in creating other proposals. You can develop 
different merge template sets for different clients or types of custom proposals. You 
can also use Custom Proposals to design mail-merge templates or any other required 
document.

Access the custom proposals form by clicking Proposals » Custom Proposals from 
the Vision main menu.

Custom Proposals Form

From the Custom Proposals form, you can do the following:

• Create new proposals from scratch or by copying and modifying existing 
proposals from the New toolbar option.

• Add custom proposal sections by clicking Sections » Configure Sections from 
the toolbar. Each section you create will create a new tab of the same name on 
the Custom Proposal form. The basic information will then appear on a tab called 
General. For instructions, see “Add Sections to a Custom Proposal” on page 248.

• Merge data from the proposals with custom merge templates, to create printable 
proposals formatted and laid out in Microsoft Word. 

• Merge graphics from proposals with custom merge templates. Merging graphics 
requires that you place a graphics placeholder on the merge template. Please see 
the topic, Merge a Custom Proposal, in the Vision Help System for instructions.
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• Link an SF255, SF330, or Custom Proposal to an Opportunity record by creating 
a proposal log.

Navigating in the Custom Proposals Form

You perform most actions in Vision Custom Proposals, such as creating new 
proposals using the main custom proposals toolbar. In addition, a number of section-
specific functions, called grid options, are available from each tab that you create to 
correspond to a custom proposal section. These options are similar to the right-click 
menu of special functions for managing records available in some Deltek CRM and 
Proposals Data Sources and Custom Proposal Module.

Grid Options for Each Section Type

In Vision, each section tab, when opened, has grid options, such as Graphics and 
Reorder, for accessing and managing records in the Info Center on which the section 
is based. 

Add Sections to a Custom Proposal

In Deltek CRM and Proposals, you use the Add Section toolbar button to set up each 
section of your custom proposal. In Vision, you set up all sections of your custom 
proposal in the Configure Sections form.

To add sections to a proposal:

1. Click Proposals » Custom Proposals from the Vision main menu.

2. Click Sections » Configure Sections from the toolbar. The Configure Sections 
dialog displays:
7-248



Custom Proposals
 

Each section name appears on a tab, with the tabs ordered as listed in the Config-
ure Sections grid.

3. To add a section, click in the grid row where you want to add a section, then click 
Insert on the section grid. For information on the fields in this dialog, click the dia-
log’s Help button from within the Vision user interface.

4. When you are finished adding sections, click Close.
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SF330 Proposals

The SF330 Proposals form was created by the government as an improvement upon 
and replacement for the SF254/SF255 forms. The government and industry experts 
created the SF330 out of a desire to improve the existing SF254/SF255 form in such 
ways as removing duplicate information or information of marginal value, expanding 
essential information, and reflecting current architectural and engineering disciplines 
and services. 

In addition to the SF254 and SF255 Proposals modules, Vision also provides an 
SF330 Proposals module. The data you enter in an SF330 proposal is stored in the 
Vision database separately from the original data. Entering or editing data on the 
SF330 has no effect on the original data, which remains available as a starting point 
for building an SF330. If you enter information manually because it is missing or 
obsolete in the database, make a note of it, so you can correct the original data 
afterward. 

In Vision, the SF254 and SF255 forms will be maintained indefinitely, because some 
states continue to use these forms. Since Vision predates the government’s release of 
the SF330 form, Deltek provides more options for populating the SF330 than it does 
for the SF254/SF255.

Access the SF330 Proposals form by clicking Proposals » SF330 Proposals from 
the Vision main menu.

SF330 Proposals Form

Vision SF330 Proposals streamlines production of SF330 proposals, minimizing 
preparation time and improving communication among the proposal team. From the 
SF330 Proposals form you can do the following: 

• Create new proposals from scratch, from existing opportunity records, or by 
copying and modifying existing proposals from the New toolbar option.

• Merge data from the proposals with merge templates to create printable proposals 
formatted and laid out in Microsoft Word. The Vision SF330 Proposals application 
comes installed with a default set of merge templates for SF330 proposals. 
Features of the SF254/SF255 merge templates and SF330 merge template differ 
slightly. See the SF330 Proposals book of the Vision Help for details. 
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• Link an Opportunity record to an SF330 proposal by creating a proposal log. See 
“Proposal Log” on page 260.

Associating Employees with Projects

Before creating SF330 forms, it is important that you associate employee records with 
relevant projects. Info Center record links are bi-directional, so you can make the link 
from either the Employee Info Center (Projects tab) or the Project Info Center (Teams 
tab). When you associate an Employee record with a Project record, be sure to enter 
information in the Role and/or Role Description fields. The Role is a one or two word 
description of the employee’s contribution on a project, while the Role Description is 
a longer, perhaps one sentence, description. You set preferences from the SF330 
proposals application as to whether you will use the Role or the Role Description on 
your SF330 proposals.

Associate Records from the Employee or Project Info Center

Role and Role Description information 
are stored in both Info Centers. By 
default, Role is used on the SF330 
Proposals. 

Click 
Associate to 
open the 
Project or 
Employee 
Lookup and 
select 
projects or 
employees to 
link.
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Associating Vendors with Projects

Before creating SF330 forms, it is important that you associate Vendor records with 
relevant Projects. Info Center record links are bi-directional, so you can make the link 
from either the Vendor Info Center (Projects tab) or Project Info Center (Teams tab). 
When you associate a vendor with a project, be sure to enter information in the Role 
field. The Role is a one or two word description of the vendor’s contribution on a 
project. You can elect to enter a Role Description, which is a longer, perhaps one 
sentence, description, but it will not be used in the SF330. Only the role itself will be 
used.

Associate Records from the Vendor or Project Info Center

Role and Role Description information is 
stored in both places. Employee Role only, 
or Employee  Role and Role Description 
together, and Vendor Role only are used 
on SF330 Proposals.

Click 
Associate to 
open the 
Project or 
Vendor 
Lookup and 
select 
projects or 
vendors to 
link.
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Associating Employees and Vendors with Opportunities

Just as you associate employees and vendors with projects, you also associate 
employees and vendors with opportunities. If you will be creating SF330 proposals 
from opportunity records, you must associate employee and vendor records with 
relevant opportunities. It is critical to SF330 form creation.

Info Center record links are bi-directional, so you can make the employee link from 
either the Employee Info Center (CRM Info tab) or the Opportunity Info Center (Teams 
tab). You can make the vendor link from the Vendor Info Center (Opportunities tab) or 
the Opportunity Info Center (Teams tab). When you associate an employee with an 
opportunity, be sure to enter information in the Role field. The Role is a one or two 
word description of the employee’s contribution on an opportunity, while the Role 
Description is a longer, perhaps one sentence, description. 

When associating a vendor with an opportunity, be sure to enter a Role, and to 
associate an address with the vendor. See the next section for details about 
associating a vendor with a vendor address.

You set preferences from the SF330 proposals application as to whether you will use 
the employee’s Role only or Role and Role Description together on your SF330 
proposals.
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Following is an example of an employee associated with an opportunity. When 
associating a vendor with an opportunity, you do this from the Opportunities tab of the 
Vendor Info Center or the Vendors grid on the Team tab of the Opportunity Info Center.

Associate Records from the Employee or Opportunities Info Center

Role and Role Description 
information is stored in both 
places. Employee Role only or 
Role and Role Description 
together, and Vendor Role only 
are used on SF330 Proposals.

Click 
Associate to 
open the 
Opportunity or 
Employee 
Lookup and 
select 
opportunities 
or employees 
to link.
7-254



SF330 Proposals
Associating a Stored Address with a Project or Opportunity’s 
Vendor

From the Vendors grid on the Project Info Center’s Team tab, you can associate any 
vendor in the grid with an address stored in the vendor’s Info Center record. By 
default, Vision displays the address description associated with the vendor's primary 
address.

If you have entered more than one address for a vendor in the Vendor Info Center, 
and you want to display an address other than the primary address in the Address 
field, you can use the Address Description field to select a different address 
description. The address you specify flows through to the SF330 form along with the 
Vendor (into Block 25 of Section F), when you associate the Vendor with the proposal. 

Associate a Vendor with a Stored Vendor Address

Although there are similarities between the way you work with SF254/
SF255 and SF330 forms in Vision, there are also differences. Differences 
range from the functionality available in  SF254/SF255 versus SF330 
merge templates, to the more automated data entry available in SF330 
forms. For full details about creating and editing SF330 proposals, please 
refer to the SF330 Proposals book of the Vision Help System.

Click the Lookup icon to open 
an Address lookup and select 
the address to associate with 
the vendor. The addresses 
available for selection are 
those saved for the Vendor in 
the Vendor Info Center.
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SF254/SF255 Proposals

Deltek Vision SF254/SF255 Proposals are similar to Deltek CRM and Proposals 3.x 
SF254/SF255 Proposals. 

Access the SF254 Proposals form by clicking Proposals » SF254 Proposals from 
the Vision main menu.

SF254 Proposals Form

Access the SF255 Proposals form by clicking Proposals » SF255 Proposals from 
the Vision main menu.

SF255 Proposals Form
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SF254/SF255 Proposals
From the SF254 Proposal or SF255 Proposal Forms, you can do the following:

• Create new proposals from scratch or by copying and modifying existing 
proposals from the New toolbar option.

• Specify the layout and font settings for each section of your SF254 or SF255 
proposal from the Preferences dialog (Edit » Preferences toolbar option).

• Merge data from the proposals with merge templates to create printable proposals 
formatted and laid out in Microsoft Word. The Vision SF254/SF255 Proposals 
application comes installed with a default set of merge templates for SF254/
SF255 proposals. The default set can be used as is, or used as the basis for 
creating new sets of templates (from the Template Editor), which can then be 
modified to meet your firm’s needs.

• For SF255 proposals, merge graphics from proposals with SF255 merge 
templates. Merging graphics requires that you edit the standard SF255 merge 
template. Please see the Vision Help topic, Create a Modified SF255 Merge 
Template, in the Vision Help System for instructions.

• From the SF255, SF330 or Custom Proposal forms only (not the SF254 form) 
you can link an Opportunity Info Center record to an SF255 proposal by creating a 
proposal log.
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Navigating the Deltek Vision SF254/SF255/SF330 
Proposals Forms

The Vision SF254/SF255/Sf330 proposals work area is similar to the Deltek CRM and 
Proposals 3.x proposals work area: government forms, displayed at their actual size. 
In place of the Deltek Proposals’ right-click menu, in Vision, each block has a down 
arrow, which, when clicked, opens a shortcut menu of dynamic links appropriate for 
populating that block (where applicable).

Here is the shortcut menu accessed from  Block 4 of the SF255:

Deltek Vision Proposals management functions are accessible from toolbar buttons; 
Click the arrow  next to certain buttons, such as New, to display further options.
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Entering Data in the SF330 Proposal Forms
Entering Data in the SF330 Proposal Forms

The Vision SF330 form is more automated than are the Vision SF254/SF255 forms. 
Although you can click in many of the SF330 blocks and type in the information 
requested, this method will not populate the related areas of the SF330. For example, 
entering firms, employees and projects by typing them into Sections C, E, and F will 
not populate Section G and Part II, whereas creating a new form by selecting either 
New » New SF330 or New » Create SF330 From Opportunity and selecting from 
the shortcut menu lookups on the form will populate Section G and Part II. 

To make optimal use of the Vision SF330 Proposals module, Deltek strongly 
recommends:

• Preparing the applicable Vision database records for use in the SF330 proposal 
(Employee Info Center, Projects Info Center, and so on). For details about this, 
see the Help topic titled, “Before you Create an SF330 Proposal,” available from 
the Vision Help System.

• Using the auto-populate features built into the Vision SF330 module. 
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Proposal Log 

CRM and Proposals 3.x Proposal Log feature is also available in Deltek Vision. In 
Vision you use Proposal Logs to link custom, SF255, or SF330 proposals to 
opportunity records that exist in the Vision Opportunity Info Center. You create this link 
from the Proposal dialog

To open the Proposal dialog:

1. Click Proposals » Custom Proposals (or Proposals » SF255 Proposals or 
Proposals » SF330 Proposals) from the Vision main menu to open the appropri-
ate proposal application.

2. Open the proposal you want to link to an opportunity by clicking Open from the 
toolbar and performing a Standard Lookup. For information about Standard Look-
ups, please refer to the Vision Help System.

3. Click Create Proposal Log from the toolbar. The Proposal dialog opens:

4. Enter information in the fields on this form and click OK when finished. For infor-
mation about the fields, please refer to the Vision Help System by clicking the dia-
log Help button from the Vision user interface.
The information you entered appears on the Opportunities Proposals tab in the 
Opportunity Info Center:
7-260



Proposal Log
Deltek CRM and Proposals to Deltek Vision Migration Guide 7-261



Proposals
7-262



Deltek CRM and Proposals to Deltek V
R e p o r t i n g            

In this chapter
� Overview
� Accessing Vision Reports
� Types of Vision Reports
ision Migration Guide 8-263



Reporting
Overview

This chapter discusses the key differences between Deltek CRM and Proposals 
reporting and Deltek Vision reporting. 

All of CRM’s reporting functionality remains available to you in Vision. In place of the 
“canned” reports available in CRM, Vision provides you with the Summary report, and 
a List report configuration feature, which you can use to create any report, including 
the standard CRM reports you are used to.

Vision offers you the capability to:

• View a visual representation of large amounts of project-related information, to 
quickly and easily discover business patterns and risks. You can generate 
visualization reports using the standard Vision interface or run a Smart Client 
version of visualization reports, which generates reports more quickly. The Smart 
Client version is a different way to display visualizations. You must set options for 
display, however, from the standard Web interface.

• Preview reports onscreen. You can print the report after previewing it right away or 
schedule it to run at a later time. 

• Specify print options specific to the selected printer, such as paper size, paper 
source (tray), whether or not to use color, and the scale at which to print.

• Create and save report “options” for a List report, specifying the Info Center, data 
columns, sorting and grouping criteria, and formatting for each report option. 

• Create and save sets of selection criteria with which to populate reports.

• Create and save “favorite” report formats. After you have created a favorite, it 
takes just one click to generate a favorite report with current data that uses the 
formatting and options you’ve saved. Access any of your favorites from the 
reporting application or your Dashboard.

• Download electronic copies of reports in Adobe PDF or Microsoft Excel format. 
You can specify whether to download a PDF file to be opened in Adobe Acrobat 
(Adobe PDF (Save)), or preview the PDF immediately in a browser window 
(Adobe PDF (View)).

• Save electronic copies of reports in Adobe PDF, RTF, Microsoft Word, or Microsoft 
Excel format to your application server each time you print a report. 

• Email a report as an attachment from the report browser window.

• Email a hyperlink to a Vision report. If the recipient of the email is logged into 
Vision, clicking the link opens the report in a new browser window. If the recipient 
is not logged in, he or she is prompted to log in, and after doing so, the report 
displays.

• Export Vision data directly to an Adobe PDF, RTF, TIFF, CSV, or Microsoft Word 
file, a Microsoft Excel spreadsheet, or an XML or HTML document.

• Use graphing functionality to manipulate chart formats, for example, customizing 
labels or flipping the x and y axes of a bar graph. 

• Display any report that is saved as a favorite, or any chart within a report, within a 
Web dashpart on your Dashboard.
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• Tailor report footers.

• Use SQL Reporting Services to define your own reports, or modify existing Vision 
reports that integrate with Vision.    

• Drill down for detail on certain types of data.

You cannot convert your custom reports from Deltek CRM, although you can use them 
as models for the report options you create in Vision. You use SQL Reporting Services 
rather than Crystal Reports to create new custom reports and modify existing reports. 

Deltek recommends that, before re-creating any of your CRM custom reports in SQL 
Reporting Services, you review Vision’s Reporting Options dialog in the relevant Info 
Center for more details on creating custom reports using Microsoft Excel 2007. 
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Accessing Vision Reports

How do I access 
reports?

You access most Vision reports from the Reporting menu option on the Vision main 
menu, similar to the Reporting menu in CRM and Proposals 3.x. Some reports, are 
accessible from the Print toolbar option within an Info Center or Activity Manager.
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Types of Vision Reports

Deltek CRM offers two main types of reports: Summary, and List reports, as well as 
variation on list reports that are specific applications, such as the forecast report and 
the hit rate report.

Deltek Vision offers:

• Audit reports that allow you to keep track of changes made to Info Center records 
in Vision. Audit trails are triggered when users perform update, delete, and insert 
actions on these records.

• Audit reports display record names, actions performed, user names, and 
dates.

• Audit Detail reports display actions performed, and old and new data values 
by column.

• A Summary report for each Info Center, as well as activities. Fonts and margins 
are configurable as to font and margins, and depending on the Info Center or 
Activity Manger, other format settings are as well.

• A List report, which is highly configurable. To create any List report, you open the 
List report that corresponds to the appropriate Info Center or Activity Manager, 
such as, Reporting » Projects » Project List. Then select from among all the 
data fields in that Info Center. You can specify column headings, sorting and 
grouping criteria, and formatting options. 

• A Calendar report in daily, weekly, or monthly view.

• Data Export reports, which allow you to select data from various Info Centers and 
download directly to an Adobe PDF, RTF, TIFF, CSV, or Microsoft Word file, a 
Microsoft Excel spreadsheet, or an XML or HTML document.

• Several Performance Management reports: Key Financial Metrics report, which 
allows you to monitor your opportunity hit rate; Top-Bottom Performers reports, 
which provide you with a quick and easy to read status of the highest and lowest 
opportunities or projects.

• Opportunity Forecast report, which you use to review probability estimates and 
predicted revenue numbers for opportunities your firm is pursuing.

• Opportunity Hit Rate List report, which you use to review the "hit rate" for 
opportunities. In general, Vision calculates the hit rate as awarded opportunities 
divided by all opportunities. Use the report's options to limit the opportunities 
included in the hit rate calculation by specifying a date range, excluding inactive 
opportunities, limiting opportunity records by their award code, or excluding a 
specific opportunity stage, such as canceled.

• The ability to save report options, just as you saved report selections in Deltek 
CRM and Proposals 3.x. For both Summary and List reports, after you have set 
options and selections for a report, you can save the settings in either the Global 
or your Personal folder. You can also save a report option as a Favorite. 

• The ability to choose which default sections to include on Summary reports, and 
the ability to add custom sections.
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• The ability to break out reimbursable consultant, reimbursable expense, direct 
consultant, and direct expense amounts on project reports to easily compare 
actual to budgeted amounts.

• The ability to print Avery 5160 or 5161 mailing labels using information from the 
Client, Contact or Lead Info Center.

Visualizations

In addition to the rich suite of reporting features described previously, Vision offers 
visualizations. Visualizations are designed to support the analytical needs of project 
managers and other executives. Visualizations are graphical representations of the 
current health of your opportunities and projects.

There are two kinds of visualizations, Web Client and Desktop Client. Web Client 
visualization runs via your internet browser, just as most applications in Vision do. To 
run Desktop Client visualizations, you must download the application file to your 
desktop before running the application.

Each visualization map consists of blocks, with the size and color of each block 
representing performance against metrics you select. Using a visualization map, you 
can make faster, better decisions about important aspects of your projects, 
opportunities, and plans. For example, you can quickly spot trends in project 
profitability or receivables. Visualization maps save you time in identifying the risks to 
your business.

For your visualization maps, you set sizing and coloring options that make it easy for 
you to identify risks and trends visually. The specific options you use for selecting the 
size and color settings depend on which visualization type you are using.

Web Client Visualizations

The Web Client Visualization application uses the standard Vision interface. To access 
Web Client Visualizations, you click Reporting » Visualization » Web Client. 

For more information about Deltek Vision Reporting, please refer to the 
Vision Online Help topic, “Reporting Overview,” accessible from the 
Vision user interface.
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Sample Opportunity Visualization Report

Each Visualization map consists of blocks. Each block represents an opportunity or 
project, with the size and color of each block representing performance against 
metrics you select. 

For your Visualization maps, you set sizing and coloring options that make it easy for 
you to identify risks and trends visually:

• Size—The greater the metric amount, the bigger the corresponding block on the 
visualization map. For example, if you select Estimated Revenue as the sizing 
metric for an Opportunity Visualization, then larger blocks on the visualization 
map represent opportunities with higher amounts of estimated revenue.

• Color—The greater the metric amount, the bigger the corresponding block on the 
visualization map. For example, if you select Estimated Revenue as the sizing 
metric for an Opportunity Visualization, then larger blocks on the visualization 
map represent opportunities with higher amounts of estimated revenue.

Using a Visualization map, you can make faster, better decisions about important 
aspects of your projects and opportunities. For example, you can quickly spot trends 
in project profitability or receivables. Visualizations save you time in identifying the 
risks to your business.

If Visualizations are enabled for your firm in Configuration, Vision offers the following 
types of visualizations for firms using Deltek Vision CRM or CRM and Proposals only:

• Opportunity Visualization

• Project Visualization

Drilling Down to Related Reports

If you want to see more detail about an opportunity or project included on a 
Visualization map, you can drill down to a related report from the map. For example, if 
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you are working with an Opportunity Visualization, you could drill down to an 
Opportunity Summary report or Opportunity Forecast. 

User Defined and Calculated Fields

You can include both numeric user-defined fields and calculated fields on 
visualizations. 

Security

The Web Client Visualization application honors all Vision Security Configuration 
settings established for record level and report grouping access.

Procedures You Can Perform with Visualization Reporting

• Create and preview a visualization map.

• Spin the view.

• Use colors to focus your visualization map.

• Mouse over with Tool Tips (similar to drilling down for detail).

• Zoom in on a group.

• Drill down to a report from a visualization map.

• Add or modify calculated fields for visualization maps.

• Print a Visualization map.

Desktop Client Visualizations

Before you can use Desktop Client Visualization, you need to use Web Client 
Visualization to establish and save favorites for use in the Desktop Client version. 
Each favorite definition contains settings for reporting options, including those that 
determine which grouping criteria and metrics will be available for the map. You must 
have one or more favorites saved in Web Client Visualization in order to display a 
visualization map in Desktop Client Visualization. 

Requirements

Desktop Client Visualization was developed using Microsoft's® Smart Client 
technology. When you launch Desktop Client Visualization, Vision opens a separate 
Smart Client window that utilizes data from the Vision database.

Deltek is utilizing Microsoft’s ClickOnce technology to deploy our new Smart Client 
applications, including Desktop Client Visualization. These Windows Forms-based 
applications require that your workstation has .NET Framework 2.0 installed.

• If that pre-requisite is missing, ClickOnce displays a form and stops the 
application download. 

• If .NET Framework 2.0 is already installed, a download of approximately 16 mb is 
initiated and completed on your workstation. You are required to click once, on an 
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Application Run – Security Warning dialog, to confirm the download; then you can 
work with the Smart Client application.

The ClickOnce technology does not require that you have local administrative rights 
on your workstation. It will allow Vision to recognize when an update is required, on 
the client machine, for our SmartClient applications, and will perform the download 
automatically.

For more information, see the "Vision/GovWin Technical Overview & System 
Requirements" document provided to your firm.

To launch Desktop Client Visualization the first time:

1. Click Reporting » Visualization » Desktop Client to download the software to 
your PC. A dialog tells you the process is taking place. When it is complete, Vision 
displays a blank Desktop Client Visualization dialog.

Once you have downloaded Desktop Client Visualization, launching it in subse-
quent sessions takes less time.

2. Now you can preview a favorite visualization map on the Desktop Client Visualiza-
tion dialog and use the Grouping, Color, and Size options to adjust its display.

• Your firm must first activate the Visualization application, from 
Configuration » Module Activation, before using visualizations.

• For more information about Deltek Vision Visualization Reporting, 
please refer to the online Help topic, “Visualizations Overview: Web 
Client and Desktop Client,” accessible from the Vision user interface.
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Create and Run Reports in Vision

In Deltek CRM and Proposals, you run reports from the Data Sources. In Vision, you 
create and run reports from the Reporting option of the Vision main menu. You can 
also run List and Summary reports from any Info Center, or from the Activity Manager.

Create Reports from the Reporting Menu

Follow these instructions to create and run reports from the Reporting option of the 
Vision main menu. This example uses Employee data.

To Create and Run a Report from the Reporting Menu:

1. Click Reporting » Employee from the Vision main menu. 

2. Select the Employee List report, then click Print in the toolbar, or click the Find 
icon in the Options column. The Options for Employee List dialog opens.

3. Click the Columns tab. The Column Name column lists all data fields for the Info 
Center you selected. In the following example, it lists all the data fields for the 
Employee Info Center. Click the Select checkboxes for each data field you want in 
the report.

4.  Click the Sorting/Grouping tab. The Sort/Group By column lists all the criteria by 
which you can sort data on the report:   

The Reports grid shows all Vision reports, as well as any 
report Favorites you saved. It also shows any custom 
reports created and loaded on the Vision Report Server. 
You create custom reports using Actuate e.Report 
Designer and the e.Reporting Library.
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5. Select the Sort checkbox for each row on which you want the report to sort or 
group data:

• If you select the Sort checkbox for data fields, the report sorts data on that 
field. A report containing employee data might be sorted by Employee Name.

• If you select the Sort checkbox for a report group, the report you are creating 
groups all data by the Info Center records in that report group. 

6. When you have finished making your selections, click Move Selected Items Up. 
to move all of your selected items to the top of the list. This will make sorting them 
easier.

7. Click on a selected row. Use the up and down arrows to the left of the grid to move 
the row up or down the column, until the data fields are ordered as you want them 
to appear in the report. 

8. Enter information on the General, Graph, and Misc tabs, as needed. For informa-
tion about the fields on these tabs, refer to the Vision Help.

9. At any time while the Options dialog is open, do any of the following:

• Click Organize to open a report options dialog. Once you save a report 
option, it appears in the Saved Options list on the Options dialog, and you 
can save it as a Favorite. You do not need to run a report before saving it as a 
report option or a Favorite.

• If you opened the Options dialog using the Binoculars icon, click Apply to 
save the options and return to the Reporting dialog. If you opened the Options 
dialog by clicking the Print button on the toolbar, click Run to open the Print 
dialog. From the Print dialog select print options, and click Print.

Create and Run Reports from Info Centers

To open the Reports grid from an Info Center:
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1.  From the Vision main menu, select Info Center » Employees.

2. Open an employee record or group of records, then click Print in the toolbar. The 
Print menu opens: 

If you opened the employee record from a record group, Print Active Group is 
enabled in this menu.

3. Select an option from the Print menu. The Reports grid opens. If you clicked:

• Print Current Employee, the Selection column contains the selected 
employee’s name.

• Print Active Group, the Selection column contains the selected group’s 
name.

• Select Employee to Print, the Options, Selection, and other columns are 
blank.

4. Follow the procedures in the section “Create Reports from the Reporting Menu,” 
on page 272 of this chapter, steps 3-8.
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Create and Run Activity and Calendar Reports

In Vision, you run the Activity Calendar, Activity List, or Summary reports from the 
Activity Manager.

To create and run an Activity Calendar, Activity List or Summary report from the 
Activity Manager:

1. Click Calendar/Activities, Activity Manager from the Vision main menu. The 
Activity Manager form displays. 

2. Do one of the following:

• Click Print » Print Current to print an Activity report for the activity currently 
selected in the Activities grid. 

• Click Print » Print All to print an Activity report for all the activities displayed 
in the Activities grid.

Vision opens the Reporting dialog.

3. Follow the procedures in the section “Create Reports from the Reporting Menu” 
on page 272 of this chapter, steps 3-8, selecting Activity Calendar, Activity List 
or Activity Summary from the Report Name field.

To create and run an Activity Calendar report from the Calendar:

1. Click Calendar/Activities » Calendar from the Vision main menu.

2. Click Print from the Calendar toolbar. The Options for Activity Calendar dialog 
opens.

3. Follow the procedures in the section “Create Reports from the Reporting Menu” 
on page 272 of this chapter, steps 3-8.

Create a Visualization Map

To create a visualization map:

1. Click Reporting » Visualization » Web Client to display the Reporting grid.

2. Select Project Visualization or Opportunity Visualization, then click the binoc-
ulars icon in the Options field to display the options tabs.

3. On the General tab, change the name of the visualization map (report).  If you are 
using the Multicurrency feature, you can set currency-related options for project 
visualizations.

4. On the Grouping tab, select up to six criteria to group by. You must select at least 
one grouping criterion. Selections on this tab determine which settings are avail-
able in the drop-down list for the Grouping option on the Visualization dialog.

5. On the Metrics tab, select one or more metrics. The metrics you select determine 
the focus of the visualization map, as well as the types of data you see when you 
mouse over blocks on the visualization map.  
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For example, if you select Revenue-Opportunity and Days Open-Opportunity, then 
you can focus your Opportunity Visualization either by estimated revenue or by 
number of days open, and mouse over the views to see specific numbers. 

Additionally, you can specify that a given metric serve as the basis for the size 
and/or color of blocks:

• If you select Color By, the metric will be available in the drop-down list for the 
Color option on the Visualization dialog. 

• If you select Size By, the metric will be available in the drop-down list for the 
Size option on the Visualization dialog. 

Select settings for Low Color, High Color, and Color Shading to customize your 
visualization map. Optionally, you can change the Label for the metric. If you are 
using the Multicurrency feature, you can set currency options.

6. On the Misc tab, set the Visualization Size options.

7. Optional. On the Drill Down Reports tab select reports that will be available as 
drill-down reports from the tool tip on the visualization map. Note that drill down 
reports are available only when you preview the map on the Web Client Visualiza-
tion dialog.

8. Click Apply. You can now preview the map on the Web Client Visualization dialog.

9. Save your visualization as a favorite if you want to preview the map on the Desk-
top Client Visualization dialog, or if you simply want it to be available for use again 
in the future on the Web Client Visualization dialog. 

For more information about Deltek Vision Visualization Reporting, please 
refer to the online Help topic, “Create a Visualization Map,” accessible 
from the Vision user interface.
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Overview

Deltek Vision includes a set of utilities that perform specific functions on the Vision 
database. Use these utilities to configure many of Vision’s functions, including report 
administration, data import details, process server setup, database backup location, 
and key conversions and formats.   

The Vision utilities are: 

• Change Company — The Change Company utility allows you to switch to 
another company record, if you are using the Multicompany feature.

• User Activity — The User Activity utility allows the System Administrator to 
display information about active logged on users, application servers, process 
server activity, and queue names.

• Advanced Utilities — From the Deltek Vision CRM and Proposals Advanced 
Utility menu, perform data imports, delete batches of Info Center or proposal 
records, perform a global Search and Replace of Vision data, execute interface 
routines between source and target databases, collect opportunity information 
from the INPUT Web Service, or create Client Info Center records from Vendor 
Info Center records.

• Key Conversions — Use this utility to change certain numbers/codes in your 
database to either new or existing numbers/codes. You can convert numbers/
codes for accounts, account ranges, clients, contacts, employees, projects, 
phases, tasks, organizations, a single project’s organization, units, and vendors. 
You can also enable or disable phases and tasks (multi-level Work Breakdown 
Structure). 

• Key Formats — Use this utility to configure, merge, or change key values and 
formats for a variety of data elements, including clients, employees, projects, 
phases, tasks, organizations, and vendors.

• Process Server — Use this utility to offload time-consuming processes from your 
workstation to another workstation, so you can continue using Vision without 
interruption.

• Backup Database — Use this utility to back up your Vision database.

• Report Administration — Use this utility to monitor and control reports that 
Vision is currently generating.

• Download Merge Macro — Use this utility to make Vision supported merge 
codes (for use with custom proposal merge templates) available in Microsoft 
Word, by creating a toolbar within Microsoft Word. 
9-278



Overview
• Download Integration — Use this utility to install Deltek’s Desktop Integration 
tool, which allows access to Vision data from Microsoft Outlook, Microsoft Word, 
Microsoft PowerPoint and the Microsoft Windows Task Bar.

The contents of this guide refer to default tabs and fields. Some of the 
tabs and fields in your application may have been changed or added to 
meet your firms business requirements.

If you are using other Vision applications, such as Accounting and/or 
Vision Planning applications, additional menu items, tabs, and fields will 
also be available.

Contact your System Administrator for more information about the Vision 
applications that your firm uses.
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Accessing Utilities

In CRM and Proposals 3.x you accessed maintenance functions from the System 
menu, and/or the Maintenance button on the Shortcut bar. In Vision, you access 
comparable functions from the Utilities menu.

Some functions you performed from the CRM and Proposals 3.x System 
and Maintenance menus, such as security-related functions, are 
accessible from Vision’s Configuration menu option, and not the Utilities 
menu. See “Configuration” on page 97.
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Change Company

The Change Company utility allows you to select and open a different company within 
your Vision database. This utility is available only if you are using the Vision 
Multicompany feature. 

The Multicompany feature allows you to set up multiple companies within your Vision 
database. Each company is a separate legal entity which functions within the larger 
enterprise. After you have set up your companies, you can then maintain Info Center 
records, generate reports, and create proposals separately for each company,

To access the Change Company utility, click Utilities » Change Company from the 
Vision main menu. Vision displays the Company Selection dialog.

Company Selection Dialog

The Company Selection dialog displays a list of all the companies you have set up in 
your database. Click the company you want to open and then click OK. Vision closes 
the company you currently have open and opens the company selected.
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User Activity

The Vision User Activity utility allows your firm’s System Administrator to review 
information about active logged on users, application servers, process servers, and 
process queues.

Your System Administrator can also use this utility to email all active users and 
temporarily disable logins when maintenance is needed.

To access the User Activity utility, click Utilities » User Activity from the Vision main 
menu.

User Activity Form

The top half of the User Activity form contains a grid that displays the name and user 
ID of each user currently logged on to Vision. The grid indicates which Vision 
applications the user currently has open, whether or not there is any process server 
activity associated with each application, and the date and time of the last transaction 
performed in each application.

The bottom half of the User Activity form displays the date and time of the last login to 
Vision, and which server was accessed by the last login. It also displays the date and 
time of the last transaction completed in Vision, and the name of the process server 
queue, if applicable. A description of the last activity displays, along with the Process 
ID and Thread ID data.

Perform the following functions from the User Activity form:

• Refresh — Update the data displayed on the User Activity form. Login and activity 
data will be updated to include any new logins or activity that have occurred since 
you opened the form.
9-282



User Activity
• Actions » Email Users — Send an email to all users who are currently logged 
on. Use this option to notify users when you need them to log off for maintenance 
purposes. When you select this option, Vision opens the Send Email dialog.

Click the Help 
button on the 
dialog from 
within Vision to 
learn more 
about sending 
emails to Vision 
users.

Send Email Dialog

Use the Disable 
user logins 
option when you 
need to 
temporarily 
disable user 
logins. If you 
need to 
permanently 
disable logins 
for one or more 
users, disable 
the logins in 
Security 
Configuration.

• Actions » Disable user logins — Disable logins for all users (except System 
Administrators). This option does not affect user login settings defined in Security 
Configuration.

• Actions » Enable user logins — Enable logins for all users. This option does not 
affect user login settings defined in Security Configuration.

• Save — If you disable or enable user logins, you must click Save before exiting 
the User Activity utility.

• Help — View help for the User Activity utility.
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Advanced Utilities

From the Advanced Utilities option you can:

• Import data

• Delete groups (batches) of Info Center records

• Use the Search and Replace utility to update the values in Info Center fields 
globally with a new value.

• Use the Datastage TX Integration utility to configure and execute data interface 
routines between source and target databases

• Use the INPUT Web service to allow Deltek GovWin to collect information for 
selected opportunities.

• Create clients from vendors.

Data Import

Use the Data Import utility to bring data collected outside of Deltek Vision into Vision 
for processing. Similar to the Deltek CRM and Proposals Import/Export utility, the 
Vision Data Import Utility automates the data import process, allowing you to take data 
that is in a text (.txt) file or an ODBC data source, and use it to create a new data entry 
table. After you import the data, you can check its validity, then post it as you would 
any other data. 

Access the Import Utility by clicking Utilities » Advanced Utilities » Data Import 
from the Vision main menu.

Data Import Utility
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Batch Deletes

Use the Batch Deletes utility to delete multiple Info Center or proposal records at once 
by selecting records to delete from a Lookup list.

Access the Batch Delete utility by clicking Utilities » Advanced Utilities » Batch 
Deletes from the Vision main menu.

Batch Deletes Utility
Deltek CRM and Proposals to Deltek Vision Migration Guide 9-285



Utilities
Search and Replace

The Search and Replace utility allows you to update the values in Info Center fields 
globally with a new value. Some examples of how you could use the Search and 
Replace utility include:

• Changing the status for a certain project or group of projects from Active to 
Dormant. This is particularly useful if you have a project with many levels of Work 
Breakdown structure, since the Search and Replace tool allows you to replace a 
value across all levels of a project (project, phase, and task). 

• Updating the Project Manager on a project. 

• Changing the Available to CRM users flag from Yes to No for all projects that are 
now marked Dormant.

Use caution when using this utility. Although Vision does include validation of the new 
value you are selecting to replace an old value, when you use the standard fields, you 
are still manipulating database information. You should double check your selections 
before initiating a global Search and Replace. Refer to the Deltek Vision Data 
Dictionary, available from within the Vision Help system, for descriptions of database 
fields.

Also be aware that when using the SQL Expression feature of the Search and 
Replace utility, no validation of new values occurs. 

Search and Replace Form
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INPUT Web Service

Deltek GovWin is Deltek’s Web-based solution that addresses the unique business 
development requirements of federal contractors. With Deltek GovWin, you have a 
central repository for the information needed to turn prospects into contracts. 

The INPUT Web feature allows Deltek GovWin to collect information for selected 
opportunities from the INPUT Web service. If you are using this feature, you already 
subscribe to INPUT to track a listing of various advertised government opportunities. 
This subscription gives you access to INPUT’s database of federal and/or state and 
local data online. Using this feature, you can also select the opportunities you'd like to 
import into GovWin as opportunities.

You then run a transfer of opportunities from the INPUT system into GovWin via a 
Web service call. This transfer is run from the INPUT Web Service utility. When you 
run this utility, an opportunity is created in GovWin for each new opportunity selected 
and transferred from INPUT. Information comes over into standard and custom fields. 
An INPUT Info tab exists in the Opportunity Info Center for much of the information. 

Access the INPUT Web Service utility by clicking Utilities » Advanced Utilities » 
INPUT Web Service.

INPUT Web Service Form

The INPUT Web Service form consists of two tabs:

• General — Use this tab to view the history of all transfers of data run between the 
INPUT Web Service and GovWin.

• Configuration — Use this tab to view the manner in which INPUT Web Service 
has been set up in GovWin. For information about subscription and preferences 
please see the GovWin Online Help, accessible from the GovWin user interface.
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Create Client from Vendor

The Create Client from Vendor utility configures Vendor Info Center records for 
automatic conversion into the Client Info Center. This is useful for CRM users who 
want to merge Client and Vendor Info Center data. 

After converting the vendor records, you must use Vision Security Configuration to 
disable the Vendor Info Center for all roles.

Access the Create Client from Vendor utility by clicking Utilities » Advanced Utilities 
» Create Client from Vendor.

Create Client from Vendor Form

The Create Client from Vendor form consists of two tabs:

• Main — Use this tab to select the vendor records you want to convert to client 
records. You can merge vendor records to existing client records or you can 
create new client records.

• Fields Mapping — Use this tab to select the vendor fields to include when you 
convert Vendor records, and to map those fields to their respective Client Info 
Center fields.

See the Vision Help topics titled, Create Client from Vendor Utility and 
Use the Combined Client and Vendor Info Centers, for more information.
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Key Conversions

Use the Key Conversions utility to change certain Vision numbers/ codes in your 
database to either new or existing numbers/codes. The changes made with Key 
Conversions apply to all of the data in your database and should be used infrequently. 

Access Key Conversions by clicking Utilities » Key Conversions.

Key Convert Clients Form

A list of numbers/codes you may convert displays in the Vision menu. The numbers/
codes you can change are as follows: Clients, Contacts, Employees, Projects, 
Phases, Tasks, Enable Phases/Tasks, Disable Phases/Tasks, Project’s Organization, 
Organizations Sub-codes, Organizations, and Vendors. If your firm uses Vision 
applications other than CRM and Proposals, additional numbers are available for 
conversion. 

Use the Key Conversion utility to do the following:

• Combine one or more records into a single record using the Combine existing 
<Record Types> option. Use this feature to close out records and consolidate 
data.

• For client and contact records, you use the Key Conversion utility only to combine 
records. To change a client or contact record number, simply open the Client or 
Contact Info Center record, and enter the new number directly in the Number field 
on the General tab. 

• Access the following Key Conversion processing functions from the Key convert 
toolbar:
• Save — Save the entries you have made without processing them.
• Run — Process the changes you have entered.
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• Help — View help for the Key Conversions utility.

• Use the Key convert grid options to:
• Lookup/Insert — Open a Lookup for the record type selected and then use 

the Lookup to search for and select the records you need. The records are 
then inserted into the grid on the Key convert form.

• Insert — Insert a blank row on the grid on the Key convert form. You can then 
enter a record name or number directly in the Project field in blank row, or 
click on the Binoculars icon in the Project field to use a Lookup.

• Delete — Delete a record from the grid on the Key convert form.
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Key Formats

Use the Key Formats utility to reformat the length, delimiter, and/or delimiter position 
for certain numbers/codes in your database. The changes made with Key Formats 
apply to all of the data in your database and should be used infrequently. 

Access Key Formats by clicking Utilities » Key Formats from the Vision main menu. 
A list of formats you can change displays in the Vision menu. The formats you can 
change are as follows: Accounts, Clients, Employees, Projects, Phases, Tasks, Units, 
Organizations, Vendors, and Reference Numbers.
 

Key Convert Employee Format Form

You must make a backup copy of your Vision database prior to running 
the Key Formats utilities.
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Process Server

The Vision Process Server feature allows you to offload batch reporting from your own 
system so that you can get back to doing what you need to do on your own application 
server. The process server also handles Alerts.

Benefits of the process server:

• Specify the workstation on which to run the process. The selected workstation, 
referred to as the Process Server, is relatively unattended. 

• After a process has been submitted to the Process Server, the submitting 
workstation is immediately available to perform other Vision functions. 

• Process potentially lengthy jobs on another workstation without having to navigate 
the menus and forms each time you submit a job. 

• Schedule each submitted process to run after a specific date or time. You can 
even schedule Process Server events to occur during the night or on the 
weekends.

• The multi-threading feature in the Process Server allows you to run a number of 
jobs concurrently. You can set the number you want to run, regardless of how 
many jobs are in a particular queue. 

• Queues can be dedicated to a specific server so that only that process server will 
run jobs on that queue. For example, you can assign large jobs to your most 
powerful machine.

• Set recurring jobs to the Process Server. 

When you set up the Process Server feature, Vision displays a Schedule option on 
the toolbar or grid options in all report applications. Users simply click the Schedule 
option and then use the Schedule dialog to add a job to the Process Server queue. 
After a user has submitted a job to the Process Server, the workstation from which the 
user submitted the job is immediately available to perform other Vision functions.

The Process Server utility allows you to monitor and manage all the jobs submitted to 
the server for processing.

The Process Server utility consists of three separate tools:

• Queue Manager

• Profile Editor

• Server Management

For more information about setting up the process server and running 
processes, see “Process Server Setup” on page 42. Also see Process 
Servers in the Vision Help System. 
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Queue Manager

Use the Process Queue Manager to view a list of processes for a selected process 
queue and review the status and positioning of a submitted process. 

Access the Process Queue Manager by clicking Utilities » Process Server » Queue 
Manager.

Process Queue Manager Form

Use the Queue Manager to do the following:

• Save your settings, Refresh Settings to restore defaults, or view Help for the 
Queue Manager from the Queue Manager toolbar.

• Use the grid options on the Queue Manager to view Detail for a selected job, 
place a job on Hold, Release a previously held job for processing, Cancel a job, 
Resubmit a previously submitted job, or Delete a job from the queue.

• Display all submitted processes on the Process Queue Manager form by leaving 
the From the previous day(s) field blank.

• Sort entries on the Process Queue Manager form by any one of the available 
categories. To sort information, simply click the appropriate column heading. To 
reverse the sort, click the column heading again.

• View error messages if processes do not complete successfully by clicking the 
Detail grid option. Vision displays the Detail Jobs dialog. Click the Termination 
Message grid option. Vision displays a message providing the reason for the 
process failure. 
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Profile Editor

Use the Profile Editor to set the date, time, sequence and parameters for groups 
reports that you want to run on the Process Server.

Access the Profile Editor by clicking Utilities » Process Server » Profile Editor.

Profile Editor Form

Use the Profile Editor to do the following:

• Use the toolbar options on the Profile Editor form to Save your entries to the 
current profile, create a New profile, Submit Profile for processing, Delete 
Profile, or view Help for the Profile Editor. 

• Use the Delete grid option to delete items from a profile.
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Server Management

To access the Process Server Management form, click Utilities » Process Server » 
Server Management from the Vision main menu. 

Process Server Management Form

From the Process Server Management form, you debug and manage Process 
Servers without physically accessing the application server. You can display the status 
of the Process Server and the System Process Server, stop and start servers, and 
view information from the Server Event log.

The Process Server Management form consists of two tabs:

• Servers — This tab lists the name and status of your servers. Use the grid options 
on this tab to Stop Service or Start Service for any server in the list. 

• Event Log — Use this tab to display the Event Log for Process Server and/or 
application events.
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Using the Schedule Dialog

When you run reports in Vision you have the option of running those processes 
immediately, or scheduling them to run at a later time. To schedule a run date for any 
report in Vision, simply click the Schedule option on the appropriate report toolbar. 
When you click this option, Vision displays the Schedule dialog. 

Use the Schedule dialog to select a queue, enter a description of the job, set the time 
and date you want to run the job, select the period in which to run the job, and set 
recurrence options, if applicable.

Schedule Dialog

Use the Schedule Dialog to:

• Submit a report to the Process Server in Vision by clicking the Schedule option 
on the toolbar in the associated reporting application. Change the description of 
the report at the time of scheduling.

• Specify a group or batch of reports to run at a particular time. The Schedule dialog 
in Vision includes a Submit to a profile option. If you select this option, Vision 
displays the Profile Editor form. In the Profile Editor, you can set up a profile with a 
series of reports, so you do not have to submit each report separately. This 
application saves you a great deal of time if you have jobs that you must send 
routinely.

If you do not select the Submit to a profile option, Vision bypasses the Profile 
Editor and submits the transaction or report to the process queue.

• Select Place job on hold to place the process on hold. If you select this option, 
and a user clicks Run for the same job, the job will not be sent to the Process 
Server. The process must be released before it can be run, even when a Run 
after date and time has been specified. This option is useful for providing a visual 
reminder about a process that needs to be run at a future point in time. It is also 
useful for processes that need further authorization from the Vision administrator, 
or for reasons of resource availability or data security.

If you have not yet specified options for the report, the options dialog 
displays when you click Schedule. Specify options and click Run from 
the Options dialog to display the Schedule dialog.
9-296



Process Server
• Select Enable process alert for this submit to have Vision send you an email 
message (alert) to indicate whether the submitted job completed successfully for 
the current submit. Vision uses the email address saved in the Employee Info 
Center record of the employee associated with the current login. This option is 
useful if you have certain types of processes for which an alert is desired, but not 
necessarily for all types. For example, you may want to be notified when reports 
are printing but not want to receive a process alert for any other process.

• Specify in which period (Current or Prior) the scheduled report should occur

• Specify recurring job options, such as whether to run the job, daily, weekly, or 
monthly.

• Review technical data to be sent to the process server when you submit a report, 
or profile to the queue by clicking Parameters. 
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Backup Database

The Backup Database utility allows you to select and initialize a device to back up 
your Vision SQL Server/MSDE database. For more information about backing up your 
Vision database, refer to the appropriate guide based on your database:

• Deltek Microsoft SQL Server 2000 Administrator’s Guide. 
 
or

• Deltek Microsoft SQL Server 2005 Administrator's Guide.

or

• Deltek Microsoft SQL Server 2005 Express Edition/Microsoft MSDE 2000 
Administrator's Guide.

These guides are available from the Answers tab of Deltek's e-support site at https://
support.deltek.com. 
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Reporting Administration

Use the Reporting Administration utility to display the reports that are running on the 
report server. You may set the sequence of the reports, view their parameters, and 
even delete jobs that have been running too long or that have hung due to an error. 

Reporting Administration also provides you with the ability to load Actuate reports on 
the report server. You can specify the folder to install to on the report server, and 
specify the file path location of the reports (ROX files) on the report server.

Access Reporting Administration by clicking Utilities » Report Administration from 
the Vision main menu.

Reporting Administration Form

The Reporting Administration form consists of three tabs:

• Load Reports — This tab allows you to indicate where Vision should store 
previously run reports. It also includes an option that allows you to empty each 
folder of older reports before storing the current batch of reports. 

• Report Printers — This tab displays printers available for printing reports. 
Information on printer names, printer locations, printer models, printer 
descriptions, default page type, default paper tray, and whether to allow color, 
collation, or scaling, displays for each printer.  If a client is not using the Actuate 
SOAP API, the only information available on this tab is the printer name.

All report printer information is stored in the database to improve performance.  If 
a printer is added to (or removed from) the report server, administrators must 
refresh the list of available printers by clicking Refresh Report Printers on the 
Report Printers tab.

• Current Activity — This tab includes fields that allow you to monitor any reports 
that Vision is currently running.
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• Report Logging — When report logging is enabled, this tab displays the following 
information about all generated reports:
• Vision username of user who ran the report 
• Report file name 
• Start and end time 
• Completion time 
• Number of pages 
• Output file name 
• Query end time for the report 
• Query completion time 
• Report server that ran the report 
• Report folder 
• Type of report (standard, custom, general for reports that are not run from the 

Reporting Navigation) 
• Report options (the report options used to generate the report can be 

displayed by selecting Display Options in the Reporting Logging grid 
header) 

In addition, report log information can be filtered by reports started over x 
number of hours, date range and/or by Vision username. You can also choose 
to purge log data. Report log information will be purged based on the current 
filter at the time you choose to purge.

Report logging must be enabled from the General System Settings form 
(Configuration » General » System Settings) for Vision to display this tab.
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Download Merge Macro

The Download Merge Macro utility is used to make Vision supported merge codes (for 
use with merge templates used in Custom Proposals and the Info Center) available in 
Microsoft Word, by creating a toolbar within Microsoft Word. 

Access the Download Merge Macro by clicking Utilities » Download Merge Macro 
from the Vision main menu.

To modify custom proposals merge templates from within Microsoft Word, you need 
access to the list of Vision supported merge codes. When the VisionWordMacro.dot is 
installed in Microsoft Word, this macro creates a toolbar, from which you can access 
Vision merge codes. The toolbar also contains the Graphics-Expand-Macro to extract 
linked-graphics into your merged documents. 
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Download Deltek Vision Desktop and Microsoft 
Office Integration

The Download Integration utility is used to install Deltek Vision Desktop and Microsoft 
Office Integration, which allows access to Vision data from Microsoft Outlook, 
Microsoft Word, Microsoft PowerPoint and the Microsoft Windows Task Bar.

Access the Install Desktop Integration utility by clicking Utilities » Download 
Integration from the Vision main menu.

The Deltek Vision Desktop and Microsoft Office Integration utility requires a client-side 
installation. After you install this add-in, you will see integration toolbars in Microsoft 
Outlook, Microsoft Word, Microsoft PowerPoint, and in the system tray at the bottom 
of your desktop. Use the add-in to:

• Record Microsoft Outlook emails, both received and sent, as Vision activities.

• Access your Vision Contacts and Leads lists from within Microsoft Outlook.

• Create and merge templates in PowerPoint for the Project, Contact, and Client 
Info Centers.

• Search all of Vision’s Info Centers from your desktop, without launching Vision.

• Search the Vision Text Library from within Microsoft Word, and copy the text you 
find into Microsoft Word documents, or highlight text in Microsoft Word and search 
for matching text in the Vision Text Library.

• To use the add-in, you must have the Microsoft .NET Framework v1.1 (SP1), and 
Microsoft Office XP, Office 2003, or Office 2007 installed on your workstation.

For more information about Desktop and Microsoft Office Integration, please see 
“Vision Desktop and Microsoft Office Integration” on page 303.
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Vision Desktop and Microsoft Office Integration
Overview

Deltek Vision Desktop Integration and Microsoft Office Integration allows you to use 
the Microsoft tools you are familiar with, such as Microsoft Word, Microsoft 
PowerPoint, Microsoft Outlook, and the Windows Task Bar, to quickly and easily 
access, manage and manipulate Vision data. 

Vision’s Integration Tools includes the following:

• Microsoft Outlook Integration

• Microsoft Word Integration

• Microsoft PowerPoint Integration

• Desktop Integration

Use Deltek Vision Desktop Integration and Microsoft Office Integration to:

• Record Microsoft Outlook emails, both received and sent, as Vision activities.

• Access your Vision Contacts and Leads lists from within Microsoft Outlook.

• Create Vision activity, client, contact and leads records from within Microsoft 
Outlook.

• Search all of Vision’s Info Centers from your Microsoft Windows Desktop, without 
launching Vision.

• Create a new Vision client, contact, or activity from your Microsoft Windows 
Desktop, without launching Vision.

• Search the Vision Text Library from within Microsoft Word, and copy the text you 
find into Microsoft Word documents.
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Installing and Accessing Vision Desktop and 
Microsoft Office Integration

How do I access 
Desktop 
Integration?

To use Vision Desktop and Microsoft Outlook Integration, you first install the tool, 
using the Download Integration utility, available from within the Vision User interface 
(Utilities » Download Integration). 

When you initiate the download of the utility from the Download Integration form, 
Deltek Vision copies the software files necessary for Microsoft Office and Outlook 
integration to the location you specify. You will see integration toolbars in Microsoft 
Outlook, Microsoft Word, Microsoft PowerPoint and in the system tray at the bottom of 
your Windows Desktop, after you have completed the download.

After downloading the required files, you then open the utility and configure Vision 
Integration. During configuration you specify information such as where Vision is 
installed, the Web server name, and your Vision username and password. You also 
specify which integration options to enable.

Options include:

• Find words that sound the same when performing searches

• Enable Microsoft Word Integration

• Enable Microsoft Outlook Integration

• Enable Microsoft PowerPoint Integration

• Enable System Tray Integration

• Enable Debug Mode

System Requirements

You must have the following pre-requisites installed on the machine where you will 
use Deltek Vision Microsoft Office and Desktop Integration.

• Microsoft .NET Framework 1.1 (SP1)

• Microsoft Office XP (SP3) or Office 2003 (SP1)

For detailed information about how to install and configure Vision Microsoft Office and 
Desktop Integration, please see Chapter 16 - Set Up Vision Desktop and Microsoft 
Office Integration, in the Deltek Vision Implementation Guide.
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Microsoft Outlook Integration

The functionality provided by the Microsoft Outlook module of Vision Integration is 
similar to CRM 3.x Microsoft Outlook Integration.

With CRM 3.x, Microsoft Outlook Integration, users synchronize calendar, activity, and 
contact information between CRM and Proposals and Microsoft Outlook. Any 
calendar, activity, or contact information that is available in one application can be 
available in the other. Using CRM and Proposals 3.x, Microsoft Outlook Integration 
users track details related to clients and contacts, such as mailing list membership, 
activities, and related prospect projects.  Any activities entered into CRM and 
Proposals or any Client/Contact updates are synchronized with Microsoft Outlook.

Vision’s Outlook Integration module shares the following data between Vision and 
Microsoft Outlook:

• Contacts: Share contact client and company information between both 
applications. Validate this information for data synchronization purposes.

• Email: Incoming and Outgoing Outlook emails are saved as Vision activities. And, 
when sending an email, you may use the Vision Address Book to access your 
Vision Contact and Lead email lists from within Outlook.

Deltek Vision Microsoft Outlook Integration is designed as a companion to the Vision 
Server to Server Synchronization feature. 

Refer to the following table for a comparison of features available in CRM and 
Proposals versus those available in Vision.

For details about using Deltek Vision Microsoft Outlook Integration, please refer to the 
Online Help topic title Outlook Integration Overview. Vision Help is available from 
within the Vision user interface.

Vision Microsoft Outlook 
Integration

CRM and Proposals Microsoft 
Outlook Integration

Synchronize contact information 
between Vision and Microsoft Outlook 
and create new Vision activities from 
Microsoft Outlook emails, both those 
received and those sent. 

Synchronize calendar, activity, and 
contact information between CRM and 
Proposals and Microsoft Outlook. 

Access your Vision Contacts and Leads 
lists from within Microsoft Outlook.

Track details related to clients and 
contacts, such as mailing list 
membership, activities, and related 
prospect projects.  

Create Vision client, contact and lead 
records from within Microsoft Outlook.
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Microsoft Word Integration

From the Microsoft Word interface you can do the following:

• Search Text Library. Allows you to copy information from the Vision Text Library 
into your Microsoft Word documents. To locate the desired text, use the Search 
function to search the Vision Text Library. After locating the data, you can paste 
the desired information into your Word documents.

• Insert Into Text Library. Allows you to select any formatted text in a Microsoft 
Word document and insert it into your Deltek Vision Text Library. 

For details about using Deltek Vision Microsoft Word Integration, please refer to the 
Online Help topic titled Microsoft Word Integration Overview. Vision Help is available 
from within the Vision user interface.

Microsoft PowerPoint Integration

Use the Microsoft PowerPoint Integration tool to insert information from the Vision 
Opportunity Info Center into your PowerPoint presentations. 

You can also use Microsoft PowerPoint Integration to search the Deltek Vision Info 
Center data for matching text or to launch Deltek Vision. 

For details about using Deltek Vision Microsoft PowerPoint Integration, please refer to 
the Online Help topic titled Microsoft PowerPoint Integration Overview. Vision Help is 
available from within the Vision user interface.

Microsoft Windows Desktop Integration

The Vision Desktop Integration application allows you to perform the following from 
your Desktop :

• Search Vision: launches the Vision Text Library where you can search for data to 
include in Word documents or Outlook emails.

• Create Activity: launches the Vision Activity dialog where you can enter and save 
a new Vision activity.

• Create Client: launches the Vision New Client dialog where you can enter and 
save a new Vision client.

• Create Contact: launches the Vision New Contact dialog where you can enter 
and save a new Vision contact.

• Create Lead: launches the Vision New Lead dialog where you can enter and 
save a new Vision lead.

• Launch Deltek Vision: launches the Vision application.
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• Options: launches the Vision Integration Options dialog. Click Configure to 
configure Vision Desktop and Microsoft Office Integration.

• About Vision Add-In: view the Vision Desktop and Microsoft Office Integration 
system information.
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Database Changes from CRM and Proposals 3.x
Before You Begin

Overall Database Differences

The Vision database differs from your CRM and Proposals database in the following 
ways:

• It has more tables, partly because of the restructuring of code tables and new 
functionality for custom fields and Lookup lists.

•  Although several CRM database tables have been carried over to Vision, some 
table columns have been renamed. The Vision Data Dictionary contains 
descriptions of all tables and columns in the Vision database.

• The Vision Data Dictionary is available from the Vision Help system. It provides 
links from the Table of Contents to each table, and from each table to its primary 
keys, foreign keys, and indexes. It also includes a description for each table, 
column, and index.

• The Data Dictionary is a useful reference for creating custom reports, third-party 
API programming, and importing data from other systems.

Vision’s database structure differs from CRM’s database structure. This has important 
implications for your CRM database:

• The CRM and Proposals database stores text entries (proposals, resume 
text, project descriptions) in RTF format, whereas the Vision database stores 
them in HTML format. The Vision conversion process makes this format 
change directly to the data in your CRM and Proposals database. 

• Before running the Vision conversion process, make a backup of your CRM 
database.

• Consultant records are converted into Vendor records tables in the database, 
however your firm’s labeling for this and all other Data Sources is carried over 
to the Vision interface. For example, if you used the label Consultant in your 
CRM Data Source, you will see a Consultant Info Center in Vision.

• The Vision database conversion process is designed for CRM and Proposals 
Version 3.x running on a Microsoft SQL Server database platform. If your firm 
is not on Version 3.x, or is running on a Sybase SQL Anywhere database 
platform, please contact CRM Support for assistance in upgrading to Version 
3.x, or Microsoft SQL Server prior to converting your database.

• None of your firm’s custom reports will work in Vision. In some cases, Vision’s 
functionality may be sufficient to replace your custom reports. 

• Your SF255, SF254, and Custom Proposals are not converted to Vision. You 
must build new proposals in Vision. Your old proposals remain stored in your 
backup copy of your CRM database, so you can still access them from CRM 
and Proposals.
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• Company Data Source information is converted to Vision Organization 
Configuration. Most of your CRM and Proposals Company Data Source data 
is converted to the Firm Setup - Proposals portion of Organization 
Configuration. For details, see “Organization” on page 140.

• If your firm used CRM Company Data Source custom fields tabs, these tabs 
are not converted to Deltek Vision. 

Specific Database Differences

• The Vision conversion process moves data on the Additional Info tab of the 
Client and Opportunities Data Sources to custom tabs in the Client and 
Opportunities Info Centers in Vision.

• Vision converts contractor information for projects onto a custom tab. All 
custom fields on Custom Fields tabs are converted onto a tab labelled 
“Miscellaneous.”

• Client Contacts and Consultant Contacts can have multiple addresses and be 
affiliated with a specific Client/Consultant address. The Vision conversion 
process maps the addresses accordingly.

• Contacts for Clients and Consultants, which are separate in CRM and 
Proposals, are combined in Vision’s Contact Info Center.

• Text stored in word processor fields is in RTF format. Vision converts text into 
HTML format. As a result, text formatting may vary slightly in some cases, 
although most formatting is preserved.

Database Similarities

You still use Microsoft SQL Server Enterprise Manager for database maintenance 
tasks. 
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Table Changes

The following list shows the CRM tables with their Vision counterparts. Because 
Vision’s data types, table relationships and other database features differ from those 
in CRM’s database, please refer to the Vision Data Dictionary for details on any Vision 
table and its columns.

CRM Table Name Vision Table Name(s)
Activity Activity
Activity_Subject CFGActivitySubject
[Populated Manually] CFGActivityType
Information_Category CFGClientInfoCat, CFGContactInfoCat
Client_Type CFGClientType
Description_Category CFGDescriptionCategory
Job_Title CFGEmployeeTitle
Registrations CFGEMRegistration
Discipline CFGEMSkill
Information_Category CFGOppInfoCat
Project_Status CFGOpportunityStatus, 

CFGProjectStatus
Project_Type CFGOpportunityType, CFGProjectType, 

CFGProposalType
Primary Specialty CFGPrimarySpecialty
Profile_Code CFGProjectCode
Proposal_Source CFGProposalSource
Proposal_Status CFGProposalStatus
Firm_Responsibility CFGPRResponsibility
Resume_Category CFGResumeCategory
State_Acronyms CFGStates
Suffix CFGSuffix
Client CL
Client (1 address) CLAddress
T_OLE_Links=’Client’ ClientFileLinks
Additional_Information CLMoreInfo
Contact Custom Tabs ContactCustomTabFields
T_OLE_Links=’Client_Contact’ ContactFileLinks
Additional_Information ContactMoreInfo
Client_Contact Contacts
Employee EM
Activity_Marketing_Reps EMActivity
Employee_Client_Association EMClientAssoc
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Client_Contact_Employee_Association EMContactAssoc
Employee_Degree EMDegree
Employee Custom Tabs EmployeeCustomTabFields
T_OLE_Links = ’Employee’ EmployeeFileLinks
Employee_Project_Associations EMProjectAssoc
Employee_Registration EMRegistration
Employee_Resume EMResume
Employee_Discipline EMSkills
Company Firm
Former_Parent_Company FirmFormerParent
Office_Fees FirmServiceFees
Additional_Information* OppMoreInfo
Prospect_Project Opportunity
Client_Contact_Prospect_Association OpportunityClientAssoc, 

OpportunityContactAssoc
Prospect_Marketing_Rep_Assoc OpportunityEMAssoc
T_OLE_Links = ’Prospect_Project’ OpportunityFileLinks
Prospect_Project_Profile_Codes OpportunityProfileCodes
Proposals OpportunityProposals
Consultant_Prospect_Association OpportunityVEAssoc
Company Organization
Projects PR
Project_Descriptions PRDescriptions
T_OLE_LINKS where = ‘Project’ PRFileLinks
Project Custom Tabs ProjectCustomTabFields
Project_Profile_Codes PRProjectCodes
*Populated Manually SE
*Populated Manually SEUser
*Populated Manually TaxCountryCode
Boiler Plate Custom Tabs TextLibraryCustomTabFields
T_OLE_Links = ’Consultant’ VEFileLinks
Vendor Custom Tabs VendorCustomTabFields
Consultant_Prospect_Association VEOpportunityAssoc
Consultant_Project_Association VEProjectAssoc

CRM Table Name Vision Table Name(s)
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